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1. Disclaimer
The information in this document is subject to change without notice and does not represent a
commitment on the part of Native Instruments GmbH. The software described by this document
is subject to a License Agreement and may not be copied to other media. No part of this
publication may be copied, reproduced or otherwise transmitted or recorded, for any purpose,
without prior written permission by Native Instruments GmbH, hereinafter referred to as Native
Instruments.
“Native Instruments”, “NI” and associated logos are (registered) trademarks of Native Instruments
GmbH.
Mac, macOS, GarageBand, Logic and iTunes are registered trademarks of Apple Inc., registered in
the U.S. and other countries.
Windows and DirectSound are registered trademarks of Microsoft Corporation in the United States
and/or other countries.
All other trademarks are the property of their respective owners and use of them does not imply
any affiliation with or endorsement by them.
Document authored by Native Instruments GmbH
Software version: 2.6.4 (10/2021)
Hardware version: S-Series Mk2
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2. Welcome to KOMPLETE KONTROL
Thank you for choosing KOMPLETE KONTROL!
The KOMPLETE KONTROL software and its dedicated keyboard—the KOMPLETE KONTROL SSeries—form a tightly integrated music production and performance system that brings all the
sounds from KOMPLETE and the Native Kontrol Standard (NKS) to the heart of your workflow.
KOMPLETE KONTROL offers advanced integration with a number of hosts and provides full
control of any Instruments supporting NKS, both from Native Instruments and partners. The
keyboard lets you browse your Instruments, Loops, One-Shots and Effects in an intuitive way and
play them creatively with KOMPLETE KONTROL’s unique Scale engine and Arpeggiator.
We hope you enjoy this instrument as much as we do.
— The team at Native Instruments
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2.1. Document Conventions
In this document the following formatting is used to highlight useful information:
Italics

Indicates paths to locations on your hard disk or other storage devices

Bold

Highlights important names, concepts, software interface elements, and hardware
controls.

[Brackets]

References keys on a computer’s keyboard.
Single item instructions are represented by a bullet icon.
Results in procedures are represented by an arrow icon.

The following three icons represent different types of information:
The light bulb icon indicates a useful tip, suggestion, or interesting fact.

The information icon highlights important information that is essential for the given
context.

The warning icon alerts you of serious issues and potential risks that require your full
attention.

Naming Conventions
Throughout the documentation, we will refer to the KOMPLETE KONTROL keyboard (or just
keyboard) as the hardware controller and KOMPLETE KONTROL software as the software installed
on your computer.

Unlabelled Buttons on the Keyboard
The buttons and knobs above and below the displays on the KOMPLETE KONTROL keyboard do
not have labels.

WELCOME TO KOMPLETE KONTROL
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The unlabelled buttons and knobs on the KOMPLETE KONTROL keyboard.

For better reference, we applied special formatting here: throughout the document, the elements
are capitalized and numbered, so the buttons above the displays are written Button 1 to Button 8,
while the knobs under the displays are written Knob 1 to Knob 8.

2.2. New Features in KOMPLETE KONTROL 2.6.0
The following new features have been added to KOMPLETE KONTROL:

Accessibility from S-Series MK2 to MASCHINE

•

Accessibility for visually-impaired users has been added when using KOMPLETE KONTROL SSeries MK2 keyboards to control MASCHINE software. For more information, refer to
Maschine Accessibility.

Audible Indicator During Background Scanning

•

When Accessibility is activated, the start and end of a Background Content Scan are
announced via an audible indicator.

Big Sur compatibility on Intel-based Macs

•

KOMPLETE KONTROL is now supported on macOS Big Sur when running as a VST, AAX or
standalone.

•

KOMPLETE KONTROL and MASCHINE are not yet supported on Apple Silicon based Macs.
Even though they can be installed from Native Access on these computers, there is a small
possibility of data loss within KOMPLETE KONTROL and MASCHINE between sessions,
meaning that Project settings, loaded Instruments, and Amp parameters may intermittently be
lost when re-opening a saved project in Logic. We are working with Apple to resolve the issue.
Please see this article for updates.

Background Scanning Improvements

•

Background Content Scan now occurs when KOMPLETE KONTROL is hosted as a plug-in.

•

UI and performance improvements whilst the Background Content Scan is running.

Additional Bug Fixes

•

Super 8 R2 UI appears blank when loaded inside of KOMPLETE KONTROL.

•

User edited tags were not saved.

•

Dragging an item from the Browser shows one more item than what is dragged.

•

Saved items are not shown in the Browser if a scan is running in the background.

•

Samples with special unicode characters were not recognised on Windows.

•

Browsing tags on the Hardware was slow when a Character tag was selected.

2.3. New Features in KOMPLETE KONTROL 2.1.6
The following new features have been added to KOMPLETE KONTROL:

WELCOME TO KOMPLETE KONTROL
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PreSonus Studio One Support for KOMPLETE KONTROL

•

KOMPLETE KONTROL keyboards now support integration in PreSonus Studio One.
For more information, refer to Integration with PreSonus Studio One.

Steinberg Cubase/Nuendo Support for KOMPLETE KONTROL A-Series and M32

•

KOMPLETE KONTROL A-Series and M32 keyboards now support integration in PreSonus
Studio One.

2.4. New Features in KOMPLETE KONTROL 2.1.3
The following new features have been added to KOMPLETE KONTROL:

Audio Plug-in

•

The new Audio plug-in specializes in keeping audio loops playing in-sync with the project in
your host software and has the optional ability to do so without influencing the key of the loop.
Furthermore, you can transpose the loop while it plays so that it fits the key of your song. For
more information on the Audio plug-in, refer to Audio Plug-In. For more information on using
the Audio plug-in, refer to Working with Loops and One-Shot Samples.

MCU Support for KOMPLETE KONTROL S-Series MK2

•

KOMPLETE KONTROL S-Series MK2 now supports integration in hosts with MCU control. For
more information, refer to Integration with Hosts using MCU Protocol.

MIDI Control Takeover Mode for Third-Party Controllers

•

When using third-party controllers, you can now enable Takeover mode to prevent potential
parameter jumps caused by mismatching knob positions between software and hardware. For
more information, refer to Enabling Takeover Mode.

Improvements to Host Integration

•

Previously, you had to start KOMPLETE KONTROL as a stand-alone application to scan your
library for Instruments, Samples, and Effects before using the plug-in in your host. This step is
now no longer necessary. Instead, when using KOMPLETE KONTROL in your host directly after
installation, a dialog is presented allowing you to scan your library.

2.5. New Features in KOMPLETE KONTROL 2.1.0
The following new features have been added to KOMPLETE KONTROL:

MIDI Mapping for Third-Party Controllers

•

It is now possible to control some of KOMPLETE KONTROL's parameters via a third-party MIDI
controller. For more information, refer to MIDI Communication.

Sounds.com Integration

•

Browse on Sounds.com, create your own collections of loops and one-shots and send them
directly to the KOMPLETE KONTROL Browser.

WELCOME TO KOMPLETE KONTROL
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Improvements to the Browser

•

Samples are now cataloged in separate Loops and One-shots tabs in the Browser. For more
information, refer to Loops and One-shots.

•

Previews of Loops selected in the Browser will be played in sync with the current project. When
a loop is selected with Prehear turned on, it will begin playing immediately in-sync with the
project if transport is running. For more information, refer to Loops and One-shots

•

Filters and product selections will be remembered when switching between Content types and
Factory/User Libraries in the Browser.

•

Browser content synchronization between multiple running instances. When running multiple
instances of KOMPLETE KONTROL, either as Standalone and/or as a plug-in, updates to the
Library will be synced across the instances. For example, if you delete a sample from your User
Library in one instance, the sample will no longer be present in the other instances. Similarly, if
you save a preset in one instance, that preset will then be available in the other instances also.

2.6. Box Contents
The box contains the following items:

•

KOMPLETE KONTROL keyboard

•

USB cable

The included 3 meter USB cable
KOMPLETE KONTROL S88 keyboard.

only

works

in

conjunction

•

Power supply (only included in the KOMPLETE KONTROL S88 box)

•

Information flyer providing:

•

•

the hardware serial number of the KOMPLETE KONTROL keyboard

•

a web link for downloading the
KOMPLETE SELECT software bundle

KOMPLETE

KONTROL

with

software

the

and

the

Safety Instructions flyer

2.7. System Requirements
For KOMPLETE KONTROL to fully function as indented, your system needs to meet certain
requirements. The latest KOMPLETE KONTROL system requirements and compatibility
information is available here:
http://www.native-instruments.com/komplete-kontrol-s-series/specifications/

KOMPLETE
KOMPLETE KONTROL is optimized for use with KOMPLETE SELECT, KOMPLETE and
KOMPLETE ULTIMATE.
The latest KOMPLETE system requirements and compatibility information is available here:
http://www.native-instruments.com/products/komplete/
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3. Accessibility
Komplete Kontrol offers a set of accessibility features for visually-impaired users. These are
focused exclusively on the keyboard itself and include speech output via your computer for the
following features:

•

Perform, Transpose, Page left / right buttons

•

All Browser functions

•

Instance switching

•

The current edit mode, including the Plug-in panel and the Perform panel (Scale, Arp)

•

Names of parameters and parameter sections when touching knobs, including all edit modes

•

Tempo (Komplete Kontrol stand-alone application only)

The accessibility features are particularly useful when combined with Komplete
Kontrol’s host integration and Apple VoiceOver in Apple Logic Pro X and GarageBand.

3.1. Keyboard Overview
The buttons and knobs on the Komplete Kontrol keyboard are organized in the following groups:

•

Perform and Edit section

•

Transport section

•

Solo and Mute buttons

•

Preset and Page buttons

•

Arrange buttons (only functional in Maschine)

•

Control section

•

Navigation and Mode buttons

•

4-Directional Push Encoder (referred to as the 4-D encoder)

•

Transpose and Fixed Velocity buttons

The Perform and Edit section is located at the top left of the keyboard. It contains six buttons that
are arranged in two rows.
The buttons in the first row are (from left to right):

•

SHIFT

•

SCALE (Edit)

•

ARP (Edit)

The buttons in the second row are (from left to right):

•

UNDO (Redo)

•

QUANTIZE

ACCESSIBILITY

•
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AUTO

The Transport section is located directly below the Perform and Edit section. It contains six
buttons that are arranged in two rows.
The buttons in the first row are (from left to right):

•

LOOP

•

METRO

•

TEMPO

The buttons in the second row are (from left to right):

•

PLAY (Restart)

•

REC (Count-In)

•

STOP

The Solo and Mute buttons are located to the top right of the Perform and Edit section. The two
buttons are arranged in a row.
The buttons are (from left to right):

•

Mute

•

Solo

The Preset and Page buttons are located to the bottom right of the Perform and Edit section,
below the Solo and Mute buttons. The four buttons are arranged in a column.
The buttons are (from top to bottom):

•

PRESET Up

•

PRESET Down

•

Page Left and Page Right (next to each other)

The Arrange buttons, which are only functional in Maschine, are located to the right of the Solo
and Mute buttons and the Preset and Page buttons. The five buttons are arranged in a column.
The buttons are (from top to bottom):

•

SCENE

•

PATTERN

•

TRACK

•

KEY MODE

•

CLEAR

The Control section is located in the center of the Komplete Kontrol keyboard. It contains eight
buttons and eight knobs. The buttons are arranged in a row at the very top of the keyboard. The
knobs are arranged in a row directly above the keybed.
The Navigation and Mode buttons are on the top right of the Komplete Kontrol keyboard. The six
buttons are arranged in two rows.
The buttons in the first row are (from left to right):

•

BROWSER

ACCESSIBILITY
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The buttons in the second row are (from left to right):

•

INSTANCE

•

MIDI

•

SETUP

The 4-D encoder is located directly below the Navigation and Mode buttons.
The Transpose and Fixed Velocity buttons are located at the far left of the keyboard next to the
keybed and directly above the Pitch and Modulation wheels. The three buttons are arranged in a
row.
The buttons are (from left to right):

•

FIXED VEL (TS Mode)

•

OCT Down

•

OCT Up

3.2. Activating Accessibility Features
In order to activate or deactivate the accessibility features from the KOMPLETE KONTROL
keyboard while the KOMPLETE KONTROL software is running:
1. Press and hold the SHIFT button on the top left of the keyboard.
2. While holding SHIFT, press the MIXER button on the top right of the keyboard.
→ The accessibility features are activated or deactivated.
When the accessibility features are activated, you can choose whether or not speech output
should be activated for names of Preset files while browsing:
1. Press and hold the SHIFT button on the top left of the keyboard.
2. While holding SHIFT, press Button 5 in the Control section.
→ Speech output for names of Preset files while browsing is activated or deactivated.

The accessibility features are designed to be used with the KOMPLETE KONTROL
plug-in. However, the KOMPLETE KONTROL stand-alone application must be opened
after initial installation and after installing additional Instruments and Effects. This will
ensure that all Instruments, Loops, One-shots and Effects are displayed correctly in
the KOMPLETE KONTROL Browser.

3.3. Training Mode
KOMPLETE KONTROL Training Mode makes it easy to locate a specific button or parameter
without accidentally triggering an action. When Training Mode is activated, all button presses and
parameter names are announced but the corresponding action is not triggered.

ACCESSIBILITY
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Activating Training Mode
To activate or deactivate Training Mode from the KOMPLETE KONTROL keyboard while the
KOMPLETE KONTROL software is running:
▶ Double-press the SHIFT button on the top left of the keyboard.
Training Mode is only available when the accessibility features have been activated.

3.4. Feature Overview and Keyboard Shortcuts
Feature

Accessibility
Mode

Accessible
from
Keyboard

Activate
or
Accessibility mode

deactivate

Yes

Activate or deactivate speech
output for names of Preset files
Browser

Smart Play

Browse for Factory and User
Preset files

Yes

Page left button or
Page right button

Switch between Category and
Vendor sorting

Yes

SHIFT + Knob 1

Set Preset file Favorites

Yes

SHIFT + Knob 4
SHIFT + Knob 3

Save and edit User Preset files

No

Browse for NKS plug-ins from
other vendors

Yes

Supported by default

Adjust
key
parameters

Instrument

Yes

Knob 1 – 8

Custom
map
parameters

Instrument

No

Accessing Scale
Parameters

and

Chord

Yes

Adjust Scale & Chord parameters
Accessing Arp Parameters

SHIFT + SCALE Edit
Knob 1 – 8

Yes

SHIFT + ARP Edit

Adjust Arp parameters

Knob 1 – 8

Selecting Parameter Pages

Page left or Page right

Touch Strips

Adjust Touch Strip parameters

No

Tempo

Adjust BPM

Yes

Training mode

Find
a
control
without
accidentally triggering actions

Yes

Activate or deactivate Training
mode

Yes

Adjust software
preferences

No

Preferences

SHIFT + MIXER
SHIFT + Button 5

Sort by Favorites

Instrument
control

Keyboard Shortcut

&

hardware

TEMPO + Knob 1

Double-press SHIFT

ACCESSIBILITY

Software
dialog

Feature

Accessible
from
Keyboard

Be notified if a dialog box opens
in the software (dialog content is
not available for speech output)

Yes
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Keyboard Shortcut

Supported by default

Accessibility for KOMPLETE KONTROL’s host integration is only available when using
Apple VoiceOver in Logic Pro X and GarageBand. For more information about
KOMPLETE KONTROL’s host integration features, refer to Host Integration.

3.5. Maschine Accessibility
Maschine software is Native Instruments’ groove production software, bundled with Maschine pad
controllers and Komplete Kontrol keyboards. The release of Maschine 2.13 software adds
Accessibility from all Komplete Kontrol S-Series MK2 keyboard models (S49 MK2, S61 MK2, and
S88 MK2).
Maschine pad controllers, such as Maschine MK3 or Mikro MK3, are not required to make use of
the Accessibility features. However, a Maschine controller can be used alongside a
Komplete Kontrol S-Series MK2 keyboard, but only the keyboard will be accessible.
Our approach to product development is incremental and we aspire to deliver value when possible,
rather than constraining features and functionality to yearly releases. This allows us to share
features with our customers as soon as they are ready, and learn what users do and do not like,
allowing us to further iterate and refine.
This first release of Maschine Accessibility represents a starting point, rather than an end goal.
There are limitations in this release that we will address in future updates, and we still very much
aspire to extend this to other controllers.

3.5.1. Maschine Software Overview
Maschine shares similarities with popular non-linear DAWs such as Ableton Live. You can create
Patterns for each instrument (Group), and add combinations of Patterns into Scenes, which are
song sections (verse, chorus, middle-8, etc). You can then arrange your Scenes into a full song on
the Timeline.
Groups in Maschine contain up to 16 Sounds. A Sound can be a One-shot sample, a loop, or an
Instrument, and can also contain Effect plug-ins within the signal chain. The Maschine browser is
home to individual presets for One-shot samples, loops, and instruments, as well as pre-configured
Sounds which load an effects chain, and pre-configured Groups which contain 16 Sounds, all
ready to go! Groups are labeled A-H, and Sounds are labeled 1-16, for example, A1.
Instruments, One-Shots, and (time-stretched) Loops can be played chromatically across the
keyboard. Groups can also be played across 16 keys, with each key mapped to a single pitch from
each of the contained Sounds; particularly great for playing drums. You can switch between these
by pressing the Key Mode button.

ACCESSIBILITY
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You can control many of Maschine’s functions directly from the S-Series keyboard. Maschine can
operate as a standalone application, or run as a plug-in in a DAW. The setup and configuration of
your keyboard will differ for each mode of use. If you are using Maschine in a DAW, you will first
need to configure the host for use with your keyboard. Using Maschine in a DAW gives you access
to additional tracks, and easy editing of preferences. Computer keyboard shortcuts like Command
+ O are not available, but operations such as saving and opening can be done directly in the DAW,
as Maschine will recall its loaded contents and settings between DAW sessions.

3.5.2. Known Issues
There are some issues and limitations that will be resolved in future updates. These include:

Speech-related Bugs

•

When the keyboard is in Pattern mode, Knob 1 is used to select Sound. This isn’t always
announced, even though the Sound selection is changing. By releasing the knob and tapping it,
you can hear the currently selected sound name.

•

When the keyboard is in Scene mode, the page left and right buttons select between banks of
Scenes (1-8, 9-16, etc). Pressing these buttons may cause a readout of an unrelated parameter
page.

Transport
Control of transport in Maschine is slightly different from that of conventional linear DAWs. We
have chosen to maintain this behavior as a starting point and will investigate ways to improve this
for future releases. Currently, two potential limitations exist that may affect usability for visually
impaired users:

•

The 4-D encoder is not used to relocate the playhead, so it is not possible to relocate to another
position on the timeline.

•

Pressing Stop whilst transport is stopped does not relocate the playhead to the start of the
project or section.

The following interactions can be used to work around this:

•

Shift + Play buttons will start transport from the beginning of the project, or selected Scene if
Loop is activated.

•

When Record Arm is activated, Shift + Rec buttons will play a bar of count-in then begin
recording.

Quitting and Saving in Standalone Mode

•

Quit, Save, and Open commands can be applied when Maschine is running as a standalone
application only. We plan to enable some of these commands from the keyboard in a future
release. For more information, refer to Maschine Workflows.

3.5.3. Maschine Keyboard Overview
The S-Series MK2 keyboard is divided into the following sections:

•

Keybed Controls are located at the bottom left corner, above the pitch and modulation wheels.

•

Central Console is located in the center of your keyboard and contains touch-sensitive knobs
and screen buttons. Screen buttons and knobs are referred to as 1-8 from left to right.
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•

Navigation Controls are located to the right of the Central Console, and feature six buttons and
a 4-Directional (4-D) push encoder. These controls set the keyboard’s mode and navigate
through Maschine.

•

Maschine Controls are located directly left of the Central Console, and feature five dedicated
buttons for Maschine.

•

Mute, Solo, Preset Up / Down, Page Left / Right buttons are located immediately left of the
Maschine controls.

•

Edit Controls are located in the upper, leftmost cluster of buttons. They are used to Undo,
Redo, activate and deactivate the Scale and Arpeggio modes, and more. The Shift button is an
important global modified key and is located with the Edit controls.

•

Transport Controls are found in the lower, leftmost cluster of buttons.

3.5.4. Maschine Workflows
The following workflows describe how to navigate Maschine software from your S-Series MK2
keyboard. Follow these steps to setup your software and keyboard, then learn how to make use of
the Browser, Plug-in page, Transport controls, Scenes and Patterns, and Mixing mode from your
keyboard.

Setup
To get started, open Maschine software and start with a new project. Note that sighted assistance
may be needed to pass through any dialogue boxes that might appear during plug-in scanning,
and to enable the MIDI ports from your Komplete Kontrol S-Series MK2 Preferences.
1. Launch Maschine software.
2. Create a new project by pressing Command + N (macOS) or Ctrl + N (Windows) on your
computer keyboard.
→ Maschine is now ready to start creating music. Next, setup the keyboard's Accessibility
features.
3. In Accessibility mode, most actions from the keyboard will trigger a speech announcement. To
activate Accessibility mode, hold the top left button (Shift) and press the top right button
(Mixer) on the keyboard.
4. In Training mode, all button presses and parameter names are announced but the
corresponding action is not triggered. Press Shift twice to enter Training mode.

Browser
The Browser allows you to load Groups, Sounds, Instruments, and Effects from an S-Series
keyboard. Next, load a Drum Kit from the Groups tab of the Browser:
1. Press Browser, located in the Navigation Controls, to the right of the Central Console.
2. Use Screen Buttons 1 and 2 to navigate through the available file types and select Groups.
3. Use the knobs to filter through different search results. Adjust the knob to filter the respective
tag: Products (Knob 2), Banks (Knob 3), Types (Knob 5), Sub-Types (Knob 6). Knob 8 and the 4D encoder are used to scroll through the available results.
4. You will hear both sound previews and the name of each preset whilst scrolling through the
results list. Use the up and down arrows to move to the next and previous presets without
hearing the preset name. To toggle prehear (audition), press Shift + Screen Button 8.
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5. Press Screen Button 8 or the 4-D encoder to load a Group.

Plug-ins
Using your keyboard, you can navigate and edit your Plug-in chains, and adjust parameters. The
Plug-in button is located top and center of the Navigation Controls
1. Press Plug-in to display the Plug-in page.
2. Press Button 1 to select the Master channel. Press Button 2 to select the Group channel. Press
Button 3 to select the Sound channel.
3. Move through the Plug-in chain using Buttons 5 and 6 to select the next or previous plug-in.
You can also push the 4-D encoder left or right to move between plug-ins.
4. If you want to replace a Plug-in, push the 4-D encoder to open the Plug-in Browser. Turn the 4D encoder to select a Plug-in, and push the encoder to insert the Plug-in in the chain.
5. Press Button 8 to quick browse preset files for the selected Plug-in. Push the 4-D encoder to
select the preset file.
6. To delete a Plug-in from the chain, press Clear.
7. Adjust the parameter values of the Plug-in using Knobs 1–8. The Page buttons provide access
to other pages containing further functions to control. Select the next or previous parameter
page using the Page Left/Page Right buttons.

Performance
Use the Edit Controls, located in the upper, leftmost cluster of buttons, to access the Arpeggiator
and Scale Engine. Adjust the settings according to your performance needs.
1. To activate the scale engine for the selected Group, press Scale.
2. Edit the scale engine by pressing Shift + Scale.
3. To activate the Arpeggiator for the selected Group, press Arp.
4. Edit the Arpeggiator settings by pressing Shift + Arp.
5. To activate quantization, press Quantize + turn Knob 1. To adjust the quantization value press
Quantize + turn Knob 2.
Transport controls can be used to operate Maschine's playback. They are located on the lower left
side of the keyboard.
1. Press Play to start playback.
2. Press Metro to activate/deactivate the metronome.
3. To adjust the Master tempo, press Tempo and turn Knob 1.
4. Press Shift + Play to restart playback.

Recording
Pattern mode is the recommended mode for recording. The Pattern button is the second of the
Maschine Controls, located left of the Central Console. In Pattern mode, you can create and edit
Patterns, and use the 4-D encoder to move and edit note events. When you are ready to record a
Pattern:
1. Press Pattern on the keyboard.
2. Use Buttons 1–8 to select a Pattern or create a new Pattern for the selected Scene.
3. Push 4-D encoder left or right to select another Group, and use Knob 1 to select another Sound
in the Pattern.
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4. Double the Pattern length by pressing Shift + Button 3.
5. Insert a copy of the selected Pattern by pressing Shift + Button 4, and insert an empty Pattern
by pressing Shift.
6. Activate the count-in by pressing Shift + Rec.
7. Start recording by pressing Rec and stop recording by pressing Stop.
8. Adjust the Position using Knob 2. Adjust the Start position using Knob 3. Adjust the Length of
the pattern using Knob 4.

Scene
Record multiple patterns, then add them into Scenes to create song sections. The Scene button is
located at the top of the five Maschine Controls, on the left side of the Central Console. Press
Scene to access the identical Ideas view of the Maschine software. This gives you instant control
over your Scenes and Patterns.
1. Press Scene on the keyboard to enter Ideas view.
2. Use Buttons 1–8 to select a Scene or create a new Scene.
3. Use Knobs 1–8 to select another Pattern in the Scene and select the corresponding Group.
4. Insert an empty Scene by pressing Shift + Button 5, and insert a copy of a selected Scene by
pressing Shift + Button 4.
5. To delete a selected Scene press Shift + Button 6, and to delete the selected Pattern press
Clear.
6. Press Shift + Button 8 to activate retrigger. When active, the next Scene that is selected will be
forced to play from start.

Mixing
In Mix mode, you can access volume and pan settings, and make adjustments to the mix from
your S-Series keyboard. The Mixer button is located on the top right of the keyboard.
1. Press Mixer to access eight of the 16 channel strips with Sounds and Groups. The further
eight Sounds can be accessed by pressing the Page buttons.
2. Press the 4-D encoder to toggle between volume and panorama control for Knobs 1–8.
3. Push the 4-D encoder up to enter Group mode and buttons 1-8 will control Groups. Push the 4D encoder down to enter Sound mode and buttons 1-8 will control Sounds.
4. Use Buttons 1-8 to jump to another Group or Sound, respective of the selected mode.
5. To adjust the output volume of the respective Group or Sound, turn Knobs 1-8. To fine-adjust
the output volume, press Shift + turn Knobs 1-8.
6. Push the 4-D encoder left or right to select the previous or next Sound or Group.
7. Turn the 4-D encoder to adjust the output volume of the respective Group or Sound.

Quitting and Saving in Standalone Mode
The following commands apply when Maschine is running as a standalone application. We plan to
enable some of this from the keyboard in a future release:

•

To launch the Save As dialog, press Command + Shift + S (macOS) / Ctrl + Shift + S (Windows).
This is a system dialog, and so can be navigated and read by screen readers.

•

To launch the Open dialog, press Command + O (macOS) / Ctrl + O (Windows). This is also a
system dialog. Note that projects can be opened from the Browser by setting Filetype to
‘Project’.
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•

If the current project has no unsaved changes, pressing Command + Q (macOS) / Alt + F4
(Windows) will quit Maschine.

•

On macOS, if the current project has unsaved changes, pressing Command + Q will launch a
Quit dialog which is not screen readable. Pressing Esc will dismiss the dialog and go back to
Maschine. Please note that it is not possible to quit Maschine when there are unsaved
changes.

•

On Windows, if the current project has unsaved changes, pressing Alt + F4 will launch a Quit
dialog which is not screen readable. Pressing Esc will dismiss the dialog and go back to
Maschine.

THE KOMPLETE KONTROL WORKFLOW
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4. The KOMPLETE KONTROL Workflow
KOMPLETE KONTROL brings all the sounds from KOMPLETE and the Native Kontrol Standard
(NKS) to the center of your workflow. Its advanced integration in a number of hosts enables you to
quickly capture ideas, with immediate access to the sounds you need, all directly from the
KOMPLETE KONTROL keyboard.
The KOMPLETE KONTROL workflow is streamlined to remove any obstacles when sketching out a
new song in a supported host:
1. Select a track that hosts the KOMPLETE KONTROL plug-in with the navigation controls on the
keyboard. This is made possible by KOMPLETE KONTROL’s advanced host integration.
2. Find Preset files you like from any of the Instruments and Effects in your
KOMPLETE KONTROL Library by browsing with the keyboard, supported by the Browser’s
filters and Preview functions.
3. Use the keyboard’s Control section to adjust the loaded Instrument and Effect(s) and create
your own unique sound.
4. Optionally, you can enable KOMPLETE KONTROL’s Smart Play features to enrich your playing
with the Scale engine and the Arpeggiator.
5. Record a new clip in the host, conveniently controlling transport and loop functions directly
from the keyboard. Again, made possible by KOMPLETE KONTROL’s advanced host
integration.
6. If you need to start over, undo and redo functions are right at your fingertips. To further refine
your recording, you can apply quantization and automation to a clip by pressing the
corresponding buttons on the keyboard.
→ You have quickly captured a musical idea and can continue sketching out a new song by
repeating the process and layering more tracks.
Key Features
The following key features facilitate the KOMPLETE KONTROL workflow:

•

Browser: The Browser is your interface for finding, loading and organizing Instruments, Loops,
One-Shots, Effects, and Preset files from the KOMPLETE KONTROL Library. For more
information, refer to Browsing the Library,Working with Effects, and Managing the Library.

•

Instrument and Effect control: The Touch Strip and knobs on the keyboard are pre-mapped to
all KOMPLETE and NKS Instruments, Loops, One-shots and Effects for immediate control. For
more information, refer to Controlling Instrument, Loop, One-shot and Effect Parameters and
Assignments for the Touch Strip.

•

Smart Play: The Scale engine and the Arpeggiator let you play and generate scales, chords,
and arpeggiator sequences. For more information, refer to Smart Play – Playing and Editing
Scales and Chords and Smart Play – Playing and Editing Arpeggiator Sequences.

•

Host integration: Advanced integration in a number of hosts allows you control core
functionality directly from the keyboard. For more information, refer to Setting up Host
Integration and Host Integration.

SETTING UP KOMPLETE KONTROL
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5. Setting up KOMPLETE KONTROL
This section provides basic setup information for using the KOMPLETE KONTROL stand-alone
software, and guides you through the process of integrating KOMPLETE KONTROL in supported
hosts.
The KOMPLETE KONTROL software is installed both as a stand-alone application as well as a VST,
Audio Unit, and AAX plug-in.
The KOMPLETE KONTROL stand-alone application directly communicates with your audio and
MIDI interfaces, which you can configure in the KOMPLETE KONTROL Preferences. When
KOMPLETE KONTROL is used as a plug-in within a host, the communication with your audio and
MIDI interfaces is managed by the host.
For details about the audio and MIDI configuration of the host, and how to load plugins, please refer to its documentation.

5.1. Connecting the Keyboard to the Computer
To connect the KOMPLETE KONTROL keyboard to your computer:
1. Attach the device end of the included USB cable to the USB socket on the rear panel of the
keyboard.
2. Attach the computer end of the USB cable to an available USB 2.0 (or later) port on your
computer.

3. Press the power switch on the rear panel of the keyboard to switch it on.
→ The keyboard is now detected by the operating system.
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Non-powered USB hubs are not supported. The keyboard should always be
connected directly to the USB port of the computer, or be used with a powered USB
hub.

5.2. Setting up the Stand-Alone Application
When you launch the KOMPLETE KONTROL software from its installation directory, it starts as a
stand-alone application independently from a host.
By default, the application uses the standard audio interface of your computer. In order to use
another audio interface, and receive MIDI notes from the keyboard, you need to configure the
application in the Preferences.

Configuring Audio Interface
1. In the KOMPLETE KONTROL menu click on Edit > Preferences to open the Preferences.
2. Click on Audio to display the Audio page.
3. Select the hardware driver supported by your audio interface from the Driver drop-down menu.
4. Select the audio interface from the Device drop-down menu.
5. Under Routings, select the left and right output channels of your audio interface you want to
use for KOMPLETE KONTROL’s master output in the Komplete Kontrol Out 1 L and
Komplete Kontrol Out 1 R drop-down menus.

Preferences panel — Audio page.

Enabling MIDI Control
1. Click on MIDI to display the MIDI page.
2. Click on Input to display the available devices for incoming MIDI signals.
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3. Click the Komplete Kontrol checkboxes to activate incoming MIDI signals from the keyboard.

Preferences panel — MIDI page (entries may vary on your computer).

→ The software is configured and ready to be controlled with the keyboard.

The MIDI Output settings are required for using KOMPLETE KONTROL’s Smart Play
features with other MIDI instruments.

5.3. Setting up Host Integration
KOMPLETE KONTROL integrates with a number of hosts to facilitate a fluent workflow for
performing and recording music with your KOMPLETE KONTROL Library.
Advanced integration of KOMPLETE KONTROL is available in the following hosts:

•

MASCHINE 2

•

Ableton Live 10

•

Apple GarageBand

•

Apple Logic Pro X

•

Avid Pro Tools

•

Bitwig Studio

•

PreSonus Studio One 4.5

•

Steinberg Cubase Artist 8.5/9/9.5/10

•

Steinberg Cubase Pro 8.5/9/9.5/10
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Steinberg Nuendo 7/8/9/10

Before using the KOMPLETE KONTROL keyboard to control a supported host, you need to set up
your host using the following instructions.

5.3.1. Setting up Ableton Live
Before you can load KOMPLETE KONTROL instances into Ableton Live, you must configure
Ableton Live for advanced integration with KOMPLETE KONTROL.

Configuring Ableton Live for KOMPLETE KONTROL
To add KOMPLETE KONTROL as a control surface in Ableton Live's preferences:
1. Ensure that the keyboard is connected and switched on before launching the application.
2. Launch Ableton Live.
3. In Ableton Live, go to the Preferences and open the Link / MIDI tab.
4. In a free control surface slot select Komplete Kontrol SMK2 from the Control Surface dropdown menu.
5. For the control surface input select Komplete Kontrol DAW -1 in the Input drop-down menu.
6. For the control surface output select Komplete Kontrol DAW -1 in the Output drop-down
menu.

Loading KOMPLETE KONTROL in Ableton Live
To load KOMPLETE KONTROL:
1. Ensure that the keyboard is connected to your computer.
2. In Ableton Live, select the Plug-ins folder in the Browser to display the installed plug-ins.
3. Drag the KOMPLETE KONTROL entry from the Browser list to an empty MIDI track.
→ You are now ready to use KOMPLETE KONTROL within Ableton Live.
If you have not started KOMPLETE KONTROL as stand-alone application once before
using the plug-in within your DAW for the first time, KOMPLETE KONTROL will ask you
to scan your library for installed Instruments and Effects. In this case, click the Scan
Library button to scan your library.
For a detailed overview of the available host integration features in Ableton Live, refer to
Integration with Ableton Live.

5.3.2. Setting up Apple Logic Pro X and GarageBand
Apple Logic Pro X and GarageBand are automatically configured for advanced integration with
KOMPLETE KONTROL once you launch the respective application for the first time after installing
the KOMPLETE KONTROL software. Ensure that the keyboard is connected and switched on
before launching the application.
A dialog asks you to confirm this after launching the application:
▶ When the message OSC app “KOMPLETE KONTROL S-Series” wants to connect to Logic Pro
X / GarageBand appears on screen, click OK.

SETTING UP KOMPLETE KONTROL

22

If you have not started KOMPLETE KONTROL as stand-alone application once before
using the plug-in within your DAW for the first time, KOMPLETE KONTROL will ask you
to scan your library for installed Instruments and Effects. In this case, click the Scan
Library button to scan your library.
For a detailed overview of the available host integration features in Apple Logic Pro and
GarageBand, refer to Integration with Apple Logic Pro X and GarageBand.

5.3.3. Setting up Avid Pro Tools
Avid Pro Tools must be configured for advanced integration with KOMPLETE KONTROL.
1. Ensure that the keyboard is connected and switched on before launching the application.
2. Launch Avid Pro Tools.
3. In Avid Pro Tools, open Setup in the menu bar and select Peripherals....
4. In the Peripherals window, go to the MIDI Controllers tab.
5. Select Komplete Kontrol in any of the drop-down menus in the Type column to add the
keyboard. The ports and MIDI channel will be set automatically.
6. Click OK to confirm the settings and close the Peripherals window.
→ Avid Pro Tools is now ready to be used with KOMPLETE KONTROL.
If you have not started KOMPLETE KONTROL as stand-alone application once before
using the plug-in within your DAW for the first time, KOMPLETE KONTROL will ask you
to scan your library for installed Instruments and Effects. In this case, click the Scan
Library button to scan your library.
The following modes, settings, and workflows in Pro Tools are recommended when using
KOMPLETE KONTROL host integration:

•

Using Dynamic Transport mode: In this transport mode, the playback start location is
independent of the timeline selection. Therefore, you can move the playback start location
while retaining the current loop boundaries. You can set the transport mode by right-clicking on
the Play button.

•

Inserting KOMPLETE KONTROL: The KOMPLETE KONTROL plug-in needs to be inserted in
Insert A of an Instrument track to ensure full host integration functionality.

•

Enabling Transport Record Lock: Depending on your workflow, you might benefit from
activating Transport Record Lock in the Preferences. When this option is active, recording
continues after the first pass is completed, enabling you to record multiple passes.

•

Selecting single tracks: The KOMPLETE KONTROL workflow relies on selecting a single track.
Therefore, selecting multiple tracks is not possible from the keyboard. Selections of multiple
tracks cannot be displayed correctly on the keyboard.

For a detailed overview of the available host integration features in Avid Pro Tools, refer to
Integration with Avid Pro Tools.

5.3.4. Setting up Bitwig Studio
Bitwig Studio must be configured for advanced integration with KOMPLETE KONTROL.
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1. Ensure that the keyboard is connected and switched on before launching the application.
2. Launch Bitwig Studio.
3. In Bitwig, open the Device Setup from the Devices menu.
4. Click the + button in the upper left corner of the Device Setup and select Komplete Kontrol S
Mk2 from the drop-down menu.
5. Set MIDI Input and MIDI Output for Komplete Kontrol S Mk2 to the ports named Komplete
Kontrol DAW -1.
→ Bitwig is now ready to be used with KOMPLETE KONTROL.
If you have not started KOMPLETE KONTROL as stand-alone application once before
using the plug-in within your DAW for the first time, KOMPLETE KONTROL will ask you
to scan your library for installed Instruments and Effects. In this case, click the Scan
Library button to scan your library.
For a detailed overview of the available host integration features in Bitwig Studio, refer to
Integration with Bitwig Studio.

5.3.5. Setting up PreSonus Studio One
PreSonus Studio One must be configured for advanced integration with KOMPLETE KONTROL.
1. Ensure that the keyboard is connected and switched on before launching the application.
2. Launch PreSonus Studio One.
3. In Studio One, open the Preferences menu, then select External Devices.
4. Press Add and select Komplete Kontrol S-Series from the drop-down menu.
5. Set MIDI Input and MIDI Output for Komplete Kontrol S-Series to the ports named
Komplete Kontrol DAW (macOS) / KOMPLETE KONTROL (Windows).
→ PreSonus Studio One is now ready to be used with KOMPLETE KONTROL.
If you have not started KOMPLETE KONTROL as stand-alone application once before
using the plug-in within your DAW for the first time, KOMPLETE KONTROL will ask you
to scan your library for installed Instruments and Effects. In this case, click the Scan
Library button to scan your library.
For a detailed overview of the available host integration features in Presonus Studio One, refer to
Integration with PreSonus Studio One.

5.3.6. Setting up Steinberg Cubase and Nuendo
Steinberg Cubase and
KOMPLETE KONTROL.

Nuendo

must

be

configured

for

advanced

integration

with

1. Ensure that the keyboard is connected and switched on before launching the application.
2. Launch Steinberg Cubase/Nuendo.
3. In Steinberg Cubase/Nuendo, open the Device Setup. from the Devices menu (Steinberg
Cubase 9.5: Studio Setup from the Studio menu).
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4. Click the + button in the upper left corner of the Device Setup and select Komplete Kontrol SSeries from the drop-down menu.
5. Set MIDI Input and MIDI Output for Komplete Kontrol S-Series to the ports named
Komplete Kontrol DAW (macOS) / KOMPLETE KONTROL (not KOMPLETE KONTROL EXT,
Windows).
→ Steinberg Cubase Nuendo is now ready to be used with KOMPLETE KONTROL.
If you have not started KOMPLETE KONTROL as stand-alone application once before
using the plug-in within your DAW for the first time, KOMPLETE KONTROL will ask you
to scan your library for installed Instruments and Effects. In this case, click the Scan
Library button to scan your library.
For a detailed overview of the available host integration features in Steinberg Cubase and Nuendo,
refer to Integration with Steinberg Cubase and Nuendo.

5.4. Connecting Pedals to the Keyboard
The KOMPLETE KONTROL keyboard provides you two pedal inputs (in the form of 1/4" sockets) on
its rear panel: PEDAL A and PEDAL B.

The pedal inputs on the rear panel of the keyboard.

These inputs both allow you to connect either a continuous or a switch pedal in order to further
refine your performance. They can be freely configured for sustain or expression behavior.
You can define the MIDI messages assigned to the pedal inputs in
KOMPLETE KONTROL’s MIDI Assignment editor. For more information, refer to Using
the MIDI Assignment Editor.

Connecting Pedals
▶ Connect a continuous or switch pedal to the PEDAL A or PEDAL B inputs on the rear panel of
the keyboard.

Configuring the Pedal Input for a Sustain Pedal
When a switch pedal is connected:
1. Click the MIDI Assignment editor button in the Header to open the MIDI Assignment editor.

2. Select the control element type PEDALS.
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3. Select the pedal input you want to configure, either Pedal A or Pedal B.

4. Select Switch from the Mode drop-down menu.

5. Depending on inverted tip/ring connectivity of the pedal, select either Tip or Ring.

→ The pedal input is configured for a switch pedal with sustain behavior. If you need to change
the MIDI Control Change message assigned to the pedal input, refer to Using the MIDI
Assignment Editor.

Configuring the Pedal Input for an Expression Pedal
When a continuous pedal is connected:
1. Click the MIDI Assignment editor button in the Header to open the MIDI Assignment editor.

2. Select the control element type PEDALS.

3. Select the pedal input you want to configure, either Pedal A or Pedal B.
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4. Select Continuous from the Mode drop-down menu.

→ The pedal input is configured for a continuous pedal with expression behavior. If you need to
change the MIDI Control Change message assigned to the pedal input, refer to Using the MIDI
Assignment Editor.

Depending on the type of pedal, you need to make further adjustments by using the provided
options. The following table gives you an overview of these options:
Option

Description

Invert toggle switch

Some continuous pedals internally support the inverted pedal range but
cannot be configured on the pedal directly. The Invert Range function
allows you to invert the range of the pedal connected to the keyboard.

Swap T/R toggle switch

Allows you to use pedals with inverted tip/ring connectivity.

Recalibrate button

Allows you to recalibrate the input.

When using the MIDI Assignment editor, all keyboard controls (i.e. navigation,
transport, etc.) are blocked.

5.5. Connecting External MIDI Equipment to the Keyboard
The KOMPLETE KONTROL keyboard has dedicated MIDI sockets that allow you to directly connect
other MIDI devices using a 5-pin DIN MIDI cable and integrate the keyboard into your MIDI setup.

The MIDI sockets on the rear panel of the KOMPLETE KONTROL keyboard.

To connect your external MIDI equipment:
1. Connect the device receiving MIDI signals to the MIDI OUT socket on the rear panel of the
keyboard using a 5-pin DIN MIDI cable.
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2. Connect the device sending MIDI signals to the MIDI IN socket on the rear panel of the
keyboard using a 5-pin DIN MIDI cable.
→ The MIDI equipment is connected.
Depending on your use case, additional configuration is required in the software:

•

If KOMPLETE KONTROL is running as a stand-alone application, you need to activate the
corresponding MIDI inputs and outputs of the keyboard on the MIDI page of the Preferences.
For more information refer to Using the Keyboard as Stand-Alone MIDI Controller.

•

If KOMPLETE KONTROL is running as a plug-in in a host, the MIDI configuration is managed by
the host. For more information refer to Using the Keyboard in MIDI Mode.

•

If you are using the keyboard as MIDI controller without a USB connection, MIDI data is directly
sent and received via the keyboard’s MIDI IN and MIDI OUT sockets. For detailed information
on MIDI mapping refer to Using the MIDI Assignment Editor.
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6. Software Overview
This following section provides an overview of the areas and controls of the KOMPLETE KONTROL
software.

Overview of the KOMPLETE KONTROL software.

1. Header: Provides access to general functions like the Main menu, the Preset display, the
Transport and Master Volume controls, as well as options to show and hide user interface
areas. For more information, refer to Header.
2. Plug-in area: Shows your loaded Instrument, Loop, One-shot or Effect and enables you control
it directly in the software. For more information, refer to Plug-in Area.
3. Browser: Provides access to your Instruments, Loops, One-shots and Effects. It also enables
you to add, edit, and manage your Preset files. For more information, refer to Browser.

6.1. Header
The header is where you find general settings that affect KOMPLETE KONTROL globally. It also
lets you access additional user interface areas.

The header.

1. KOMPLETE KONTROL logo: Opens the About screen, which shows the version number of the
KOMPLETE KONTROL software.
2. Browser button: Shows or hides the Browser. For more information, refer to Browser.
3. KOMPLETE KONTROL menu: Opens the KOMPLETE KONTROL menu, which contains a
number of general functions and settings, including the Preferences.
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4. Preset display: Displays the name of the loaded Preset file or KONTAKT key switch. The arrow
buttons on the right skip to the next Preset file in the Browser’s Results list.
5. Perform panel button: Shows or hides the Perform panel, which gives you access to the
parameters of the Scale engine and the Arpeggiator. The Perform panel button lights up blue
when the Scale engine and/or the Arpeggiator are activated. For more information, refer to
Perform Panel.
6. Plug-in panel button: Shows or hides the Plug-in panel, which allows you to customize the
parameter mapping for the Control section on the keyboard for every Preset file. For more
information, refer to Plug-in Panel.
7. Plug-in chain panel button: Shows or hides the Plug-in chain panel and lights up white when
activated. For more information, refer to Plug-in Chain Panel.
8. View button: Switches between Default view and Additional view of the loaded Instrument.
The View button only appears if the loaded Instrument contains an Additional view. The View
button is not available when an Effect is selected.
9. MIDI/Keyboard button: Shows the currently connected keyboard, S25, S49, S61, or S88. If
multiple instances of the KOMPLETE KONTROL software are running (for example in a host),
clicking the button connects the keyboard to this instance. This indicator only appears if at
least one compatible device is connected. When a third-party keyboard is used, the MIDI
button will be displayed instead of the Keyboard. Use the MIDI button to assign third-party
controllers to Native Map. For more information, refer to Switching Instances.
10. Transport controls: Lets you start, stop, and reset the internal clock. When
KOMPLETE KONTROL is loaded as a plug-in in a host, the transport automatically follows the
host transport and this feature is greyed out. For more information, refer to Transport and
Tempo.
11. Tempo control: Lets you adjust the tempo in BPM (beats per minute). For more information,
refer to Transport and Tempo.
12. Master Volume control: Lets you adjust the overall output volume of KOMPLETE KONTROL.
The meter shows the current peak level of the output signal. For more information, refer to
Adjusting Master Volume.
13. CPU meter: Represents the current load on your computer’s processor; it should not go above
70% to avoid clicks and interruptions.
14. MIDI Assignment editor button: Lets you to access all the settings related to the keyboard’s
MIDI mode, as well as pedals. This button only appears in the KOMPLETE KONTROL standalone application. For more information, refer to Using the MIDI Assignment Editor.
15. NI logo: The NI logo opens the About screen, which shows the version number of the
KOMPLETE KONTROL software.

6.2. Browser
The Browser provides you access to your KOMPLETE KONTROL Library and lets you add, edit, and
organize Preset files. It consists of the Library pane together with the Product selector, and of the
Files pane which are explained in the following overviews.
For more information on using the Browser and managing your Preset files, refer to Browsing the
Library, Working with Effects, and Managing the Library.

6.2.1. Library Pane
The Library pane is where you browse for Instruments, Loops, One-shots, Effects, and Preset files.
It consists of the following elements:
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3
4
5

6
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The Library pane.

(1) Library: Displays the Library pane.
(2) Product Type icon: Displays if you are currently browsing for Instruments, Loops or One-shots,
or Effects. This is dependant on which Plug-in slot in the Plug-in chain is selected. For more
information on switching between Product Types, refer to Product Types: Instruments, Loops,
One-shots and Effects.
(3) Content selector: The Globe icon selects factory content and the User icon selects user
content. Only Preset files of the selected content type are displayed in the Results list (8). For more
information, refer to Choosing Between Factory Content and User Content.
(4) Product selector: Selects a particular Product or Effect, Product category, and Bank of the
selected Product. Only Preset files matching your selection are displayed in the Results list (8). For
more information, refer to Product Selector.
(5) TYPES: Browse for Preset files based on Type and Sub-Type tags that have been applied to
them. You can collapse or expand this section by clicking on the arrow next to TYPES. For more
information, refer to Types and Characters Tags.
(6) CHARACTERS: Lets you browse for Preset files based on Characters tags that have been
applied to them. You can collapse or expand this section by clicking on the arrow next to
CHARACTERS. For more information, refer to Types and Characters Tags.
(7) Favorites: When the icon is activated, only favorite Preset files are displayed in the Results list
(8). For more information, refer to Working with Favorites.
(8) Results list: Displays all Preset files that match your entered search criteria. For more
information, refer to Loading Preset Files.
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(9) Control bar: Provides useful tools when browsing and editing the KOMPLETE KONTROL
Library:

•

The Information button (i) displays additional information for the selected Preset file(s).

•

The EDIT button opens the Attribute editor for displaying and editing the tags and properties
of the selected Preset file(s).

For more information, refer to Displaying Preset File Information.
(10) Prehear controls: Lets you audition Preset files. For more information, refer to Auditioning
your Preset Files.
(11) Search field: Lets you perform a text search. For more information, refer to Performing a Text
Search.

6.2.2. Product Selector
When browsing for Instruments, Loops, One-shots or Effects, the Product selector enables you to
limit your search to a specific Category/Vendor, Product, and Bank. Only Preset files matching your
selection are displayed in the Results list.

The Product selector.

(1) Product selector header: The header displays the selected Product. If there is no selection it
shows a generic label (All Instruments or All Effects). A click on the header opens or closes the
Product selector.
(2) Category / Vendor selector: Allows you to sort the Product list by Category or Vendor.
(3) Product list: Displays all Products that are available in your KOMPLETE KONTROL Library.
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If Category is selected in the Category / Vendor selector, the Product list is sorted by the following
categories:

•

DRUMS & PERCUSSION

•

SAMPLED INSTRUMENTS

•

SYNTHESIZERS

•

NO CATEGORY

If Vendor is selected in the Category / Vendor selector, the Product list is sorted by the names of
the manufacturers.
For more information, refer to Filtering Preset Files by Product and Filtering Preset Files by Bank.

6.2.3. Files Pane
The Files pane contains following elements:

The Files pane in the Browser.

(1) Files: Displays the Files pane. For more information, refer to Working with the Files Pane.
(2) Favorite bar: Displays all your favorite folders. A click on any favorite folder lets you jump
directly to that particular path and display its content in the Result list (5). For more information,
refer to Working with File Location Favorites.
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(3) Location bar: Displays the selected path. The Location bar provides various tools to quickly
navigate your file system. For more information, refer to Navigating to File Locations with the
Location Bar.
(4) Recent Locations button: Opens a list of the last visited locations for quickly jumping to any of
them. For more information, refer to Navigating to Recent File Locations.
(5) Results list: Displays the content (files and folders) of the folder shown in the Location bar.
Only files compatible with KOMPLETE KONTROL are displayed. For more information, refer to
Additional Results List Features List in the Files Pane.
(6) Control bar: Provides useful tools when browsing your file system:

•

The Information button (i) displays additional information about the selected files.

•

The IMPORT button lets you import the content of the selected folder to the
KOMPLETE KONTROL Library. Before any files are imported, you can choose which tags will be
assigned to the files in the Attribute editor.

For more information, refer to Editing the Tags and Properties of User Preset Files and Importing
KOMPLETE KONTROL-Compatible User Files.

6.2.4. Browser on the Keyboard
On the keyboard displays, the Browser is organized as follows:

The Browser on the keyboard displays.

•

The left display shows the Product selector parameters which allow you to narrow your search
by selecting the content type (factory or user content), as well as a Product category, a
Product, a BANK, and a SUB-BANK.

•

The right display shows the parameters to further refine your search by selecting the desired
TYPES and CHARACTERS tags. It also shows you the corresponding Results list.

6.3. Perform Panel
The Perform panel lets you access all the parameters related to the Scale engine and the
Arpeggiator.
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The Perform panel.

1. SCALE: Clicking the round button left of SCALE switches the Scale engine on or off. Clicking
the SCALE label displays the Scale engine’s parameters. See Smart Play – Playing and
Editing Scales and Chords for details.
2. ARP: Clicking the round button left of ARP switches the Arpeggiator on or off. Clicking the ARP
label displays the Arpeggiator’s parameters. See Smart Play – Playing and Editing
Arpeggiator Sequences for details.
3. Parameter pages: If multiple pages of parameters are available, you can switch between them
here.
For more information, refer to Smart Play – Playing and Editing Scales and Chords.

6.4. Plug-in Panel
The Plug-in Panel lets you view and customize the parameters mapped to the Control section on
the KOMPLETE KONTROL keyboard for individual Preset files. The amount of pages and
parameters vary depending on the loaded Instrument or Effect.

The Plug-in panel.

For more information, refer to Customizing Parameter Mappings using the Plug-in Panel.

6.5. Plug-in Chain Panel
The Plug-in chain panel is situated at the top of the Plug-in area. The Plug-in chain is the place
where you can directly load Instrument Plug-ins and Samples (Plug-in slot 1), and Effect Plug-ins
(Plug-in slot 2 onwards) and arrange them in horizontal series. Each Plug-in is loaded into a Plug-in
slot to create the Plug-in chain. The arrangement of the Plug-ins is customizable, but only an
Instrument or a Sample can be loaded in to the first Plug-in slot. For more information, refer to
Working with Effects.
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Overview of the Plug-in Chain panel.

1. Plug-in chain: Displays the loaded Instrument or Sample, and Effects.
2. Plug-in slot: Each Plug-in slot represents a Plug-in and displays the Product’s name and
image. Use the Plug-in slots to directly load Plug-ins, bypass Effects and customize the order.

6.6. MIDI Assignment Editor
The MIDI Assignment editor allows you to define what kind of MIDI messages are assigned to the
controls on the KOMPLETE KONTROL keyboard in MIDI mode. This way you can use the keyboard
with MIDI applications or MIDI devices that require specific MIDI messages to be sent in order to
control certain parameters or functions. Multiple templates can be configured for quick recall,
allowing you to prepare controller assignments for different applications and/or devices. The MIDI
Assignment editor lets you change the assignments for the knobs, buttons, the Touch Strip in the
keyboard’s Control section, as well as for connected pedals. For more information, refer to Using
the MIDI Assignment Editor.

Overview of the MIDI Assignment editor.

1. Templates pane: Allows you to create and manage your Templates for MIDI assignments.
2. Templates pane button: Shows/hides the Templates pane.
3. KNOBS, BUTTONS, PEDALS, TOUCHSTRIP: Here you can select the type of control element to
which you can make MIDI assignments.
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4. Pages / Pedal A and Pedal B: For the knobs and buttons you can have multiple assignments,
organized in pages. Here you can select and manage up to four pages. Pedal Assignments
are global and not distinct per Template. Pedals A and B can be independently configured. For
the pedals it is not possible to have multiple assignments.
5. Control elements: Here you can select the control element for a MIDI assignment.
6. Definition area: Defines the MIDI assignment properties for the selected control element.

6.7. Plug-in Area
The Plug-in area of the KOMPLETE KONTROL software is where your Instruments, Loops, Oneshots and Effects are displayed once you have loaded them from the Browser. Each Product offers
a different set of controls and parameters that are all easily controlled directly on the computer
screen or from the keyboard. Parameter changes are mutually reflected by both the displays on
the keyboard and the Instrument’s user interface in the Plug-in area.
For most Instruments, additional views are available that give you access to another
set of controls. See Instrument Views for details.

The Plug-in area displaying the Instrument Form.

6.8. Sampler Plug-In
When loading a sample from the One-shots tab in the Browser, the sample will be automatically
loaded into the Sampler plug-in so it can be played immediately. Important parameters can be
accessed via the GUI, but all parameters for the Sampler plug-in can be accessed via the Plug-in
Panel or a connected keyboard.
For more information on using the Sampler plug-in, refer to Working with Loops and One-Shot
Samples.
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Sampler plug-in.

1. Waveform display: Shows the waveform of the Sample.
2. Start: Determines the Start point of the sample. When Loop is active, the Loop Point
determines the start of the loop.
3. PITCH: Defines the pitch of your sample and adjusts the pitch within three octaves up or
down. As this is a traditional sampler.
4. ENVELOPE: Selects one of three envelope types (One-shot, AHD and ADSR). For more
information, refer to Envelopes.
5. Loop Point: Sets the point at which the loop will start playing. The Loop Point can be set
independently of the Start Point.
6. LOOP: When the ON button is activated, the sample will loop at a length determined by the
Loop Point and End Point.
7. X FADE: Determines the type of fade between the loop points.
8. End Point: Sets the End point of the sample. When Loop is active, the End Point determines
the length of the loop.
9. Timeline: Shows the time scale in seconds.

6.8.1. Envelopes
An envelope allows you to modify the shape and timing of your sample, so you can create more
expressive and dynamic sounds. There are three Envelope types available in the Sampler plug-in;
One Shot, AHD and ADSR. Each Envelope will affect the playback and behavior of the sample.

One-shot
One-shot operates like a typical vintage drum machine; the sample is played in its entirety from
beginning to end, with no envelope. When this type is selected, no parameters are displayed.

The One-shot Envelope.
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AHD
AHD disables the Sustain and Release controls of the ADSR envelope and replaces them with the
Hold parameter. AHD mode is ideal for triggering a sample for a certain amount of time, regardless
of how long the pad is held.

The AHD Envelope.

•

ATTACK: Attack determines how quickly the sample reaches full volume after being triggered.

•

HOLD: Hold determines how long the envelope will stay at its maximum level.

•

DECAY: Decay is used to adjust how fast the sample takes to fade to out.

ADSR
The ADSR Envelope is generally used for longer, sustained samples that require complex dynamic
control.

The ADSR Envelope.

•

ATTACK: Attack determines how quickly the sample reaches full volume after being triggered.

•

DECAY: Decay determines how fast the envelope drops to the Sustain level.

•

SUSTAIN: Sustain determines the constant level being kept after Decay until the note ends.

•

RELEASE: Release determines how long the sound takes to fade out after the note has ended.

SOFTWARE OVERVIEW

39

6.9. Audio Plug-In
When you load a sample of content type Loop from the Browser, the sample is automatically
loaded into the Audio plug-in so you can play it immediately. The Audio plug-in specializes in
keeping audio loops playing in-sync with the project in your host software and has the optional
ability to do so without influencing the key of the loop. Furthermore, you can transpose the loop
while it plays so that it fits the key of your song. Important parameters can be accessed via the
GUI, but all parameters for the Audio plug-in can be accessed via the Plug-in panel or a connected
keyboard. As for any Instrument or the Sampler plug-in, the Audio plug-in uses the first Plug-in slot
in the Plug-in chain.
For more information on using the Audio plug-in, refer to Working with Loops and One-Shot
Samples.
The Audio plug-in provides you with the following elements and parameters:

Audio plug-in.

1. Timeline: Shows the timeline of the loop in musical units, including bars and beats.
2. Waveform display: Shows the waveform of the loaded loop. When a sample is played back, a
playhead is shown in the waveform display. With the scroll wheel of your mouse, you can
zoom in and out the waveform display. Right-clicking on the waveform display opens a context
menu for finding the loop on your computer.
3. Start Marker: Determines the start point of the loop by moving it left or right. You can adjust
the Start Marker only from within the software.
4. End Marker: Determines the end point of the loop by moving it left or right. You can adjust the
End Marker only from within the software.
5. Fade: Sets a simple fade-in/fade-out amount to avoid pops or clicks that may occur when
playing loops with the Audio Plug-in.
6. Tune: Transposes the tune of the loop within the range of -36 to +36 semitones. You can use
this control to set the playback pitch of the loop to 'C', and then the loop's pitch will match the
pitch of notes programmed into the host sequencer. This parameter is only available in Stretch
and Formant Engine mode (8).
7. Pitchbend: Sets the Pitchbend range of the loop from -12 to +12 which is relative to the Tune
parameter. This parameter controls the effect of the Pitch Wheel/Slider on your MIDI
controller. This parameter is only available in Stretch and Formant Engine mode (8).
8. Engine: Here you can choose from three different playback engine modes from the drop-down
menu:
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•

Re-pitch: This playback engine mode matches the tempo of the loop to the host
sequencer's tempo by changing the playback rate of the loop, and playback rate changes
will result in pitch changes to the loop. Like a vinyl record, playing it faster will also cause
the pitch of the loop to rise, whereas slowing it down causes the overall pitch to drop. This
mode is therefore more suitable for non-pitched material, like drums and percussion, and
has the benefit that the transients of sounds remain sharp and also uses significantly less
CPU than the other Engine modes. Since tempo and pitch are not independently adjustable
with this Engine, any pitch automation you may have done via Events entered will be
ignored, only the rhythm of the Events will be used to gate the Loop on and off.

•

Stretch: This playback engine mode provides complete independence between tempo and
pitch. With this engine, you can change the tempo of a loop without changing its pitch, you
can change its pitch without changing its tempo, or you can change both the tempo and
pitch simultaneously. This mode even allows you to automate pitch changes by entering
notes into the host sequencer. As this mode provides complete tempo and pitch
independence, and also works on polyphonic material, it requires more CPU power than
other Engines.

•

Formant: This playback engine mode is best suited to pitched (tonal) audio as it preserves
the formant of the sound. By preserving the formant, it retains the intrinsic character and
avoids any shifts in pitch that would normally result in the undesirable cartoon-like effects
on vocals when they are pitched upwards or downwards.

9. Tempo: Sets the original tempo of your loop so that the Audio plug-in can accurately play it in
sync, no matter what tempo you choose in your host sequencer. This is useful if your host
software has miscalculated the tempo while importing the loop. However, be aware that
changing Tempo during playback could affect the synchronization of your loop.
10. Length: Sets the original length of your loop so that the Audio plug-in can accurately play it in
sync, no matter what tempo you choose in your host sequencer. This is useful if your host
software has miscalculated the length while importing the loop. However, be aware that
changing Length during playback could affect the synchronization of your loop.
All parameters of the Audio plug-in can be adjusted by clicking the parameter and dragging the
mouse upwards or downwards. Pressing the [SHIFT] key on your computer keyboard while
dragging sets finer increments.
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7. Keyboard Overview
The KOMPLETE KONTROL keyboard is tightly integrated into the software and can be used to
browse, control and play your Products as well as to control supported hosts.
The keyboard is available in three sizes: The S49, and S61 are equipped with the same top-quality
semi-weighted Fatar keybed with aftertouch. The S88 comes with professional, fully-weighted,
hammer-action keys, also made by Fatar. Beyond the keybed, all keyboards come with identical
features.
The keyboard is equipped with the following sections:

Top View

KOMPLETE KONTROL S49 top view.

1. Transport section: Controls the transport of supported hosts when KOMPLETE KONTROL is
used as a plug-in. For more information, refer to Transport Section.
2. Perform and Edit section: Lets you edit and control the Smart Play features, e.g., playing
scales, chords, and arpeggiator sequences. The settings made in the Perform and Edit section
are displayed in the Control section (5) and are reflected by the Light Guide and keybed (7). For
more information, refer to Perform and Edit Section.
3. Solo and Mute buttons: Let you instantly solo and mute any Sound or Group in supported
hosts. For more information, refer to Host Integration.
4. Arrange buttons: Let you switch between the different arrangement views and modes in
supported hosts. For more information, refer to Host Integration.
5. Control section: The knobs and displays are automatically assigned to parameters of the
loaded Product or selected mode. For more information, refer to Control Section.
6. Navigation and Mode buttons: Lets you browse your KOMPLETE KONTROL Library and
navigate in your DAW with the 4-D encoder, as well as directly access functions like the Mixer
and MIDI mode. For more information, refer to 4-D Encoder and Mode Buttons.
7. Keybed and Light Guide: Reflect the Smart Play functions by switching LEDs on or off to
indicate active and inactive keys. The Light Guide also reflects the settings of the loaded
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Instrument and can be very helpful to illustrate e.g., BATTERY or KONTAKT mappings. For
more information, refer to Keybed and Light Guide.
8. Touch Strip: The Touch Strip can be assigned to parameters via the MIDI learn function of the
loaded Instrument. For more information, refer to Touch Strip.
9. Pitch and Modulation Wheels: The Pitch Wheel on the left lets you adjust the pitch of the
loaded Instrument. The Modulation Wheel on the right lets you adjust the default modulation
parameter of the loaded Instrument.
10. Transpose and Fixed Velocity buttons: The FIXED VEL (TS Mode) button sets the note
velocity for all keys to a fixed value of 127. The OCTAVE (Semi) down / up buttons transpose
the entire keybed an octave down / up. Pressing SHIFT + OCTAVE (Semi) down / up
transposes the entire keybed a semitone down / up. For more information, refer to Transpose
and Fixed Velocity Buttons.
11. Preset and Page buttons: The PRESET up / down buttons let you skip to the next or previous
Preset file of the loaded Product. The Page left / right buttons let you skip to the next
parameter page and thus remap the knobs and displays to another set of parameters.

Rear View

KOMPLETE KONTROL S49 rear view.

1. Kensington Lock: Allows you to attach a Kensington Lock to secure your device from theft.
2. MIDI IN/OUTsocket: Connect devices for MIDI control. For more information, refer to
Connecting External MIDI Equipment to the Keyboard.
3. Pedal A and Pedal B sockets: Connects sustain and expression pedals. For more information,
refer to Connecting Pedals to the Keyboard.
4. PSU socket (15V - 1.2A): Connects the optional power supply which can be purchased
separately in the Native Instruments online shop.
5. USB connector: Connects the keyboard to your computer with the supplied USB cable.
6. Power button: Switches the keyboard on and off.

7.1. Perform and Edit Section
The buttons in the Perform and Edit section on the far left of the KOMPLETE KONTROL keyboard
allow you to activate the Scale engine, the Arpeggiator, and also access their parameters. The
parameters are visible in the display and can be adjusted using the knobs in the Control section.
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The Perform and Edit section.

1. SHIFT: Lets you access the secondary functions of buttons labeled as such, for example, the
Edit functions of the SCALE (Edit) and ARP (Edit) buttons.
2. SCALE (Edit): Switches the Scale engine on or off, and lets you edit the Scale engine
parameters. For more information, refer to Smart Play – Playing and Editing Scales and
Chords.
3. ARP (Edit): Switches the Arpeggiator on or off, and lets you edit the Arp parameters. For more
information, refer to Smart Play – Playing and Editing Arpeggiator Sequences.
4. AUTO: Lets you activate or deactivate automation in supported hosts. For more information,
refer to Host Integration.
5. QUANTIZE: Lets you quantize events to the step grid in supported hosts. For more
information, refer to Host Integration.
6. UNDO (Redo): Lets you undo or redo your last action in supported hosts. For more
information, refer to Host Integration.

7.2. Transport Section
In supported hosts, the TRANSPORT section at the far left on the keyboard provides you quick and
easy access to functions like play, record, loop, etc.

Transport section.

1. LOOP: Switches between standard and loop playback.
2. METRO: Switches the metronome on or off.
3. TEMPO: Tapping this button lets you set the tempo.
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4. STOP: Ends playback.
5. REC(Count-in): REC(Count-in) switches record on or off. SHIFT + REC(Count-in) switches the
count-in on or off.
6. PLAY(Restart): PLAY(Restart) starts playback. SHIFT + PLAY(Restart) starts playback from
the beginning.

7.3. Control Section
The Control section is located at the center of the KOMPLETE KONTROL keyboard. The knobs,
buttons, and displays are automatically assigned to parameters of the loaded Product or selected
mode. They provide immediate control and allow for deep editing of various aspects of
KOMPLETE KONTROL.

Control section overview.

(1) Buttons 1-8: The eight buttons dynamically adapt their assignment to the selected mode,
allowing for direct access to the most important functions and sub-sections. The displays show
the current assignment below each button.
(2) Displays: The displays give you information related to the shown Product or selected mode,
and show the functions and parameters assigned to the buttons and knobs.
(3) Knobs 1-8: The eight knobs dynamically adapt their assignment to the selected mode, allowing
for direct access to the available parameters. The displays show the current assignment above
each knob. As the knobs are touch-sensitive, you can tap them to see additional information.

7.4. Mode Buttons
The Mode buttons let you browse your KOMPLETE KONTROL Library as well as directly access
functions like the Mixer and MIDI mode.
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Mode buttons.

(1) BROWSER: Displays the Browser in the Control section. For more information, refer to
Browsing the Library.
(2) PLUG-IN: Displays the Plug-in Chain and the selected plug-in the Control section. For more
information, refer to Working with Effects.
(3) MIXER: Displays the mixer of supported hosts in the Control section. For more information,
refer to Host Integration.
(4) SETUP: Displays the hardware serial number and the firmware version, and lets you change the
display brightness. For more information, refer to Keyboard Settings.
(5) MIDI: Accesses MIDI mode that allows you to use the KOMPLETE KONTROL keyboard as a
MIDI controller. For more information, refer to MIDI Communication.
(6) INSTANCE: When using KOMPLETE KONTROL as a plug-in in a host without advanced
integration, this button lets you switch between KOMPLETE KONTROL instances and MIDI Mode.
For more information, refer to Switching Instances and Host Integration.

7.5. 4-D Encoder
The 4-Directional Push Encoder (referred to as the 4-D encoder) combines the functionalities of a
conventional joystick, a button, and a continuous encoder. These aspects make it a multifunctional control element that can be used for navigation, for adjusting values of parameters, and
for controlling Products. Hence, it can be pushed to the four directions: up, down, left, and right, as
well as being pressed and rotated.
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The 4-D encoder situated below the Mode buttons.

Depending on the menu or context, the available actions differ:

•

The displays are navigated by pushing the 4-D encoder in a direction indicated by the four
LEDs.

•

Entries in a list are browsed by turning the 4-D encoder.

•

The value of a highlighted parameter is adjusted by turning the 4-D encoder.

•

A selection is confirmed by pressing the 4-D encoder.

For more information, refer to Browsing the Library, Working with Effects, and Controlling
Instrument, Loop, One-shot and Effect Parameters.

7.6. Keybed and Light Guide
The keybed enables you to play the loaded Instrument, Loop or One-shot. The Light Guide above
the keybed visualizes the key mapping of loaded Instruments and samples by color coding. Active
and inactive keys respectively sample based Instruments are indicated by the LEDs. The
Light Guide also reflects the Smart Play settings. This means when you select e.g., a scale or
chord, the LEDs corresponding to the keys contained in that scale or chord will light up, whereas
inactive keys remain unlit. The Light Guide also gives you visual feedback when you play back
incoming MIDI note patterns from the host.

The Keybed and the Light Guide.

For more information, refer to Controlling Instrument, Loop, One-shot and Effect Parameters,
Smart Play – Playing and Editing Scales and Chords, and Smart Play – Playing and Editing
Arpeggiator Sequences.

7.7. Touch Strip
The Touch Strip is an intuitive control element that gives you immediate control over Instrument
parameters. It can send MIDI pitch bend or control change messages and can be configured in the
MIDI Assignment editor.
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The Touch Strip.

For more information, refer to .

7.8. Transpose and Fixed Velocity Buttons

Transpose and Fixed Velocity buttons.

(1) FIXED VEL (TS Mode): Sets the note velocity for all keys to a fixed value of 127. By default, the
keys are sensitive to velocity: The harder you hit them, the louder the sound will be. With Fixed
Velocity activated, your pads play at the same volume no matter how hard you hit them.
(2 - 3) OCTAVE (Semi) down and OCTAVE (Semi) up: Transpose the entire keybed one octave
down / up. Pressing SHIFT + OCTAVE (Semi) down / up transposes the entire keybed a semitone
down / up. Pressing both buttons simultaneously resets the keybed to the central octave.
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8. Global Controls and Preferences
This sections introduces the global controls and the Preferences you can access via the Header of
KOMPLETE KONTROL.

8.1. Instrument Views
Once you have loaded an Instrument from the Browser, it appears in the Plug-in area of the
KOMPLETE KONTROL software. Most KOMPLETE Instruments come equipped with more than
one view, giving you access to another set of controls or letting you edit certain features in finer
detail. The three possible Instrument views are Default View, Additional View, and Edit View
which can be selected directly in the KOMPLETE KONTROL menu.

Instrument views in the KOMPLETE KONTROL menu.

▶ Alternatively, you can switch between Default View and Additional View by clicking on the View
button in the Header (+ icon).
All Instrument parameters can be controlled at all time from the KOMPLETE KONTROL keyboard,
regardless of the selected Instrument view in the KOMPLETE KONTROL software.
The available views may vary with the loaded Instrument.

8.1.1. Default View
The Default View is the view that first appears when you load an Instrument from the Browser. It
gives you access to some of the most important features of each NKS Instrument with an easy-touse interface.
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POLYPLEX in Default view.

8.1.2. Additional View
Most NKS Instruments have more parameters that can be displayed at once in small surface and
therefore come with a second, Additional View. The Additional View can give you access to
detailed edit controls or to a completely different set of controls altogether depending on the
loaded Instrument.

POLYPLEX in Additional view.

Besides of selecting Additional View via the KOMPLETE KONTROL Menu and the application
menu, you can also do this by clicking the + button in the KOMPLETE KONTROL header. Clicking it
again will return to the Default View.
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The + button opens and closes the Additional view.

8.1.3. Edit View
Edit view is only available for Instruments powered by KONTAKT or REAKTOR.
In the Edit View you have also the possibility to open any KOMPLETE Instrument that can be
loaded or played by either the KONTAKT PLAYER or REAKTOR PLAYER. This gives you access to
all the flexible controls and features you would normally have when using KONTAKT or REAKTOR
in stand-alone mode.

POLYPLEX in Edit View.

Edit view enables you to access files that cannot be loaded from the
KOMPLETE KONTROL Browser, e.g., KONTAKT Multis which can be loaded from the
KONTAKT Browser in edit view.
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8.2. Switching Instances
When two or more instances of the KOMPLETE KONTROL software are running (e.g., as a plug-in
on different tracks of the host), you can choose which instance you want to control from the
KOMPLETE KONTROL keyboard.

Switching to an Instance from the Software
▶ To switch the keyboard to a particular instance of the KOMPLETE KONTROL software, click
the Connect button (keyboard icon) in the header of that instance.

Automatic Switching in a Host
When using KOMPLETE KONTROL as a plug-in in a host with advanced integration, the keyboard
automatically switches between controlling the KOMPLETE KONTROL software and MIDI mode,
depending on the content of the selected track.

•

If you select a track that hosts the KOMPLETE KONTROL plug-in, the keyboard automatically
switches to this instance of the KOMPLETE KONTROL software. This allows you to
immediately control all of your Product’s parameters from the keyboard.

•

If you select a track that does not host the KOMPLETE KONTROL plug-in, the keyboard
automatically switches to MIDI mode. This allows you to assign the available controls on the
keyboard to parameters in the host or in an inserted plug-in via MIDI learn (if supported).

▶ To select a track in a supported host from the keyboard, push the 4-D encoder up or down until
the track is highlighted.

Switching to an Instance from the Keyboard
If you use KOMPLETE KONTROL as a plug-in in a host without advanced integration, you cannot
rely on automatic switching between instances. However, you can still select a particular instance
of the KOMPLETE KONTROL software from the keyboard using its displays and 4-D encoder.
To display and switch between KOMPLETE KONTROL instances from the keyboard, follow the
instructions below:
1. Press the INSTANCE button to show all active instances of the KOMPLETE KONTROL
software on the keyboard displays.
2. Use the 4-D encoder to select an instance.
3. Press the 4-D encoder to switch to the selected instance.
→ You can now control the selected instance of the KOMPLETE KONTROL software from the
keyboard.

8.3. Transport and Tempo
If KOMPLETE KONTROL is used as a stand-alone application, it features its own Transport and
Tempo controls. They are used by sequenced KONTAKT and REAKTOR Instruments as well as the
Arpeggiator. Additionally, the tempo is used by all Instruments that allow you to set timing
parameters in relation to the musical tempo (e.g., rhythmic modulation, delay effects).
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You can find the Transport and Tempo controls in the Header:

Transport and tempo controls in KOMPLETE KONTROL.

(1) Play button: Starts and stops the internal clock. This can be used to control the playback of
sequenced KONTAKT and REAKTOR Instruments.
(2) Reset button: Resets the internal clock to its start position. Consequently, sequencers in
KONTAKT and REAKTOR Instruments will start their playback from the beginning. The same
applies to the Arpeggiator.
(3) Tempo control: Sets the tempo in BPM (beats per minute).
When using KOMPLETE KONTROL as a plug-in, it is automatically synchronized to the
host. Therefore the Transport and Tempo controls are grayed out and inactive.

8.3.1. Resetting the Clock
You can reset the clock in the software and from the keyboard.

Resetting the Clock in the Software
When the internal clock is stopped:
1. Click the Reset button to reset the internal clock.
2. Click the Play button to start playback from the beginning.
When the internal clock is running:
▶ Click the Reset button to reset the internal clock and to resume playback from the beginning.

Resetting the Clock from the Keyboard
When the internal clock is stopped:
1. Press STOP to reset the internal clock.
2. Press PLAY (Restart) to start playback from the beginning.
When the internal clock is stopped:
▶ Press SHIFT and PLAY (Restart) to reset the internal clock and to start playback from the
beginning.
When the internal clock is running:
▶ Press SHIFT and PLAY (Restart) to reset the internal clock and to resume playback from the
beginning.
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8.3.2. Adjusting Tempo
You can adjust the tempo in the software and from the keyboard.

Adjusting Tempo in the Software
The Tempo control allows you to set the tempo in BPM (beats per minute):
1. Click the display and drag the mouse up or down.
2. Alternatively, double-click the display and enter a value numerically.
→ The tempo adjusts in increments of one.

Adjusting Tempo from the Keyboard
You can also use the KOMPLETE KONTROL keyboard to set the tempo in BPM (beats per minute):
▶ Hold TEMPO and turn Knob 1 in the Control section.
→ The tempo adjusts in increments of 1 BPM.

8.4. Adjusting Master Volume
The Master Volume slider lets you adjust the overall output volume of KOMPLETE KONTROL. The
Volume meter shows the current peak level of the output signal.

Master Volume controls.

In order to adjust the output volume:
▶ Click and drag the slider to the left or to the right.
→ This will adjust the output volume in 0.5 dB increments from -30 dB to +10 dB. Below -30 dB,
the keyboard’s volume control is exponentially scaled and quickly lowers the output signal to
complete silence.

Adjusting Master Volume with the Keyboard
To adjust the output volume on the keyboard:
▶ Press and hold SHIFT and turn the Knob 1.

8.5. Preferences
In the Preferences you can specify various settings for KOMPLETE KONTROL.
To open the Preferences:
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▶ Click Edit > Preferences in the KOMPLETE KONTROL menu:

8.5.1. Preferences – Audio Page
The Audio page holds settings related to your audio interface when KOMPLETE KONTROL is
running as a stand-alone application.
When using KOMPLETE KONTROL as a plug-in, the audio configuration is managed
by the host, and the Audio page is not available.
The Routings section allows you to configure the connections between the virtual outputs of
KOMPLETE KONTROL and the physical outputs of your audio interface.

Preferences panel — Audio page.

Setting
Driver

Description
Here you can select the audio driver.
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Description

Device

This allows you to choose from the available devices if you have connected more than
one audio interface.

Status

This shows you whether your audio interface is currently running.

Sample
Rate

This displays the selected sample rate of your audio interface. Please restart
KOMPLETE KONTROL after changing the sample rate.

Buffer Size

macOS: This slider allows you to adjust the buffer size of your audio interface in
samples. Lower values result in a more immediate playing response but increase the
CPU load, and may result in audible clicks and pops. Larger values decrease the CPU
load but introduce a larger latency (a small delay between hitting a pad and hearing it).
It is recommended to find the lowest value that does not cause clicks and pops even
when playing more demanding Products.
Windows: When using an ASIO driver, the Audio page shows an ASIO Config button
instead of the Buffer Size slider. Click this button to open the settings window of the
selected ASIO driver.

Latency

This shows the delays introduced by the current Buffer Size setting.

Routings

Under Routings, you will be presented with a list of the 16 stereo outputs from
KOMPLETE KONTROL: In the right column, you can assign them to the outputs of
your audio interface. Click the fields in the right column to select the desired outputs
via a drop-down menu.

8.5.2. Preferences – MIDI Page
The MIDI page allows you to set up the MIDI input and output ports that you want to use when
KOMPLETE KONTROL is running as a stand-alone application.
When using KOMPLETE KONTROL as a plug-in, the MIDI configuration is managed by
the host, and the MIDI page is not available.
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Preferences panel — MIDI page (entries may vary on your computer).

Element

Description

Input

Clicking Input displays a list of all the available MIDI inputs of your system. You can
activate/deactivate each input by clicking the checkbox next to its name.

Output

Clicking Output displays a list of all the available MIDI outputs of your system. You
can activate/deactivate each input by clicking the checkbox next to its name.

Takeover
Mode

When using third-party controllers, you can select Pickup from the Takeover mode
drop-down menu to prevent potential parameter jumps caused by mismatching knob
positions between software and hardware. For more information, refer to Enabling
Takeover Mode.

The MIDI Output settings are required for using KOMPLETE KONTROL’s Smart Play features with
other MIDI instruments.

8.5.3. Preferences – General Page
The General page holds Usage Data Tracking settings. Usage Data Tracking technology enables
KOMPLETE KONTROL to automatically track anonymous usage data that you can choose to share
with us.
Usage Data Tracking can be activated or deactivated in the General page of the Preferences in the
KOMPLETE KONTROL software. However, we encourage all users to keep Data Tracking activated
as it provides a valuable tool for understanding the performance of Native Instruments
applications when they are used in real life situations. The data sent to Native Instruments is one
hundred percent anonymous and will not affect performance.
For more detailed information about Usage Data Tracking, please refer to the following Knowledge
Base article on the Native Instruments website: https://support.native-instruments.com/hc/enus/articles/209545029
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Usage Data Tracking in the KOMPLETE KONTROL Preferences.

Enabling or Disabling Usage Data Tracking
To enable or disable Usage Data Tracking:
1. Open the General page of
KOMPLETE KONTROL menu.

the

Preferences

by

clicking

Preferences…

in

the

2. Click the Allow usage data tracking checkbox to enable or disable user data tracking.

8.5.4. Preferences – Library Page
The Library page allows you to edit the locations of all KOMPLETE KONTROL Library files (both
Factory and User) that appear in the Library pane of the Browser.
At the top of the page, the Factory and User buttons allow you to switch between the Factory
pane and the User pane.

Factory Pane
The Factory pane shows all factory libraries available. These libraries will appear in the Factory
view of the Browser’s Library pane.
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Preferences panel – the Library page’s Factory pane.

Element

Description

Location column

Shows the path of each library. If you have moved any library to another location
on your computer, click the folder icon on the left of that library and select its
new path.

Product column

Shows the name of each product. These names cannot be edited.

Rescan button

If you have made any change to a library (e.g., changed its location), select it in
the list and click the Rescan button to rescan that library.

User Pane
The User pane shows all user libraries currently used. These include KOMPLETE KONTROL’s
standard user directory as well as any other user directory you might have defined. These libraries
will appear in the User view of the Browser’s Library pane.
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Preferences panel – the Library page’s User pane.

Element

Description

Location
column

Shows the path of each library. If you have moved any library to another location
on your computer, click the folder icon on the left of that library and select its new
path.

Alias column

Shows the alias stored for each library. Click an alias to edit it. Defining aliases for
your user folders is not mandatory, but it can be of great help when working on
different computers (see description below). After adding a location (see Add
below), click the field in the new row and in the Alias column to set the alias for
that new location. The alias of the default user folder, Native Instruments User
Directory, cannot be edited — this is the location where all your user files will be
stored by default.

Scan user
content for
changes at
start-up

Enabled by default, this option automatically detects any new added user content
when starting KOMPLETE KONTROL.

Add button

Click Add to manually add directories to the user library. See below for more
details.

Remove button

Click Remove to remove the selected user library. Files will only be removed from
the KOMPLETE KONTROL Browser, not from your hard disk.

Rescan button

If you have made any change to a library (e.g., added/removed files), select it in
the list and click the Rescan button to rescan that library.

You can resize the Preferences panel at your convenience using the usual method on
your operating system. You can also resize each column by clicking and dragging the
limit between both column headers.
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Adding Folders to the User Library
In the User pane of the Library page, you can add other folders to the user content of your
KOMPLETE KONTROL Library. To do this:
1. Click Add at the bottom of the pane. A folder selection dialog opens up.
2. In the dialog, navigate to the desired folder on your computer and click OK (Choose on
macOS).
→ All KOMPLETE KONTROL-compatible files found in the selected folder are added to your user
content in KOMPLETE KONTROL.

KOMPLETE KONTROL-compatible files include ens, rkplr, nrkt, nksn, nfm8, nabs, nki,
nmsv, nbkt, nis.
Furthermore, the attributes (Instrument/Bank/Sub-Bank, Type/Sub-Type/Characters tags, as well
as properties) of all imported files will be retained.
By adding a folder to the user content of your KOMPLETE KONTROL Library, you make their files
available in the Browser’s Library pane for quick searching and loading.

Paths to folders added via the IMPORT button in the Browser’s Files pane will also
show up here. The only difference between adding folders via the Add button in
Preferences panel described here, and via the IMPORT button in the Files pane of the
Browser is that the latter allows you to directly tag the files as they are imported.
Note that the selected folder cannot contain, or be contained within, a folder already listed in the
User or Factory pane. If KOMPLETE KONTROL detects such a folder as you press OK (Choose on
macOS) in the folder selection dialog, a Duplicate Location message appears: Click OK to return to
the folder selection dialog and select another folder on your computer.

Removing Folders from the User Library
You can also remove any user folder from your library—except the default user content directory
Native Instruments User Content.

8.5.5. Preferences – Plug-ins Page
The Plug-ins page allows you to manage your VST plug-ins in KOMPLETE KONTROL.
At the top of the page, the Manager and Locations buttons allow you to switch between the
Manager pane and the Locations pane.

Manager Pane
The Manager Pane allows you to view and manage all VST plug-ins available in
KOMPLETE KONTROL. By default, all available plug-ins are activated for use in
KOMPLETE KONTROL.
▶ To deactivate a plug-in for use in KOMPLETE KONTROL, click on the checkbox icon next to its
name so it is unchecked.
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The option to Always use latest version of NI Plug-ins selects whether or not your Library content
is always loaded with the latest version of the associated plug-in. If this option is deactivated, your
Library content is loaded with the lowest required version of the associated plug-in found on the
computer.
For example, this option is required if you have installed both the full version of
REAKTOR 5 as well as a KOMPLETE Instrument that came with REAKTOR 6 Player.
By disabling the option, the REAKTOR 5 Factory Library will be loaded with the full
version of REAKTOR 5, while the KOMPLETE Instrument will be loaded with REAKTOR
6 Player. This is necessary since the REAKTOR 5 Factory Library is not authorized for
use with REAKTOR 6 Player.

Preferences panel — the Plug-ins page's Manager pane.

Element

Description

Checkbox column

Activates or deactivates a plug-in for use in KOMPLETE KONTROL.

Plug-in column

Lists all available VST plug-ins in KOMPLETE KONTROL.

Always use latest
version of NI Plug-ins

If this option is activated (default), Library content is loaded with the latest
version of the associated plug-in.
If this option is deactivated, Library content is loaded with the lowest
required version of the associated plug-in.

Locations Pane
The Locations pane allows you manage the folders containing your plug-ins on the hard drive.
KOMPLETE KONTROL scans these folders for VST plug-ins and adds them to the Manager pane.
You can Add and Remove folders from the list, as well as use the Rescan function to update the
available plug-ins in KOMPLETE KONTROL according to any changes made to the folders or their
contents.
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▶ To display the Locations pane, click the Locations button at the top of the Plug-ins page.

Preferences panel — the Plug-ins page's Locations pane.

Setting

Description

Plug-in column

Lists all folders that KOMPLETE KONTROL scans for VST plug-ins.

Add

Opens a file dialogue that lets you add another folder to the list.

Remove

Removes the selected folder from the list.

Rescan

Scans all folders in the list for compatible plug-ins and updates the Manager pane
accordingly.

8.5.6. Preferences - Features Page
Using the Features page, you can enable different configurations of KOMPLETE KONTROL.
Whenever a feature toggle is activated or deactivated, the software must be restarted for the
changes to take effect.
Element

Description

Auto-Scan of Sounds.com Content

Automatically scans the software for content from
Sounds.com

Browser Tag Remapping

Remaps the tags found in the Browser

8.6. Keyboard Settings
The KOMPLETE KONTROL keyboard’s SETUP page gives you access to information and settings
related to the hardware.
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▶ To open the SETUP page, press the SETUP button on the keyboard.

The following information and settings are available:

•

Firmware: The version number of the firmware installed on the keyboard.

•

Serial Nr.: The hardware serial number of the keyboard.

•

Velocity / SCALING: Lets you adjust the velocity response curve of the keybed. Use the Soft 3,
Soft 2, Soft 1 settings to compensate for gentle playing (velocity response is more sensitive),
and the Hard 1, Hard 2, Hard 3 settings to compensate for strong playing (velocity response is
insensitive).

•

Displays / BRIGHTNESS: Lets you adjust the brightness of the keyboard’s displays.

8.7. Loading a Plug-in in Default State
You can load a Plug-in in default state directly from the KOMPLETE KONTROL menu:
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▶ In the KOMPLETE KONTROL menu select e.g., Instruments > Native Instruments > Massive.

→ The Plug-in is loaded. All parameters are set to their default values.

Loading Plug-ins in default state is only possible in the software.
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9. MIDI Communication
KOMPLETE KONTROL provides you with flexible MIDI control and host automation capabilities for
easy integration with your MIDI environment. In this section you are provided with overall
information about MIDI communication and Host automation and you learn how to use the
keyboard in MIDI mode and as stand-alone MIDI controller.

Incoming MIDI
KOMPLETE KONTROL and the Instruments you load inside it can be controlled via MIDI and the
host (when KOMPLETE KONTROL is loaded as a plug-in):

•

Triggering Instruments via MIDI notes: By default, incoming MIDI notes trigger the loaded
Instrument and will also be visually reflected by the Light Guide.

•

Controlling parameters via host automation: You can control parameters of both
KOMPLETE KONTROL and your loaded Instruments via host automation (when
KOMPLETE KONTROL is loaded as a plug-in).

Receiving MIDI Clock
KOMPLETE KONTROL does not receive MIDI Clock. However, when using KOMPLETE KONTROL
as a plug-in, it is automatically synchronized to the host tempo. The tempo display in
KOMPLETE KONTROL’s header is grayed out and tempo is adjusted in the host.

Outgoing MIDI
You can also send MIDI data from KOMPLETE KONTROL:

•

Triggering MIDI instruments and recording MIDI notes: KOMPLETE KONTROL sends MIDI
Note, Pitch Bend, and Channel Pressure (aftertouch) messages to the host and to any MIDI
application or device.

•

Controlling MIDI applications and devices: KOMPLETE KONTROL’s MIDI mode allows you to
send Control Change and Program Change messages to any MIDI application or device.

•

Routing and recording processed MIDI notes: KOMPLETE KONTROL outputs the MIDI notes
generated by the Scale engine and the Arpeggiator through the MIDI outputs of the stand-alone
application as well as the plug-in. You can route the MIDI notes to other MIDI instruments or
record them as a MIDI pattern in the host.
MIDI output is only supported by the stand-alone application as well as the VST and
AAX versions of the plug-in. The AU (Audio Unit) version of the plug-in does not
support MIDI output.

9.1. Mapping MIDI Controls to Third-Party Controllers
MIDI Mapping enhances the user experience and provides more control over sound, workflows
and performance. KOMPLETE KONTROL keyboards are ready-mapped to the software. Third-party
keyboards and controllers can also be used to control some of the parameters in the KOMPLETE
KONTROL software. These parameters include the eight knobs of the Native Map, parameter page
switching, preset switching and plug-in switching.
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Setting up a Third-Party Controller
To map a third-party controller to the KOMPLETE KONTROL software:
1. Connect your third-party controller to your computer.
2. Start KOMPLETE KONTROL.
3. Open the Preferences dialog, and select the MIDI tab.
4. Click the checkbox next to the corresponding name of the third-party controller.
→ The third-party controller is now ready to be used.

Assigning Knobs to a Third-Party Controller
To map a knob on your third party controller to KOMPLETE KONTROL:
1. Click MIDI in the panel header of the software, to open the MIDI Learn panel.
2. Select a MIDI Learn knob in the software and then turn a knob on your keyboard.
3. It is now connected and the knobs should move in line with each other.
4. To map the remaining knobs, repeat this process.

MIDI Learn – Knobs page.

Assigning Buttons to a Third-Party Controller
You can also map buttons on your third-party controller to the software. This will allow you to
select another page of eight control knobs in the software using your keyboard. You can assign
MIDI CCs to move between parameter pages and switch between presets. To map a button to
your keyboard:
1. Click MIDI in the panel header of the software.
2. Select the Buttons tab.
3. Select a button in the software and then press and button on you keyboard.
4. It is now connected and the button should act in accordance with the software.
5. To map the remaining buttons, repeat these steps.

MIDI Learn – Buttons page.
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Enabling Takeover Mode Pickup for Knobs to prevent Parameter Jumps
When switching parameter pages, it can happen that knob positions in the software do not match
with the knob positions on your third party MIDI controller. To prevent potential parameter jumps,
you can enable the Takeover mode Pickup in the Preferences page MIDI.

Takeover mode option on the MIDI page in the Preferences.

When Pickup is activated, turning the knobs on your third party MIDI controller will only change
the value of the corresponding parameter, when the knob pointer reaches (picks up) the respective
value in the software. KOMPLETE KONTROL highlights the difference between the knob positions
using white circles around the knobs in the Plug-in panel. The white circle indicates the knob
position in the software. The knob pointer indicates the position on the hardware.
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Differences between knob positions in the software and on the hardware.

Hardware Configuration for MIDI Mapping
When using the MIDI mapping feature in KOMPLETE KONTROL, a MIDI button can be configured
to send a CC message on push and also on release. This mode is referred to as ‘Toggle’ mode. A
MIDI button can also be configured to send a single message when it is clicked, as opposed to the
two that are sent in Toggle mode. This mode is referred to as ‘Trigger’ mode. To use the MIDI
mapping functionality with a third-party controller, you must configure your third-party controller to
use Trigger mode.

Share Mapping Across Instances
You need to map your keyboard to KOMPLETE KONTROL only once and you can then instantiate
new instances of the software, and the mapping will continue working across all of them.

Instances that are already open as the mapping is changed, will not receive the new
mapping automatically; for them to be updated to the new mapping you must close
your DAW and reopen it.

9.1.1. Setting up a Third-Party Controller
To map a third-party controller to the KOMPLETE KONTROL software:
1. Connect your third-party controller to your computer.
2. Start KOMPLETE KONTROL.
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3. Open the Preferences dialog, and select the MIDI tab.
4. Click the checkbox next to the corresponding name of the third-party controller.
→ The third-party controller is now ready to be used.

9.1.2. Assigning Knobs to a Third-Party Controller
To map a knob on your third-party controller to KOMPLETE KONTROL:
1. Click MIDI in the panel header of the software, to open the MIDI Learn panel.
2. Select a MIDI Learn knob in the software and then turn a knob on your keyboard.
3. It is now connected and the knobs should move in line with each other.
4. To map the remaining knobs, repeat this process.

MIDI Learn – Knobs page.

9.1.3. Assigning Buttons to a Third-Party Controller
You can also map buttons on your third-party controller to the software. This will allow you to
select another page of eight control knobs in the software using your keyboard. You can assign
MIDI CCs to move between parameter pages and switch between presets. To map a button to
your keyboard:
1. Click MIDI in the panel header of the software.
2. Select the Buttons tab.
3. Select a button in the software and then press and button on you keyboard.
4. It is now connected and the button should act in accordance with the software.
5. To map the remaining buttons, repeat these steps.

MIDI Learn – Buttons page.

9.1.4. Enabling Takeover Mode
When you switch parameter pages, it can happen that knob positions in the software mismatch
with the knob positions on your third-party MIDI controller. To prevent potential parameter jumps
when turning the knobs, you can enable Takeover mode by selecting Pickup in the Preferences
page MIDI.
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Takeover mode option on the MIDI page in the Preferences.

When the Takeover mode is activated, turning the knobs on your third-party MIDI controller will
only change the value of the corresponding parameter, when the knob pointer reaches (picks up)
the respective value in the software. KOMPLETE KONTROL highlights the difference between the
knob positions with white circles around the knobs in the Plug-in panel. The white circle indicates
the knob position in the software. The knob pointer indicates the position on the hardware.
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Differences between knob positions in the software and on the hardware.

9.1.5. Hardware Configuration for MIDI Mapping
When using the MIDI mapping feature in KOMPLETE KONTROL, a MIDI button can be configured
to send a CC message on push and also on release. This mode is referred to as ‘Toggle’ mode. A
MIDI button can also be configured to send a single message when it is clicked, as opposed to the
two that are sent in Toggle mode. This mode is referred to as ‘Trigger’ mode. To use the MIDI
mapping functionality with a third-party controller, you must configure your third-party controller to
use Trigger mode.

9.1.6. Share Mapping Across Instances
You need to map your keyboard to KOMPLETE KONTROL only once and you can then instantiate
new instances of the software, and the mapping will continue working across all of them.
Instances that are already open as the mapping is changed, will not receive the new
mapping automatically; for them to be updated to the new mapping you must close
your DAW and reopen it.

9.2. Host Automation
When you load KOMPLETE KONTROL as a plug-in in a host, the parameters of the loaded
Instrument, the Scale parameters, and the Arpeggiator parameters can be automated from the
host.
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9.2.1. Recording Automation
Once your host is set up to record automation you can perform the following actions in the
software as well as from the keyboard:

•

You can enable or disable Scale and Arpeggiator functions by clicking individual buttons in the
software or by pressing the corresponding buttons on the keyboard.

•

You can select values of parameters by turning individual knobs in the software or on the
keyboard.

For detailed information about recording automation in your host, refer to the
documentation of your host software.
Some hosts allow you to handle automation by using automation IDs that are mapped to specific
parameters of the plug-in. KOMPLETE KONTROL comes with a predefined list of automation IDs
which allows the host find them automatically.

9.2.2. Automation IDs for the Perform Panel
The following automation IDs are reserved for parameters in KOMPLETE KONTROL’s Perform
panel:
Automation ID

Parameter

000

Reserved for Instance Recognition and Automatic Focus Follow

001

Scale On / Off

002

Root Note (Scale)

003

Scale Type (Scale)

004

Key Mode (Scale)

006

Chord Mode (Scale)

007

Chord Type (Scale)

026

Arp On / Off

027

Mode (Arp)

028

Type (Arp)

029

Rate (Arp)

030

Sequence (Arp)

031

Swing (Arp)

032

Octaves (Arp)

033

Dynamic (Arp)

034

Gate (Arp)

035

Retrigger (Arp)

036

Repeat (Arp)

037

Offset (Arp)

038

Inversion (Arp)

039

Min. Key (Arp)

040

Max. Key (Arp)
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Parameter
Hold (Arp)

9.3. Using the Keyboard in MIDI Mode
Besides using the KOMPLETE KONTROL keyboard in combination with the KOMPLETE KONTROL
software, you can also use it in MIDI mode as a versatile MIDI controller to pilot MIDI applications
or devices, both via USB or via 5-pin DIN MIDI connections.
KOMPLETE KONTROL sends MIDI Note, Pitch Bend, and Channel Pressure (aftertouch) messages
to trigger MIDI instruments, as well as Control Change and Program Change messages to control
any MIDI application or device.

•

When you switch on the keyboard and the displays show the message PRESS BROWSE, you
are controlling an instance of the KOMPLETE KONTROL software.

•

When you switch on the keyboard and the displays show various MIDI CC numbers, the
keyboard is in MIDI mode. The keyboard directly launches into MIDI mode when the
KOMPLETE KONTROL software is not running.

Switching to MIDI Mode
To switch the keyboard between controlling the KOMPLETE KONTROL software and MIDI mode:
1. Press MIDI on the keyboard.
2. To leave MIDI mode, press any button switching to another mode.

When using the KOMPLETE KONTROL plug-in in a supported host, the keyboard
automatically switches between controlling the KOMPLETE KONTROL software and
MIDI mode, depending on the content of the selected track.

MIDI Assignment
The MIDI mode’s versatility is made possible by the MIDI Assignment editor, which allows you to
freely define MIDI assignments for the controls on the keyboard. For more information, refer to
Using the MIDI Assignment Editor.
1. Use the Page left / right buttons on the keyboard to switch between Pages you created in the
MIDI Assignment editor.
2. Use the PRESET up/down buttons on the keyboard to switch between Templates you created
in the MIDI Assignment editor.

9.4. Using the Keyboard as Stand-Alone MIDI Controller
If you power up the KOMPLETE KONTROL keyboard without a USB connection (while the power
supply is connected), you can use it as a stand-alone MIDI controller by connecting MIDI devices
to the 5-pin DIN MIDI sockets on the keyboard’s rear panel.
The keybed and the controls on the keyboard send out the following MIDI messages:
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Control Element
Pedal A

Message
Type
Controller

CC#
Tip 64

Mode /
Type

Range /
Values

Control
Function

Gate

0-127

Damper Pedal
On / Off
(Sustain)

Ring
65
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Pedal B

Controller

11

-

0-127

Expression
Controller

Pitch Wheel

Pitch Bend

-

-

0-16384

Pitch Bend

Modulation Wheel

Controller

1

-

0-127

Modulation
Wheel or Lever

Touch Strip

Controller

11

Mode:
Standard

0-127

Expression
Controller

Display:
Unipolar
LED Mode:
Bar
Knob 1

Controller

14

Absolute

0-127

Undefined

Knob 2

Controller

15

Absolute

0-127

Undefined

Knob 3

Controller

16

Absolute

0-127

General
Purpose
Controller 1

Knob 4

Controller

17

Absolute

0-127

General
Purpose
Controller 2

Knob 5

Controller

18

Absolute

0-127

General
Purpose
Controller 3

Knob 6

Controller

19

Absolute

0-127

General
Purpose
Controller 4

Knob 7

Controller

20

Absolute

0-127

Undefined

Knob 8

Controller

21

Absolute

0-127

Undefined

Button 1

Controller

112

Toggle
(Action on
Down)

Off 0 / On
127

Undefined

Button 2

Controller

113

Toggle
(Action on
Down)

Off 0 / On
127

Undefined

Button 3

Controller

114

Toggle
(Action on
Down)

Off 0 / On
127

Undefined

Button 4

Controller

115

Toggle
(Action on
Down)

Off 0 / On
127

Undefined

Button 5

Controller

116

Toggle
(Action on
Down)

Off 0 / On
127

Undefined
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Control Element

Message
Type

CC#

Mode /
Type

Range /
Values

Control
Function

Button 6

Controller

117

Toggle
(Action on
Down)

Off 0 / On
127

Undefined

Button 7

Controller

118

Toggle
(Action on
Down)

Off 0 / On
127

Undefined

Button 8

Controller

119

Toggle
(Action on
Down)

Off 0 / On
127

Undefined
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10. Using the MIDI Assignment Editor
This section guides you through the process of mapping MIDI controls and creating Key Zones
using the MIDI Assignment editor. It also makes you familiar with the mapping system and
includes reference information about MIDI message types and assignments.
When using the MIDI Assignment editor, all keyboard controls (i.e. navigation,
transport, etc.) are blocked.

10.1. The Mapping System
Whatever you do on the keyboard, the MIDI Assignment editor translates it into a MIDI message
that is then sent to your computer via USB connection. This is what the MIDI Assignment editor is
all about: mapping human actions to MIDI events.
The MIDI Assignment editor’s mapping system is structured in a way that allows you to efficiently
organize your assignments. This makes the entire mapping process a lot easier and informs you
about what will happen whenever you actuate a control element on the keyboard. The next
paragraphs will introduce you to some basic concepts.

Assignable Controls Elements
Assignable control elements are knobs, buttons, keys, pedals, and the Touch Strip. All other
controls and buttons are not assignable.

Assignments
An assignment defines which MIDI event is triggered by a particular control element. Available
MIDI event types are MIDI messages such as Control Change and Program Change. Every action
on a control element is translated into one MIDI event, the corresponding assignment defines the
rules of that translation.
Depending on the type of control element (buttons, knobs, keys, pedals, and Touch Strip), the
available assignments differ. For more information, refer to MIDI Message Types and
Assignments.

Pages
You can have multiple assignments, organized within Pages. A Page contains eight knobs and
eight buttons, and corresponds to the hardware. One Page can be selected and loaded at a time.
You can have up to four Pages which can be directly selected in the MIDI Assignment editor and
from the keyboard.
When you select another Page, all assignments for the control elements in the Page area are
updated accordingly.

MIDI Templates
A MIDI Template holds a mapping configuration for knobs, buttons, and keys on the keyboard,
including all Pages that might exist. One MIDI Template can be selected at a time. Switching
between different MIDI Templates can be used, for example, to address different applications on
your computer or different MIDI instruments.
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The configuration of the Touch Strips and the Pedals are saved globally and not per
Template. This means all settings made under TOUCHSTRIP and PEDALS remain the
same when switching between Templates.

10.2. Opening the MIDI Assignment Editor
You can open the MIDI Assignment editor with the MIDI Assignment editor button.
▶ Click on the MIDI Assignment editor button in the Header.

→ The MIDI Assignment editor opens. Now you have access to all the settings related to the
keyboard’s MIDI mode.
The MIDI Assignment editor button is only visible when the KOMPLETE KONTROL
keyboard is connected to your computer and switched on.

10.3. Assigning MIDI Messages to Control Elements
This tutorial covers the workflow of assigning MIDI messages to the knobs, buttons, pedals, and
the Touch Strip. If you intend to create new Key Zones, refer to section Creating Key Zones.
In order to assign MIDI messages to control elements:
1. Click on the MIDI Assignment editor button to open the MIDI Assignment editor.

2. Select a MIDI Template in the Templates pane.

3. Select the type of control element.

4. Select the control element you want to assign a MIDI message to.
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5. Select the MIDI message using the drop-down menus and options in the Definition area.

→ The available drop-down menus and options in the Definition area vary depending on the
selected type of control element as well as from the selections in the Definition area itself.
6. If required select or create another page for making multiple assignments.

7. When you have finished assigning MIDI messages, close the MIDI Assignment editor.
→ Your edits are saved to the MIDI Template.
For more information on MIDI message types and assignments, refer to MIDI Message Types and
Assignments.

10.4. Renaming Control Elements
As the default names do not reveal which parameters they are assigned to, you can rename them:
1. Double-click the name of the control element.

2. Enter the desired name with a maximum length of seven characters.

3. Press the enter key to confirm.
→ The name of the control element has changed.

10.5. Creating a New MIDI Template
When using the keyboard in different situations, e.g., in a studio or live on stage, you can create a
different MIDI Template for each setup.
To create a new Template:
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1. In the Templates pane click the + icon.

→ The Add Template dialog appears.
2. Enter a name for the new MIDI Template.

3. Click Add.
→ The new MIDI Template is created. The MIDI Templates are arranged in alphabetical order.

10.6. Renaming MIDI Templates
If you want to change the name of an existing MIDI Template, proceed as follows:
1. Right-click the MIDI Template and select Rename from the context menu.

→ The Rename Template dialog with the current MIDI Template name appears.
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2. Enter the desired MIDI Template name.

3. Click Rename to confirm.
→ The MIDI Template name has changed.

10.7. Creating Key Zones
The MIDI Assignment editor allows you to manage Key Zones. Key Zones can be used to assign
different MIDI channels to certain keys. In this section you learn about Key Zones, how you can
create them, how you select another MIDI channel and set the Light Guide color, and how you
transpose key pitches.

10.7.1. About Key Zones
A Key Zone is a group of contiguous keys to which you can assign a particular MIDI channel. Key
Zones are a flexible and handy tool that allows you to quickly set up advanced key mappings.

•

You do not have to assign each key individually. Instead, assigning a key range to the Key Zone
will automatically set the correct assignments to all included keys.

•

Each Key Zone can have its own MIDI channel, and color setting. These settings are applied to
all of the keys in a Key Zone.

•

Key Zones span the entire range of MIDI notes. You can have between 1 and 16 Key Zones.
Key Zones cannot overlap (i.e. each key can only belong to one single Key Zone), and they
cannot have gaps between them (i.e. each key must belong to a Key Zone). You can disable
particular Key Zones: in this case their keys will not send any MIDI Note message (dead keys).

•

Key Zone assignments are valid per MIDI Template.

Key Zones in the KEYS Tab
At the top of the KEYS tab, the depicted Keybed area allows you to define and manage your Key
Zones over the full range of notes:
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The Keybed area lets you easily create and modify your Key Zones.

The Keybed area shows 128 keys along with a few additional elements:

•
•
•
•

Each existing Key Zone is shown with its color and borders on the keybed.
The octave markers under the keybed indicates the beginning of each octave.
The white frame indicates the selected Key Zone.
Disabled Key Zones are grayed out.

10.7.2. Splitting Key Zones
The process of creating a new Key Zone is straight-forward, and can be achieved by selecting and
splitting an existing Key Zone.
In order to split a Key Zone:
1. Select an existing Key Zone. If there is only one Key Zone it is always selected by default.

2. Click the +Split button to the right above the keybed area.

→ The Key Zone is split into two halves. The right half appears in a different color but has the
same MIDI channel of the left half.
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If you already have 16 Key Zones, the +Split button is deactivated.

If the selected Key Zone is only one-key-wide, the +Split button is deactivated.

10.7.3. Selecting MIDI Channels for Key Zones
After creating a new Key Zone you can select another MIDI channel for the Key Zone so that it can
be used to control another instrument.
To select another MIDI channel for a Key Zone:
1. Select the Key Zone for which you want to select another MIDI channel.

2. Select a MIDI channel from the Channel drop-down menu.

→ The Key Zone’s MIDI channel has changed.

10.7.4. Recoloring Key Zones
When splitting Key Zones the newly created Key Zone automatically gets one of 16 different colors
assigned. If you want to recolor a Key Zone, proceed as follows:
1. Select the Key Zone you want to recolor.
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2. Select a color from the Color drop-down menu.

→ The Key Zone’s color has changed and is reflected by the Light Guide. Repeat the
aforementioned steps if you want to change the colors for other Key Zones.

10.7.5. Resizing Key Zones
To resize a Key Zone:
1. Select the Key Zone you want to resize.

2. Hover the mouse over the selected Key Zone’s lower or upper border.

3. Click and drag your mouse horizontally to the position of your liking and release.

→ The Key Zone is resized. Since Key Zones cannot overlap, dragging the border of a Key Zone
simultaneously resizes the neighbouring Key Zone so that both Key Zones stay “in contact”.
When resizing Key Zones the lower border of the leftmost Key Zone as well as the upper border of
the rightmost Key Zone are fixed and cannot be dragged. You cannot resize a Key Zone to less
than one key, this is also true for the neighbouring Key Zone that is simultaneously resized.
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10.7.6. Disabling Key Zones
Disabling a Key Zone disables the assignments for all included keys: from then on, these keys will
no longer trigger any notes. For example, this can be useful when you want to avoid triggering
unwanted MIDI messages by mistake as you play keys in the neighboring Key Zones, or simply to
have a clean, better organized keybed.
To disable a Key Zone:
1. Select the Key Zone you want to disable.

2. Select the value Off from the Type drop-down menu.

→ The Key Zone and its MIDI assignment are deactivated and grayed out in the Keybed area.
Repeat the aforementioned steps if you want to disable other Key Zones.

On the Light Guide of your KOMPLETE KONTROL keyboard, a deactivated Key Zone
will be indicated by unlit LEDs for the corresponding keys.
You can re-enable a Key Zone at any time.
To re-enable a Key Zone:

USING THE MIDI ASSIGNMENT EDITOR

85

1. Select the Key Zone you want to re-enable.

2. Select the value Note from the Type drop-down menu.

→ The Key Zone with its MIDI assignment is reactivated. Repeat the aforementioned steps if you
want to re-enable other Key Zones.

10.7.7. Deleting a Key Zone
You can delete a Key Zone as follows:
1. Hover the mouse over the Key Zone you want to delete.
2. Click the little cross icon that appears when hovering the mouse over a Key Zone.

→ The Key Zone is deleted and its keys are incorporated into the next Key Zone to the left. If you
delete the leftmost Key Zone, its keys are incorporated into the next Key Zone to its right.

If you only have one Key Zone set up, the cross icon is not available when hovering
the mouse the Key Zone.
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10.7.8. Transposing Key Zones
By transposing a Key Zone you raise or lower the MIDI notes assigned to all keys included in a Key
Zone by the same interval, for example, this is useful if you want the keys in separate Key Zones to
trigger the same MIDI notes. Using the Transpose knob you can transpose any Key Zone within
the range from -127 to 127 MIDI notes. The Transpose knob is set to the default value 0 if a Key
Zone is not transposed.
To transpose a Key Zone, proceed as follows:
1. Select the Key Zone you want to transpose.

2. Turn the Transpose knob to raise or lower the MIDI notes by the desired value.

→ The Key Zone is transposed.
When splitting a transposed Key Zone, the original transpose value is also applied to the newly
created Key Zone.

The original transpose value also is applied to the newly created Key Zone.
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If you transpose one-key wide Key Zones, you can specify the pitch for one-shot
samples.

10.8. MIDI Message Types and Assignments
In this section you find reference information about the MIDI message types provided in the Type
menu and about the several assignments for control elements and for Key Zones.

10.8.1. MIDI Message Types – Type Menu
For all control elements, the assignment definition starts with the same menu: the Type menu.
The Type drop-down menu specifies the type of MIDI message that has to be sent upon action on
this control element. Depending on the type of control element, the entries in this menu will differ
(for example, sending a “play” command from a knob wouldn’t make much sense).
All other parameters displayed in the Definition area depend both on the type of control element
that you are working on, and on the type of MIDI message selected in this Type menu.
Below is a list of all possible MIDI message types to be found in the Type menu.

•

Control Change: Sends MIDI Control Change messages on a specific MIDI channel set by the
Channel parameter (range from 1 to 16, 1 by default). This message changes the value of a
specific continuous controller of the MIDI destination — controlling for example some effect’s
depth in your music application. The continuous controller (CC) number is specified via the
Number parameter (range from 0 to 127). The values to be sent for that controller are specified
in various ways, depending on the type of the selected control element (see next sections).

•

Program Change: Sends MIDI Program Change messages on a specific MIDI channel set by
the Channel parameter (range from 1 to 16, 1 by default). This message switches to another
program (or patch, preset…) of the MIDI destination. The program number to be sent can be
specified in various ways, depending on the type of the selected control element (see next
sections).

•

Note: Sends MIDI Note On/Off messages on a specific MIDI channel set by the Channel
parameter (range from 1 to 16, 1 by default). These messages start and stop MIDI notes
specified by the Note parameter (range from C-2 to G8), at a velocity set by the Value
parameter (range from 0-127).

•

Pitchbend: Sends MIDI pitchbend messages on a specific MIDI channel set by the Channel
parameter (range from 1 to 16, 1 by default). This message changes the pitch of the MIDI
notes sent on the same MIDI channel. Depending on the MIDI destination, it can also be used
to control other parameters.

•

Off: Deactivates MIDI for the control element. Select this entry to disable the control element or
action. The control element/action does not send any MIDI message, hence no parameter is
displayed.

10.8.2. Assignments for Knobs
For the knobs, the Type menu offers the entries Control Change and Program Change. Depending
on the selected entry, a different set of additional parameters is available:
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Type
Control Change

Mode

RANGE

Absolute

From 0-126 / To 1-127

Number

Step

0-127

Relative

-32 to 31

Relative (Offset)

-32 to 31

Program Change

88

From 0-126 / To 1-127

Mode Menu Values for Knobs
For the type Control Change, a Mode menu allows you to select between three operating modes:

•

Absolute: In this mode the control element sends absolute values. The From, To, and
Resolution parameters are the same as for the other message types (refer to above).

•

Relative: In this mode the sent message is in a +1/-1 fashion — actually 1/127, which is then
understood by the target software as +1/-1 in that case. This allows the control element to set
the new Control Change value relative to its current value. Two parameters are available:

•

•

Step: Defines the increment to use. Increase the Step value to trigger greater jumps in the
target parameter value. If you choose a negative value for Step, the control will be inverted.

•

Resolution: Adjusts the sensitivity of the control element to your actions. At high
Resolution values, a little movement of the control element will be enough to trigger the
message. At lower Resolution values, you will have to move it more frankly to trigger the
message.

Relative (Offset): This mode is similar to the Relative mode explained above, with the
difference that here the values sent for the “+1” and “-1” messages are 65 and 63, respectively
— in other terms, they are centered around 64 instead of 0. This is well suited for some
particular software implementations. As in Relative mode, a Step parameter defines the
increment to use, and a Resolution parameter adjusts the sensitivity of the control element to
your actions.

10.8.3. Assignments for Buttons
For the buttons, the Type menu offers the entries Control Change, Program Change, and Note.
Depending on the selected entry, a different set of additional parameters is available:
Type

Mode

Value

Control Change

Toggle

Off/On 0-127

Trigger

0 - 127

Toggle

Off/On 0-127

Trigger

0 - 127

Toggle

0 - 127

C-2 – G8

Gate

0 - 127

C-2 – G8

Program Change

Note

Number

Note

0-127

Mode Menu Values for Buttons
For the buttons control elements listed in the above table, and only for some of the MIDI message
types available for these control elements, you can choose from different behaviors for the way
the data is sent. This is controlled by the Mode menu. This menu can have up to four entries,
depending on the message type that you have selected in the Type menu. Here is the list of all
possible entries:
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•

Toggle: In this mode, the control element has two states, on and off. When you press once, it
switches to the on state — when you press again, it switches to the off state. This can be
useful for enabling and disabling an effect to check how it affects the original sound. In this
mode, there are two VALUE settings: Off defines the value for the off state (from 0 to 127, 0 by
default), and On defines the value for the on state (0 to 127, 127 by default). For the Note
message type, since the off state is predefined (it’s the MIDI Note Off message), you find
instead a single VALUE setting defining the velocity of the MIDI Note On message.

•

Trigger: In this mode, only one message is sent when you hit the control element. For instance,
this can be useful for switching to another program (preset, patch…) or for triggering one-shot
samples (e.g., drum sounds or any other envelope-controlled sounds). In this mode, you thus
find only one VALUE setting, defining the value to be sent when you hit the control element. It
goes from 0 to 127 (127 by default).

•

Gate: In this mode, which is only available for the Note message type, the control element
sends MIDI Note messages. When you press a control element, it sends a MIDI Note On
message — when you release the control element, it sends a MIDI Note Off message. For
instance, this can be useful to temporarily enable an effect while playing. Since the off state is
predefined (it’s the MIDI Note Off message), you find instead a single VALUE setting defining
the velocity of the MIDI Note On message.

10.8.4. Assignments for Key Zones
The assignments described here are valid for the Key Zones.

Type
For Key Zones, the Type menu offers the following entries: Note and Off.

•

Note: Sends MIDI Note On/Off messages. These messages are sent over a specific MIDI
channel set by the Channel parameter. It tells your target to play/stop the note corresponding
to the key you press/release on your keyboard.

•

Off: Disables a Key Zone including the MIDI assignment. When a Key Zone gets reactivated the
previous MIDI assignment is recalled.

Channel
The selected value in the Channel menu determines the MIDI channel for the selected Key Zone.

•

Values range from 1 to 16.

•

Value 1 is always set by default.

Color
The Color setting defines which color should be used in the Light Guide (the LEDs above the keys
on your keyboard) for the selected Key Zone:

•

Red, Orange, Light Orange, Warm Yellow, Yellow, Lime, Green, Mint, Turquoise, Cyan, Blue, Plum,
Violet, Purple, Magenta, and Fuchsia.

Transpose
The Transpose knob lowers or raises MIDI notes of a Key Zone.

•

Value range from -127 to 127.
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Value 0 is always set by default.

10.8.5. Assignments for the Touch Strip
For the Touch Strip, the Type menu offers the entries Control Change and Pitchbend. Depending
on the selected entry, a different set of additional parameters is available:
Type

Range

Number

Control Change

From 0-126/To 1-127

Strength

0-127

Pitchbend

0-100%

Selecting a Type also changes the behavior of Touch Strip. When Control Change is
selected, the Touch Strip can be used like a fader that retains its position even after
you have removed your finger. When Pitchbend is selected, the Touch Strip behaves
like a spring that returns to zero position after you have removed your finger.
For Control Change, you can set the Range of values that is sent when swiping the Touch Strip,
and the Number of the Control Change message. For Pitchbend, you can set the Strength of the
Touch Strip’s spring behavior. As you increase this value, the Touch Strip returns to the zero
position more quickly.
The configuration of the Touch Strips and the Pedals are saved globally and not per
Template. This means all settings made under TOUCHSTRIP and PEDALS remain the
same when switching between Templates.

10.8.6. Assignments for Switch Pedals
For Pedals used as switch, the Type menu offers the entries Control Change and Program
Change. Depending on the selected entry, a different set of additional parameters is available:
Type
Value
Control
Change

Mode
Value

Value

Number

Toggle/Gate

Off/On
0-127

0-127

Trigger

0 - 127

0-127

Inc
Program
Change

Range

Min/Max
(0-127)

Toggle/Gate

Off/On
0-127

Trigger

0 - 127

Inc

Min/Max
0-127

Step

Wrap

-128 to
127

On/Off

-128 to
127

On/Off
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Mode Menu Values for Pedals (Switch)
For the button-like control elements listed in the above table, and only for some of the MIDI
message types available for these control elements, you can choose from different behaviors for
the way the data is sent. This is controlled by the Mode menu. This menu can have up to four
entries, depending on the message type that you have selected in the Type menu. Here is the list
of all possible entries:

•

Toggle: In this mode, the control element has two states, On and Off. If you press once, it
switches to the On state — if you press again, it switches to the Off state. This can be useful for
example for activating some effect, then deactivating it later. This is usually the default mode.
In this mode, you find two numeric fields: Off Value defines the value for the Off state (from 0
to 127, 0 by default), and On Value defines the value for the On state (0 to 127, 127 by default).
For the Note message type, since the Off state is predefined (it’s the MIDI Note Off message),
you find instead a single Value parameter defining the velocity of the MIDI Note On message.

•

Gate: This mode is equal to Toggle with the difference that the state is active for the time the
Pedal is held depressed. In Toggle mode the state is activated until the next time the Pedal is
pressed again.

•

Trigger: In this mode, only one message is sent when you hit the control element. There are no
On or Off states. For example, this can be useful for switching to another program (preset,
patch…) or for triggering one-shot samples (e.g., drum sounds or any other envelope-controlled
sounds). In this mode, you thus find only one numeric field called Value, defining the value to
be sent when you hit the control element. It goes from 0 to 127 (127 by default).

•

Inc: In this mode you can configure the press of a pedal to step through a list of values by
choosing the size of the jump (e.g., 1-2-3-4-5, 2-4-6-8-10 or 3-6-9-12-15), and whether or not the
values wrap around back to the beginning, or stop when they reach their minimum or
maximum.

10.8.7. Assignments for Continuous Pedals
For Pedals used as continuous control, the Type menu offers the entries Control Change and
Program Change. Depending on the selected entry, a different set of additional parameters is
available:
Type

Mode

Range

Control Change

From 0-126 / To 1-127

Program Change

From 0-126 / To 1-127

Number
0-127

For Control Change, you can set the Range of values that is sent when pressing the pedal, and the
Number of the Control Change message. For Program Change, you can set the Range of values
that is sent when pressing the pedal.
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11. Host Integration
When using advanced host integration, the KOMPLETE KONTROL keyboard becomes the
centerpiece of your studio setup. You can use it to control not only the Instrument, Sample or
Effect loaded in KOMPLETE KONTROL but also core functionality of supported hosts.
Before you can make use of advanced host integration you need to set it up first. For
more information, refer to Setting up Host Integration.
Advanced integration of KOMPLETE KONTROL is available in the following hosts:

•
•
•
•
•
•
•
•
•
•

MASCHINE 2
Ableton Live 10
Apple GarageBand
Apple Logic Pro X
Avid Pro Tools
Bitwig Studio
PreSonus Studio One 4.5
Steinberg Cubase Artist 8.5/9/9.5/10
Steinberg Cubase Pro 8.5/9/9.5/10
Steinberg Nuendo 7/8/9/10

11.1. Integration with MASCHINE
If you own MASCHINE, you can control many of MASCHINE’s functions directly from the
KOMPLETE KONTROL keyboard. Furthermore, the Arrange buttons located at the left of the
keyboard’s displays give you access to certain modes and views of the MASCHINE software that
makes the integration of KOMPLETE KONTROL into MASCHINE straight-forward. This section
gives you an overview of the basic controls functions as well as of the advanced integration
controls using the Arrange buttons.

Connect to MASCHINE using the Keyboard
1. Press INSTANCE on the keyboard.
2. Select the MASCHINE instance shown in the display.
3. Press Button 8 (SELECT) to connect the keyboard to MASCHINE.

11.1.1. Basic Control Functions
The available basic control functions of MASCHINE mapped to the keyboard’s controls are
grouped in the tables below.
You can configure your keyboard to trigger a speech announcement for many actions. To activate
Accessibility mode, hold the top left button SHIFT and press the top right button MIXER on the SSeries keyboard.
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TRANSPORT Control
Action in MASCHINE

Button on KOMPLETE KONTROL SSeries

Start/stop playback

PLAY

Restart playback at the beginning of the Loop Range

SHIFT + PLAY (RESTART)

Activate/deactivate recording

REC (COUNT-IN)

Record with count-in

SHIFT + REC (COUNT-IN)

Stop playback/recording

STOP

Activate/deactivate the metronome

METRO

Adjust Tempo

TEMPO + Knob 1

Activate/deactivate Loop

LOOP

PERFORM Control
Action in MASCHINE

Button on KOMPLETE KONTROL SSeries

Activate/deactivate Scale engine for selected Group

SCALE (Edit)

Activate/deactivate Arpeggiator for selected Group

ARP (Edit)

Edit Scale engine for selected Group

SHIFT + SCALE (Edit)

Edit Arpeggiator for selected Group

SHIFT + ARP (Edit)

Display quantization settings

QUANTIZE

Activate/deactivate quantization grid

QUANTIZE + Knob 1

Adjust quantization value

QUANTIZE + Knob 2

Activate/deactivate automation

AUTO

Undo action

UNDO (Redo)

Redo action

SHIFT + UNDO (Redo)

Navigation
Action in MASCHINE

Button on KOMPLETE KONTROL SSeries

Select previous Preset file

PRESET Up

Select next Preset file

PRESET Down

Select previous Plug-in page

Page Left

Select next Plug-in page

Page Right

Mode Buttons
Action in MASCHINE

Button on KOMPLETE KONTROL SSeries

Open Browser

BROWSER

Open Plug-in view

PLUG-IN

Open Mix mode

MIXER
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Action in MASCHINE
Switch
between
MASCHINE
KOMPLETE KONTROL instances

94

Button on KOMPLETE KONTROL SSeries
and

INSTANCE

Enter MIDI Mode

MIDI

Display hardware serial number and firmware version,
and change display brightness

SETUP

11.1.2. Advanced Integration Control Functions
The advanced integration controls using the Arrange buttons located to the left of the
KOMPLETE KONTROL keyboard’s displays and the MIXER button are listed below.

Ideas View
When you press SCENE on the KOMPLETE KONTROL S-Series, you are presented with the Ideas
view in the displays. This view is identical to the Ideas view of the MASCHINE software and gives
you instant control over Scenes and Patterns.

MASCHINE’s Ideas view on the KOMPLETE KONTROL keyboard.

In the Ideas view you can perform the following actions:
Action in MASCHINE

Button on KOMPLETE KONTROL S-Series

Select Scene or create new Scene

Button 1–8

Select another Pattern in Scene and select the
corresponding Group in touch

Knob 1–8

Insert copy of selected Scene

SHIFT + Button 4 (DUPLICATE)

Insert empty Scene

SHIFT + Button 5 (INSERT)

Delete selected Scene

SHIFT + Button 6 (DELETE)

When activated, the next Scene that is selected will
be forced to play from start

SHIFT + Button 8 (RETRIGGER)

Delete selected Pattern

CLEAR

Pattern View
When you press PATTERN on the keyboard, you are presented with the Pattern view in the
displays. The Pattern view is the recommended view for recording.
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MASCHINE’s Pattern view on the KOMPLETE KONTROL keyboard.

Action in MASCHINE

Button on KOMPLETE KONTROL S-Series

Select Pattern or create new Pattern for the
selected Scene

Button 1–8

Select another Sound in Pattern

Knob 1

Select another event (note) in the Pattern

Turn 4-D encoder

Move the selected event up or down

Push 4-D encoder up or down

Move the selected event up or down by octave

SHIFT + push 4-D encoder up or down

Nudge the selected event

Push 4-D encoder left or right

Change length of the selected event

Press and hold + turn the 4-D encoder

Select another Group

Push 4-D encoder to the left or to the right

Double Pattern length

SHIFT + Button 3 (DOUBLE)

Insert copy of selected Pattern

SHIFT + Button 4 (DUPLICATE)

Insert empty Pattern

SHIFT + Button 5 (INSERT)

Delete selected Pattern

SHIFT + Button 6 (DELETE)

Adjust Pattern length

Knob 4

Zoom in or zoom out the Pattern view

Knob 5

Horizontally move visible area in the displays

Knob 6

Vertically move the visible area of the Pattern in the
displays, if notes are residing out of the visible area

Knob 7

Delete Pattern content

CLEAR

TRACK View
When you press and hold TRACK on the keyboard, you are presented with the Track view in the
displays. The Track view is available from every view and can be used for quickly selecting Groups
and Sounds. In other words, it works like a shortcut page. The Track view stays visible as long as
the TRACK button is depressed.
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Track view on the KOMPLETE KONTROL keyboard.

In the Track view you can perform the following actions:
Action in MASCHINE

Button on KOMPLETE KONTROL S-Series

Jump to another Group

TRACK + Button 1–8

Select another Sound of that Group

TRACK + Knob 1–8

Select the Group in the previous/next Scene

TRACK + push 4-D encoder to the left or to the right

Browse and select another Sound in selected
Group

TRACK + turn 4-D encoder

Delete selected Group

CLEAR

Mix Mode
When you press MIXER on the keyboard, you are presented with the Mix mode in the displays. The
Mix mode displays eight of 16 channel strips with Sounds and Groups. The further eight Sounds
can be displayed by pressing the Page buttons.

Mix mode on the KOMPLETE KONTROL keyboard.

In Mix mode you can perform the following actions:
Action in MASCHINE

Button on KOMPLETE KONTROL S-Series

Toggle between volume and panorama control for
Knob 1–8

Press 4-D encoder

Set Button 1–8 to control Group mode

Push 4-D encoder up

Set Button 1–8 to control Sound mode

Push 4-D encoder down

Jump to another Group in Group mode

Button 1–8

Jump to another Sound in Sound mode

Button 1–8

Coarse adjust output volume of the respective
Group or Sound

Knob 1-8
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Button on KOMPLETE KONTROL S-Series

Fine adjust output volume of the respective Group
or Sound

SHIFT + Knob 1–8

Select previous or next Sound or another Group

Push 4-D encoder to the left or to the right

Coarse adjust output volume of selected Group or
Sound

Turn 4-D encoder

Fine adjust output volume of selected Group or
Sound

SHIFT + Turn 4-D encoder

Plug-In View
When you press PLUG-IN on the keyboard, you are presented with the Plug-in view in the displays.
The Page buttons give access to other pages containing further functions to control the selected
Plug-in with the keyboard.

Plug-in view on the KOMPLETE KONTROL keyboard.

In the Plug-in view you can perform the following actions:
Action in MASCHINE

Button on KOMPLETE KONTROL S-Series

Select MASTER channel

Button 1 (MASTER)

Select GROUP channel

Button 2 (GROUP)

Select SOUND channel

Button 3 (SOUND)

Select next or previous Plug-in in Plug-in chain or in
Plug-in Browser

Button 5 and 6

Quick browse Preset files for selected Plug-in

Button 8

Select Preset files in Quick browse

Push 4-D encoder

Select next or previous parameter page

Page Left/Page Right

Adjust parameter values

Knob 1–8

Select another Plug-in in Plug-in chain

Push 4-D encoder left/right

Open Plug-in Browser

Push 4-D encoder

Select Plug-in

Turn 4-D encoder

Insert Plug-in

Push 4-D encoder

Delete Plug-in from Plug-in chain

CLEAR

Key Mode
When you press KEY MODE on the keyboard, you are presented with the Key mode in the displays.
When the Key mode is active the Keybed and Light Guide reflect the PADs behavior and PADs
colors as of the MASCHINE controller.
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Key mode on the KOMPLETE KONTROL keyboard.

11.2. Integration with Ableton Live
If you own Ableton Live, you can control many of its functions directly from the
KOMPLETE KONTROL keyboard. The available functions mapped to the sections of the keyboard
are listed below.
Your host needs to be set up for host integration before you can use this functionality.
For more information, refer to Setting up Host Integration.

The following functionality descriptions apply to the default Ableton Live setup. If e.g.,
different playback settings have been selected the functionality will respect those
settings.

Transport Control
Action in Ableton Live

Button on KOMPLETE KONTROL S-Series

Start playback

PLAY (Restart)

Start recording

REC (Count-In)

Restart playback/recording

PLAY (Restart)

Stop playback/recording at current position

STOP

Relocate playhead position to song start when
stopped

STOP

Start Arranger recording

SHIFT + REC (Count-In)

Scroll playhead position

Turn 4-D encoder

Activate/deactivate loop mode

LOOP

Activate/deactivate metronome

METRO

Tap tempo

TEMPO

Edit Control
Action in Ableton Live

Button on KOMPLETE KONTROL S-Series

Undo action

UNDO (Redo)

Redo action

SHIFT + UNDO (Redo)
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Button on KOMPLETE KONTROL S-Series

Quantize to grid value

QUANTIZE

Toggle automation for selected Track on/off

AUTO

Activate/deactivate Scale engine

SCALE (Edit)

Change Scale engine parameters

SHIFT + SCALE (Edit)

Activate/deactivate Arpeggiator

ARP (Edit)

Change Arpeggiator parameters

SHIFT + ARP (Edit)

Arranger Control
Action in Ableton Live

Button on KOMPLETE KONTROL S-Series

Select previous/next Track

Push 4-D encoder left/right

Select previous/next Clip Slot in Track

4-D encoder down/up

Start/stop selected Clip

Push 4-D encoder

Mute/unmute selected Track

M

Solo/unsolo selected Track

S

Mixer Control
Action in Ableton Live

Button on KOMPLETE KONTROL S-Series

Mute/unmute Channel

M + Button 1–8

Solo/unsolo Channel

S + Button 1–8

Jump to Track

Button 1–8

Select previous/next Track

Push 4-D encoder left/right

Switch Bank

Page Left/Page Right

Set Knob 1–8 to control panorama

SHIFT + push 4-D encoder up

Set Knob 1–8 to control volume

SHIFT + push 4-D encoder down

Show master output volume channel

SHIFT + Page Left/Page Right button

Coarse adjust panorama/volume of selected Track

Knob 1–8

Fine adjust panorama/volume for selected Track

SHIFT + Knob 1–8

11.3. Integration with Apple Logic Pro X and GarageBand
If you own Apple Logic Pro X or GarageBand, you can control many of their functions directly from
the KOMPLETE KONTROL keyboard. The available functions mapped to the sections of the
keyboard are listed below.
Your host needs to be set up for host integration before you can use this functionality.
For more information, refer to Setting up Host Integration.
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Transport Control
Action in Logic Pro X and GarageBand

Button on KOMPLETE KONTROL S-Series

Start playback

PLAY (Restart)

Restart playback

SHIFT + PLAY (Restart)

Start recording

REC (Count-In)

Punch out when recording

PLAY (Restart)

Punch in when playing

REC (Count-In)

Stop playback/recording at current position

STOP

Relocate playhead position to song start when
stopped

STOP

Scroll playhead position

Turn 4-D encoder

Activate/deactivate count-in

SHIFT + REC (Count-In)

Activate/deactivate metronome

METRO

Activate/deactivate loop mode

LOOP

Move Loop by its own length

LOOP + turn 4-D encoder

Tap tempo

TEMPO

Edit Control
Action in Logic Pro X and GarageBand

Button on KOMPLETE KONTROL S-Series

Undo action

UNDO (Redo)

Redo action

SHIFT + UNDO (Redo)

Quantize to grid value

QUANTIZE

Toggle automation between Read mode and Touch
mode

AUTO

Activate/deactivate Scale engine

SCALE (Edit)

Change Scale engine parameters

SHIFT + SCALE (Edit)

Activate/deactivate Arpeggiator

ARP (Edit)

Mute and Solo
Action in Logic Pro X and GarageBand

Button on KOMPLETE KONTROL S-Series

Mute/unmute selected Track

M

Solo/unsolo selected Track

S

Track Navigation
Action in Logic Pro X and GarageBand

Button on KOMPLETE KONTROL S-Series

Select previous/next track

Push 4-D encoder left/right

Select previous/next Region

Push 4-D encoder up/down
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Mixer Controls
Action in Logic Pro X and GarageBand

Button on KOMPLETE KONTROL S-Series

Mute/unmute track

M + Button 1–8

Solo/unsolo track

S + Button 1–8

Jump to track

Button 1–8

Switch Bank

Page Left/Page Right

Set Knob 1–8 to control panorama

SHIFT + push 4-D encoder up

Set Knob 1–8 to control volume

SHIFT + push 4-D encoder down

Select previous Track

Push 4-D encoder left

Select next Track

Push 4-D encoder right

Coarse adjust panorama/volume for selected track

Knob 1–8

Fine adjust panorama/volume for selected track

SHIFT + Knob 1–8

11.4. Integration with Avid Pro Tools
If you own Avid Pro Tools, you can control many of its functions directly from the
KOMPLETE KONTROL keyboard. The available functions mapped to the sections of the keyboard
are listed below.

Your host needs to be set up for host integration before you can use this functionality.
For more information, refer to Setting up Host Integration.

Transport Control
Action in Pro Tools

Control on Keyboard

Start playback

PLAY (Restart)

Stop playback

STOP (Clear)

Activate/deactivate recording

REC (Count-In)

Move playback start point

Turn 4-D Encoder

Move timeline selection

LOOP + turn 4-D Encoder

Activate/deactivate loop playback

LOOP

Activate/deactivate click

METRO

Activate/deactivate count in

SHIFT + REC (Count-In)

You need to create a Click Track in your Pro Tools session before using METRO to
activate the click.

Editing
Action in Pro Tools
Undo

Control on Keyboard
UNDO (Redo)
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Action in Pro Tools
Redo

Control on Keyboard
SHIFT + UNDO (Redo)

Track Navigation and Control
Action in Pro Tools

Control on Keyboard

Select previous/next track

Push 4-D encoder left/right or up/down

Mute selected track

M (Mute)

Solo selected track

S (Solo)

Mixer Mode
Action in Pro Tools

Control on Keyboard

Select previous/next track

Push 4-D encoder left/right

Select track

Button 1–8

Move mixer bank

</>

Mute track 1–8

M + Button 1–8

Solo track 1–8

S + Button 1–8

Set knobs 1–8 to control volume

SHIFT + Push 4-D encoder up

Set knobs 1–8 to control pan

SHIFT + Push 4-D encoder down

Adjust volume/pan for selected track

Knob 1–8

11.5. Integration with Bitwig Studio
If you own Bitwig Studio, you can control many of their functions directly from the KOMPLETE
KONTROL keyboard. The available functions mapped to the sections of the keyboard are listed
below.

Your host needs to be set up for host integration before you can use this functionality.
For more information, refer to Setting up Host Integration.

Transport Control
Action in Bitwig

Control on Keyboard

Start playback

PLAY (Restart)

Start recording

REC (Count-In)

Punch out while recording

PLAY (Restart)

Punch in while playing

REC (Count-In)

Stop playback/recording at current position

STOP

Relocate playhead position to song start when stopped

STOP

Scroll playhead position

Turn 4-D encoder

Activate/deactivate count-in

SHIFT + REC (Count-In)

Activate/deactivate metronome

METRO
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Action in Bitwig

Control on Keyboard

Activate/deactivate loop mode

LOOP

Move loop by its own length

LOOP + Turn 4-D encoder

Tap tempo

TEMPO

Editing
Action in Bitwig

Control on Keyboard

Undo action

UNDO (Redo)

Redo action

SHIFT + UNDO (Redo)

Set quantize to grid value

QUANTIZE

Activate/deactivate automation write

AUTO

Activate/deactivate scale engine

SCALE (Edit)

Edit scale engine parameters

SHIFT + SCALE (Edit)

Activate/deactivate arpeggiator

ARP (Edit)

Edit arpeggiator parameters

SHIFT + ARP (Edit)

Mute and Solo
Action in Bitwig

Control on Keyboard

Mute/unmute selected track

M

Solo/unsolo selected track

S

Track Navigation
Action in Bitwig

Control on Keyboard

Select previous/next track

Push 4-D encoder up/down

Select previous/next clip slot

Push 4-D encoder left/right

Mixer control
Action in Bitwig

Control on Keyboard

Mute/unmute track

(M) + Button 1–8

Solo/unsolo track

(S) + Button 1–8

Jump to track

Button 1–8

Select previous/next track

Push 4-D encoder left/right

Switch bank

</>

Set knobs 1–8 to control pan

SHIFT + Push 4-D encoder up

Set knobs 1–8 to control volume

SHIFT + Push 4-D encoder down

Coarse adjust pan/volume

Knobs 1–8

Fine adjust pan/volume

SHIFT + Knob 1–8
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11.6. Integration with PreSonus Studio One
If you own PreSonus Studio One, you can control many of its functions directly from the
KOMPLETE KONTROL keyboard. The available functions mapped to the sections of the keyboard
are listed below.

Your host needs to be set up for host integration before you can use this functionality.
For more information, refer to Setting up Host Integration.

Transport Control
Action in Studio One

Control on KOMPLETE KONTROL S-Series

Start playback

PLAY (Restart)

Start recording

REC (Count-In)

Punch out while recording

PLAY (Restart)

Punch in while playing

REC (Count-In)

Restart playback

SHIFT + PLAY (Restart)

Stop playback/recording at current position

STOP (Clear)

Relocate playhead position to song start when
stopped

STOP (Clear)

Activate/deactivate count-in

SHIFT + REC (Count-In)

Activate/deactivate metronome

METRO

Activate/deactivate loop mode

LOOP

Tap tempo

TEMPO

Play from loop selection start

Press the 4-D encoder

Set selection as loop area (not in Plugin Mode)

SHIFT + Press the 4-D encoder

Editing
Action in Studio One

Button on KOMPLETE KONTROL S-Series

Undo action

UNDO (Redo)

Redo action

SHIFT + UNDO (Redo)

Set quantize to grid value

QUANTIZE (Auto)

Toggle Automation modes Read and Touch

SHIFT + QUANTIZE (Auto)

Reset selected track volume to 0dB

SHIFT + STOP (Clear)

Track Navigation
Action in Studio One

Control on KOMPLETE KONTROL S-Series

Select previous/next clip

Push 4-D encoder up/down

Select previous/next track

Push 4-D encoder left/right

Move in timeline (not in Mixer mode)

Turn 4-D encoder left/right

Play from loop section start

Press 4-D encoder

Set selection as loop area (not in Plugin Mode)

SHIFT + Press 4-D encoder
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Mixer Mode
Action in Studio One

Button on KOMPLETE KONTROL S-Series

Select track

Button 1–8

Mute/unmute track 1–8

M + Button 1–8

Solo/unsolo track 1–8

S + Button 1–8

Move Mixer bank

</>

Select previous/next track

Push 4-D encoder left/right

Set knobs 1–8 to control volume

SHIFT + Push 4-D encoder up

Set knobs 1–8 to control pan

SHIFT + Push 4-D encoder down

Coarse adjust volume/pan for selected track

Knob 1–8

Fine adjust volume/pan for selected track

SHIFT + Knob 1–8

MIDI Mode
Action in Studio One

Control on KOMPLETE KONTROL S-Series

Assign knobs

Turn Knobs 1–16

Assign buttons

Press Buttons 1–8

Plugin Mode
Action in Studio One
Remote control selected KOMPLETE KONTROL plugin

11.7. Integration with Steinberg Cubase and Nuendo
If you own Steinberg Cubase or Nuendo, you can control many of their functions directly from the
KOMPLETE KONTROL keyboard. The available functions mapped to the sections of the keyboard
are listed below.
Your host needs to be set up for host integration before you can use this functionality.
For more information, refer to Setting up Host Integration.

Transport Control
Action in Cubase and Nuendo

Button on KOMPLETE KONTROL S-Series

Start playback

PLAY (Restart)

Start recording

REC (Count-In)

Punch out while recording

PLAY (Restart)

Punch in while playing

REC (Count-In)

Stop playback/recording at current position

STOP

Relocate playhead position to song start when
stopped

STOP

Scroll playhead position

Turn 4-D encoder
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Action in Cubase and Nuendo

Button on KOMPLETE KONTROL S-Series

Activate/deactivate count-in

SHIFT + REC (Count-In)

Activate/deactivate metronome

METRO

Activate/deactivate loop mode

LOOP

Move loop by its own length

LOOP + Turn 4-D encoder

Tap tempo

TEMPO

Editing
Action in Cubase and Nuendo

Button on KOMPLETE KONTROL S-Series

Undo action

UNDO (Redo)

Redo action

SHIFT + UNDO (Redo)

Set quantize to grid value

QUANTIZE

Activate/deactivate automation write

AUTO

Activate/deactivate scale engine

SCALE (Edit)

Edit scale engine parameters

SHIFT + SCALE (Edit)

Activate/deactivate arpeggiator

ARP (Edit)

Edit arpeggiator parameters

SHIFT + ARP (Edit)

Mute and Solo
Action in Cubase and Nuendo

Button on KOMPLETE KONTROL S-Series

Mute/unmute selected track

M

Solo/unsolo selected track

S

Track Navigation
Action in Cubase and Nuendo

Button on KOMPLETE KONTROL S-Series

Select previous/next track

Push 4-D encoder up/down

Select previous/next region

Push 4-D encoder left/right

Mixer control
Action in Cubase and Nuendo

Button on KOMPLETE KONTROL S-Series

Mute/unmute track

(M) + Button 1–8

Solo/unsolo track

(S) + Button 1–8

Jump to track

Button 1–8

Select previous/next track

Push 4-D encoder left/right

Switch bank

</>

Set knobs 1–8 to control pan

SHIFT + Push 4-D encoder up

Set knobs 1–8 to control volume

SHIFT + Push 4-D encoder down

Coarse adjust pan/volume

Knobs 1–8

Fine adjust pan/volume

SHIFT + Knob 1–8
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11.8. Integration with Hosts using MCU Protocol
You can use the KOMPLETE KONTROL S-Series MK2 in any host which supports the MCU (Mackie
Control Universal) protocol. In this case, the host integration functionality is limited. Setting up
KOMPLETE KONTROL in hosts supporting MCU differs with each host. For more information on
setting up controllers with MCU, refer to the documentation of your host.
The following table provides you with the basic transport controls supported with MCU:
Action in DAW using MCU

Button on KOMPLETE KONTROL S-Series

Basic Transport
Start/pause playback

PLAY (RESTART)

Enable/disable recording

REC (COUNT-IN)

Punch in while recording

REC (COUNT-IN)

Punch out while recording

REC (COUNT-IN)

Stop playback/recording

STOP

Relocate playhead position to start when stopped

STOP

Enable/disable looping

LOOP

Scroll playhead position (if supported by host)

Turn 4-D encoder

Track Navigation
Select previous/next track (if supported by host)

Move 4-D encoder up/down/left/right

Select previous/next region (if supported by host)

Move 4-D encoder up/down/left/right

Full KOMPLETE KONTROL plug-in control (including Browser, Native Map, Light Guide and the
perform features) is available in any host software which supports the available plug-in formats:

•

macOS: VST 64-Bit, AU 64-Bit, AAX 64-Bit

•

Windows: VST 32 and 64-Bit, AAX 32 and 64-Bit

Automatic Track Focus not Supported with MCU
Automatic track focus ist not supported with MCU. However, you can press the INSTANCE button
on your KOMPLETE KONTROL keyboard to call up a dialog in the displays to switch between all
loaded instances of the plug-in.
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12. Browsing the Library
The Browser is where you access your KOMPLETE KONTROL Library with all its Instruments,
Loops, One-shots and Effects. You can search, filter, and load Instrument, Loop, One-shot and
Effect Preset files as well as add them to your personal Favorites from the KOMPLETE KONTROL
software. You can also use your KOMPLETE KONTROL keyboard, or a third-party controller, to
access the Browser, enabling you to search for Presets using only the hardware controls.
You can also save Preset files and tag them in KOMPLETE KONTROL to further add to your
personal user content and build your personal sound library. They are automatically added to the
User section of the KOMPLETE KONTROL Library pane. Adding and editing tags can only be done
using the software. For more information refer to section Saving Preset Files to the User Library
and Editing the Tags and Properties of User Preset Files.

Browsing for Instruments or Effects
Since the same workflows apply to Instruments, Loops, One-shots and Effects, this section refers
to all product types as Products. The Browser automatically switches the product type to either
Effects or Instruments, Loops, and One-shots, depending on the selected slot in the Plug-in chain.
For more information on Product Types and about switching between Product Types, refer to
Product Types: Instruments, Loops, One-shots and Effects.
For a detailed overview of the Browser elements, refer to Browser.

12.1. Browser Basics
This section describes general concepts related to the Browser.

12.1.1. Product Types: Instruments, Loops, One-shots and Effects
Although the Library contains Instruments, Loops, One-shots and Effects, it is not possible to
browse for these four Product Types at the same time. Depending on the selected Plug-in slot the,
Product Type in the Browser switches to “Instrument” or “Effect”:

•

When you start KOMPLETE KONTROL or when you select the first Plug-in slot in the Plug-in
chain, the Product Type is set to Instruments and is represented by the respective icon in the
Browser.

•

When the first Plug-in Slot is selected, you can choose between Instruments, Loops and Oneshots. The Product Type icon will be highlighted accordingly. Instruments is selected as the
default Product Type.

•

When you select any other Plug-in slot, the Product Type is set to Effects, which is reflected by
the respective icon in the Browser.

For more information on the Plug-in chain and usage, refer to Plug-in Chain Panel and Working
with Effects.

12.1.2. Loops and One-shots
The Browser divides samples into Loops and One-Shots. One-shots are typically sampled
instruments or vocals, while loops are usually sections of music. Both filetypes can come from
existing expansion packs and sounds.com.
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When a Loop is selected in the Browser with Prehear turned on, it will begin playing immediately
in-sync with the host if transport is running. If a Loop preview begins part-way through, the Loop
will play once more in full length to ensure you hear the entire Loop in context with your project.
Loops and One-shots can also be dragged directly from the Browser and dropped onto an audio
track within your host DAW.

12.1.3. About the Library and Meta-Information
To organize, find, keep track of, and provide you thousands of Preset files at any time ready for
loading, KOMPLETE KONTROL makes use of a Library. The Library contains the factory content of
your KOMPLETE Instruments, Loops, and One-shots, NKS Instruments, Effects, as well as your
own user content.

Tags
To help you find the right Preset file quickly and efficiently, the Library implements various
techniques that go far beyond the classic folder structure of your operating system—the usage of
tags. For example, each Preset file included in the Library contains tags which describe the Preset
file according to following aspects:

•

The content type of the Preset file, i.e. whether it originates from a Product’s factory library or if
it was created by a user.

•

The Product where the Preset file come from—this can include, e.g., a hierarchical structure
with a Product category, a particular Product, and possibly a Bank of a Product.

•

A variable amount of tags used to describe various characteristics of the Preset file, for
example, the type of effect, the sonic character, the context in which it is used—in a word,
anything that might help you find the file.

Included Preset Files in the Library
The Preset files included in the Library are all KOMPLETE KONTROL-relevant files found in the
folders whose paths are listed in the Library page of the Preferences panel.
You can also save the sounds you created in KOMPLETE KONTROL to the User content section of
the Library pane.

12.1.4. Browsing the Library vs. Browsing Your Hard Disks
Besides of browsing KOMPLETE KONTROL Library the Browser also allows you to navigate your
file system in a classic way. For each way the Browser provides a single pane with its own tools:

•

The Library pane allows you to browse the KOMPLETE KONTROL Library. This is the preferred
way to search for files meeting particular musical requirements. This pane also allows you to
tag your own Preset files to your liking.

•

The Files pane allows you to browse your hard disks by using the hierarchical folder structure
of your operating system. For example, you can use it to navigate KOMPLETE KONTROLrelevant files that have not been imported into the KOMPLETE KONTROL Library—and you can
import them from there.

The Library pane and the Files pane can be accessed by clicking the corresponding tab at the top
of the Browser.
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Click the desired tab to show the corresponding pane of the Browser.

Browsing and loading files from the file system using the KOMPLETE KONTROL
keyboard is not possible. The Browser called up from the keyboard can only load files
that have already been added to the Library. It is best to always import all your files to
the Library and tag them using the software Browser before use.

12.2. Opening the Browser
To open the Browser:
▶ Click on the Browser button (the magnifier symbol) in the header.

Alternatively you can also open the Browser by selecting View > Browser in the
KOMPLETE KONTROL menu.

In stand-alone mode, you can also open/close the Browser from your computer
keyboard via the [B] key.

Calling up the Browser on the Keyboard
On the Plug-in page when the Plug-in chain is entirely empty the displays show No INSTRUMENT
Loaded.

No Instrument loaded.

To call up the Browser on the keyboard’s displays:
▶ Press the BROWSE button.
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12.3. Loading Preset Files
When the Browser is open, you can directly load any of the Preset files shown in the Results list.
When loading a Preset file the corresponding product automatically opens in the Plug-in area.
▶ To load a Preset file, double click the corresponding entry in the Results list.

→ The Preset file and the corresponding Product opens in the Plug-in area.

Loading a Preset File using the Keyboard
To load a Preset file using the Keyboard:
1. Open the Browser by pressing the BROWSER button.
2. Select a Preset file in the Results list by turning Knob 8 in the Control section or by turning the
4-D encoder.
3. Load the selected Preset file by pressing Button 8 in the Control section (LOAD) or by pressing
the 4-D encoder.
→ The Preset file together with the product is loaded and the keyboard switches to the PLUG-IN
page, showing the Product parameters in the Control section.

12.4. Choosing Between Factory Content and User Content
As a default setting, Factory content is selected in the Browser. The Content selector shows the
User content icon, which is used to switch between Factory and User Libraries. When switching
between Factory and User Libraries in the Browser, all tags and product selections will be
remembered.

The Content selector.
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▶ Click the User icon to search for User content in the Browser. The User Library is activated
when the icon lights up. To switch back to Factory content, click the User icon again to
deselect it.

Choosing Between Factory and User Content on the Keyboard
In order to choose between Factory and User content on the keyboard:
▶ Press Button 4 to choose between Factory content (USER off) and User content (USER on). By
default, the Factory content is selected.

12.5. Filtering Preset Files by Product
The Product selector allows you to filter Preset files according to a certain Product.
By default the Product selector header displays All Instruments or All Effects. This means that no
certain Product is selected. In order to filter the Preset files in the Results list by a certain Product
you need to select that Product in the Product selector:
1. Click on the arrow in Product selector header.

→ The Product selector expands, showing you the Product list with all the Instruments, Loops,
One-shots or Effects available in your KOMPLETE KONTROL Library.
2. Select either Category or Vendor in the Category / Vendor selector to filter the Products
accordingly.
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3. Scroll through the Product groups to find the Product you are looking for.
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4. Click on the Product image to select it.

→ The Product selector header shows the Product name. You can now browse for all Preset files
associated with the selected Product in the Results list.
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Loading a Product with its Default Preset File
You can also directly load a Product with its default Preset file:
1. Hover the mouse over the Product entry in the Product selector.
2. Click on the arrow symbol that appears in the upper right corner of the Product entry.

→ The Product with its default Preset file is loaded.

Filtering Preset Files by Product using the Keyboard
In order filter Preset files by Product on the keyboard:
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1. Press and hold SHIFT to access the secondary Browser functions.

2. While holding SHIFT press Button 1 for sorting the Product list by CATEGORY or press Button
2 for sorting the Product list by VENDOR. By default the Product list is showing all Instruments
or all Effects.
3. Release SHIFT.
4. Turn Knob 1 to select a category or a vendor.

5. Turn Knob 2 to scroll through the Product list and find an Instrument.

→ You can now browse for all Preset files associated with your selection in the Results list.

12.6. Filtering Preset Files by Bank
Banks can be additional Libraries (for example Expansions), different versions of the original
Factory Library, or any other content categorization specific to a particular Product.
When you select specific Products in the Product list, an additional Bank drop-down menu
appears under the closed Product selector. The Bank drop-down menu allows you to select a
particular Bank of Preset files for the selected Product if available.
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The Bank menu showing All Banks for POLYPLEX

To select a particular Bank of Preset files for the selected Product:
1. Click the arrow in the Banks menu to expand it.
2. Choose a Bank from the available entries.

→ Upon your selection the Bank menu closes and displays the selected Bank. The Results list
further narrow its content accordingly.
You can remove the selected Bank by clicking the little cross in the closed Bank menu.

Selecting a Bank of Preset Files using the Keyboard
In order to select a particular Preset file Bank of the selected Product:
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▶ Turn Knob 3 to select the desired Bank of the Product.

→ The Results list only displays the associated Preset files.

12.7. Resetting the Product Selection
In order to select another Product, or show Preset files for all Products in your
KOMPLETE KONTROL Library, you have to reset the selection.
To reset the selection in the Product selector:
▶ Click the little cross at the right of the Product name.

→ The selection is reset. The Product selector displays the generic label All Instruments, All
Loops, All One-shots or All Effects. The TYPES and CHARACTERS tags and the Results list
below the Product selector now includes Preset files for all Instruments, Loops, One-shots and
Effects.
Products are only shown in the Product selector if the Library contains files for them.
If a particular Instrument does not show up, make sure it is installed correctly and has
been updated to the latest available version.

Resetting the Product Selection on the Keyboard
To reset the Product selection:
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▶ Turn Knob 2 counterclockwise until ALL PRODUCTS is shown above in the display.

→ The Product selection is reset.

12.8. Types and Characters Tags
The CHARACTERS menu is not available when browsing Effects.
The TYPES and CHARACTERS tags menus enable you to search for Preset files according to
particular characteristics of a sound. Recommended but not mandatorily the TYPES and
CHARACTERS tags bring best results in combination with a selected Instrument.

TYPES and CHARACTERS tags for MASSIVE

As soon the desired tags are selected, the search is limited to the Preset files with corresponding
tags. Tags can also be deselected to broaden the search.

TYPES
TYPES tags are structured into two hierarchical levels—top-level tags and sub-level tags.

•

At first the TYPES menu displays the available top-level tags only.

•

As soon as a tag in the top level is selected, the second level appears underneath with sub-tags
of the selected top-tag.
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•

The hierarchical structure means that the sets of sub-tags are specific to each tag of the level
above.

CHARACTERS
The CHARACTERS tags provides an additional level that is independent of the TYPES levels:

•

In general, CHARACTERS tags refer to technical terms (e.g., Arpeggiated, Percussive,
Synthetic).

•

The CHARACTERS tags are always displayed. You can start your search with the
CHARACTERS menu before, or even without, using the TYPES tags.

•

However, the list of tags available in the CHARACTERS menu will vary depending on the
selected TYPES tags. If no file contains both the Types and Characters tags that you have
selected, the Type tags will prevail and the Characters tags will be deselected.

If you don’t select any tag in the TYPES or the CHARACTERS menus, the Result list will include all
available files for the selected Instrument.
Both the Types as well as the Characters tags menus can be collapsed and expanded by clicking
on the arrows to allow for a larger Results list display.

Expanded TYPES and CHARACTERS menus.

Collapsed TYPES and CHARACTERS menus.

12.8.1. Filtering Preset Files by Types and Characters
The CHARACTERS menu is not available when browsing Effects.
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In this tutorial you will learn how to find a bass line Preset file for the MONARK Instrument using
the Types tags. To start, select the MONARK Instrument in the Product selector. The TYPES
section currently shows only top-level tags:

The MONARK Instrument is selected in the Product selector.

To find a bass sound:
1. Under TYPES, select the Bass tag.
→ Once selected, the second level of tags will appear underneath with Sub-Types like Fingered,
Picked, etc.
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2. Select the Sub-Type matching the desired characteristic for your bass sound. By selecting any
of these tags, e.g., Synth, you will narrow your search to this particular Sub-Type of bass
sounds.

3. Select the Analog tag from the CHARACTERS tags.
→ The Results list is filtered according to the selected Types and Characters tags.
This method allows you to quickly find Preset files for an Instrument with similar characteristics.

Searching for Preset Files by Types and Characters Using the Keyboard
To find a bass sound:
1. Turn Knob 5 (All Types) to select the Bass tag from the Types filter.

→ Upon your selection the second level of tags appears above Knob 6 displaying All Sub-Types.
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2. Turn Knob 6 to select the Sub-Type matching the desired characteristic for your bass line, e.g.,
Synth.

→ The Results list is filtered according to the selected Types and Characters tags.

12.8.2. Selecting Multiple Tags from the Same Level
The CHARACTERS menu is not available when browsing Effects.
In both TYPES and CHARACTERS menus, you can select multiple tags from the same level:
1. Hold [Shift] on your computer keyboard and click two tags at a particular level to select these
tags and all tags in-between.
2. Hold [Ctrl] ([Cmd] on macOS) on your computer keyboard and click any number of tags at a
particular level to select these tags.
→ The result list will include all files that correspond to at least one of the selected tags.
Selecting multiple tags from the same level using the keyboard is not possible.
Nevertheless, the display on the keyboard will show (multi) when multiple tags are
selected in the software.

12.9. Working with Favorites
Favorites in the KOMPLETE KONTROL Browser allow you to quickly view and browse your most
frequently used Preset files. Any Preset file can be assigned to be a Favorite. The Favorites serve
as an additional filter in the Library pane. When activated, the Results list will only show Preset
files that have been assigned to be a Favorite, and also match all other selected filters, including
the search query entered into the search field.
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The KOMPLETE KONTROL Browser showing all Favorites tagged with the Type Bass.

12.9.1. Adding Preset Files to the Favorites
To add a Preset file to the Favorites:
1. Place the mouse cursor over any selected or unselected entry in the Results list.
→ The entry is highlighted and the Set Favorite icon on right appears.

2. Click on the Set Favorite icon to add the corresponding Preset file to the Favorites.
→ The Preset file is added to the Favorites, indicated by the lit Set Favorite icon next to its name.
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You can add any Preset file in the Results list to the Favorites, no matter if it is selected or not.

Adding Preset Files to the Favorites on the Keyboard
In order to add a Preset file to the Favorites on the keyboard:
1. Turn Knob 8 to select the Preset file you want to add to the Favorites in the Results list.

2. Press and hold SHIFT to access the secondary functions.
3. While holding SHIFT press Button 7.
→ The Preset file is added to the Favorites, indicated by the lit Set Favorite icon next to its name.

12.9.2. Displaying Favorites in the Results List
To activate the Favorites filter:
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▶ Click on the Favorites icon next to the search field to activate the Favorites filter.

→ The Favorites icon is now lit and the Results list shows all favorite Preset files.

Displaying all Favorites in the Results list on the Keyboard
In order to display all Favorites in the Results list on the keyboard:
▶ Press Button 7.
→ The Favorites icon is now highlighted in the display and the Results list shows all favorite
Preset files.

12.9.3. Removing Preset Files from the Favorites
To remove a Preset file from the Favorites:
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▶ Click on the lit Set Favorite icon to remove the corresponding Preset file from the Favorites.

→ The Preset file is removed from the Favorites, indicated by the hidden Set Favorite icon. The
next time you select the Favorites filter, the Preset file will not be shown in the Results list.

You can also remove a Preset file from the Favorites when the Results list is not filtered by
Favorites.

Removing Preset Files from the Favorites on the Keyboard
In order to remove a Preset file from the Favorites on the keyboard:
1. Select a favorite Preset file.
2. Press Button 7 to remove the corresponding Preset file from the Favorites.
→ The Preset file is removed from the Favorites, indicated by the hidden Set Favorite icon.

12.10. Performing a Text Search
In the search field you can enter your search query. The search considers all properties such as
Preset file names, Instruments, Banks, Type and Characters tags, directly as you type.

The search field.

1. Click in the search field.
2. Type the desired text to limit the Results to files containing this text.
→ As you start typing, the list of matches will start narrowing in the result list below.
You can also limit the search by selecting Types and Characters tags.
In order to reset both text search tag search, use the Reset button (showing a little cross) on the
right side of the search field. The Instrument selection is not affected.
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12.11. Displaying Preset File Information
▶ Click the Information button (showing a little “i”) next to the EDIT button in the right part of the
Control bar to display information on the file(s) selected in the result list.

→ A box appears above with various information on the selected file(s): File Format, Date
modified, File Size, Type, as well as the Author and Manufacturer properties, if any.

The Information box provides various information on the selected file(s).

If the selected files have different characteristics, the corresponding fields in the Information box
will show multi.

12.12. Auditioning your Preset Files
When you are browsing Preset files, you can audition Preset files by using the Prehear feature at
the bottom of the Browser. For this you need to enable the Prehear feature.

The Prehear controls.

1. Click the Prehear button (showing a little speaker icon) to enable/disable Prehear.
→ When Prehear is activated, you can directly hear Preset files as you select them in the Result
list of the Library pane or Files pane.
2. Drag the Prehear Volume slider next to the Prehear button to adjust the volume of the Preset
files you are pre-listening to.
3. Click on any entry in the Results list.
In order to hear audio of the Prehear feature it is mandatory to configure the audio
interface in the Preferences of KOMPLETE KONTROL.

Auditioning Your Preset Files using the Keyboard
You can also enable/disable the Prehear feature on the keyboard:
1. Press and hold SHIFT.
2. Press Button 8 (PREHEAR) to enable/disable the Prehear feature.
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3. Release SHIFT.
4. Turn Knob 8 to select another Preset file in the Results list.
→ Upon selection this Preset file is played back and the previous Preset file stops playing
instantly.
When you disable Prehear, the playback of any Preset file still being pre-listened is stopped.
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13. Working with Effects
In this section you learn how to work with the Plug-in chain in terms of adding Effects, and
organizing the Plug-in chain. Also, this section assumes you are familiar using the Browser and
already loaded an Instrument.
For more information on using the Browser, refer to Browsing the Library.

13.1. Opening the Plug-in Chain Panel
In order to work with the Plug-in chain in the KOMPLETE KONTROL software you need to make
sure the Plug-in chain panel is displayed.
If this is not the case you can display the Plug-in chain panel by the following action:
▶ Click on the Plug-in chain panel button in the Header.

→ The Plug-in chain panel and the loaded Instrument are displayed. You can now add Effects to
the Plug-in chain.

On the KOMPLETE KONTROL keyboard the Plug-in chain is displayed on the Plug-in page.

13.2. Adding Effects
Once an Instrument, Loop or One-shot has been loaded into the first Plug-in slot, you can then add
Effects to the Plug-in chain. To add an Effect to the Plug-in chain:
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1. Click on the empty Plug-in slot to select it.

→ The Product Type icon in the Browser changes to Effects.

The Product selector provides you with a list of the available Effects.
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2. Browse for an Effect to your liking.

→ The Effect is loaded. Its image (or a generic icon for non-NKS Plug-ins) and name are shown in
the second Plug-in slot. To add more Effects to the Plug-in chain, repeat the aforementioned
steps.

Adding Effects using the Keyboard
Once an Instrument, Loop or One-shot has been loaded into the first Plug-in slot, you can then add
an Effect to the Plug-in chain:
1. Press the PLUG-IN button to show the Plug-in page.
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2. Press Button 6 until you select the empty Plug-in slot.

3. Press the BROWSE button to open the Browser.
→ The label below Button 1 shows the current Product Type EFFECTS.

4. Select an Effect together with a Preset file.
5. Press Button 8 or the 4-D encoder to load the selection.
→ The Effect is added to the second Plug-in slot in the Plug-in chain. To add more Effects to the
Plug-in chain, repeat these steps.

13.3. Selecting Plug-in Slots
When you have several Effects added to the Plug-in chain you can directly jump to a Plug-in slot in
order for adjusting the included Effect.
In order to jump to another Plug-in slot and display the Effect’s controls:
▶ Click on the Plug-in slot you want to select.

Selecting another Plug-in Slot using the Keyboard
In order to select another Plug-in slot in the Plug-in chain using the keyboard:
1. Press PLUG-IN to show the Plug-in page.
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2. Press Button 5 or Button 6 to select the previous or next Plug-in slot in the Plug-in chain.
→ The Plug-in controls are mapped to the knobs accordingly.

You can also select another Plug-in Slot using Button 5 and 6 directly in the Browser.

13.4. Reordering Effects
If you want to reorder your Effects in the Plug-in chain you can easily move them by drag and drop.
In order to move an Effect in the Plug-in chain:
1. Hover the mouse over the Plug-in slot you want to move.
2. Click and hold the left mouse button and move the mouse pointer to the desired position in the
Plug-in chain.
→ The white line between the borders of the Plug-in slots is the current position for dropping the
Plug-in slot.

3. Drop the Effect into a new position in the effects chain.
→ The Plug-in slot now sits at another position in the Plug-in chain and the other Plug-in slots
have moved accordingly.

Reordering Effects on the Keyboard
In order to move an Effect in the Plug-in chain:
1. Press the PLUG-IN button.
2. Press Button 5 or Button 6 to select the Plug-in slot with the Effect you want to move.
3. Press and hold SHIFT in order to access additional controls.
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4. While holding SHIFT press Button 5 or Button 6 to move the selected Effect in the Plug-in
chain.

13.5. Scrolling the Plug-in Chain
Theoretically, it is possible to add an unlimited amount of Effects to the Plug-in chain. If the Plug-in
chain exceeds the space on the GUI due to numerous Effects loaded, big scroll arrows appear on
the left and/or on the right border.

Right scroll arrow.

In order to scroll through the Plug-in chain:
▶ Click the scroll arrow for the respective direction.

13.6. Bypassing Effects
If you temporarily want to listen to the Instrument without a specific Effect for an A/B comparison
but do not want to delete it from the Plug-in chain, you can bypass Effects.
In order to bypass an Effect:
1. Hover the mouse over the Plug-in slot containing the Effect you want to bypass.
→ Additional controls are displayed.
2. Click the Bypass button at the top left of the Plug-in slot.

→ The Effect is now bypassed and the image is grayed out.

Bypassing Effects using the Keyboard
1. Press the PLUG-IN button to show the Plug-in page.
2. Select the Plug-in slot containing the Effect you want to bypass in the Plug-in chain.
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3. Press and hold SHIFT in order to access additional controls.

4. While holding SHIFT press Button 7 (BYPASS).
5. The Effect is now bypassed and its name is grayed out.

13.7. Removing Effects
In order to remove an Effect from the Plug-in chain:
1. Hover the mouse over the Plug-in slot containing the Effect you want to remove.
→ Additional controls are displayed.
2. Click the Remove button at the top right of the Plug-in slot.

→ The Effect is now removed from the Plug-in chain.

Removing Effects from the Plug-in Chain using the Keyboard
In order to remove an Effect from the Plug-in chain:
1. Press PLUG-IN to show the Plug-in page.
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2. Press and hold SHIFT in order to access additional controls.

3. While holding SHIFT Press Button 8 (REMOVE).
4. The Effect is removed from the Plug-in chain.
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14. Working with Loops and One-Shot
Samples
In KOMPLETE KONTROL you can also work with loops and One-shot samples using the Sampler
plug-in or the Audio plug-in. In this section you will learn about the different use cases of the
Sampler plug-in and the Audio plug-in, how you load samples, how you open the Sampler plug-in
and the Audio plug-in, and how to switch between the Sampler plug-in and the Audio plug-in.

14.1. Sampler Plug-In and Audio Plug-In Use Cases
The Sampler plug-in and the Audio plug-in have different use cases and provide different
parameters for adjustments:

•

With the Sampler plug-in you can define the start point and end point of the loaded sample,
and modify the shape and timing. For more information on the parameters of the Sampler
plug-in, refer to Sampler Plug-In.

•

The Audio plug-in specializes in keeping audio loops playing in-sync with the sequencer in your
host software and has the optional ability to do so without influencing the key of the loop.
Furthermore, you can transpose the loop while it plays so that it fits the key of your song. For
more information on the parameters of the Audio plug-in, refer to Audio Plug-In.

14.2. Loading One-Shot Samples and Loops
When you load a sample of the content type One-shot from the Browser, the sample will be
automatically loaded into the Sampler plug-in. When you load a sample of the content type Loop
from the Browser, the sample will be automatically loaded into the Audio plug-in. However, once
the Sampler plug-in or the Audio plug-in is opened, you can still load loops and One-shot samples
into either of them.
To load a loop or One-shot sample from the Browser:
1. Select the first Plug-in slot in the Plug-in chain.
2. Select the content type Loop or One-shot sample in the Browser.
3. Refine your search using TYPES and CHARACTER tags.
4. Drag the loop or One-shot sample from the Results list into the Plug-in area.
→ The loop or One-shot sample is loaded into the corresponding plug-in. You can now play and
edit it using the parameters.
When the Audio plug-in is opened, loops and samples from the Browser will be loaded
into the Audio plug-in. When the Sampler plug-in is opened, loops and samples from
the Browser will be loaded into the Sampler plug-in.

It is not possible to manually save Presets for the Audio plug-in. The Save and Save
As… entries in the KOMPLETE KONTROL menu are grayed out when the Audio plug-in
is opened.
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14.3. Opening the Audio Plug-In or Sampler Plug-In
You can open an empty Audio plug-in or Sampler plug-in using the KOMPLETE KONTROL menu in
the header. This enables you to load samples of each content type into the Audio plug-in or
Sampler plug-in.
To open the Audio plug-in or Sampler empty:
1. Open the KOMPLETE KONTROL menu in the header.
2. Select Instruments > Internal > Audio to open the Audio-plug-in, or select Instruments > Internal >
Sampler to open the Sampler plug-in.

→ The Audio plug-in or Sampler plug-in has opened. It uses the first Plug-in slot in the Plug-in
chain. You can now load loops or One-shot samples from the Browser via drag and drop.

14.4. Switching between the Audio Plug-In and the Sampler
Plug-In
When you intend to use the loaded loop in the Audio plug-in with the Sampler plug-in instead, you
can switch from Audio plug-in to Sampler plug-in. Switching from Audio plug-in to Sampler plug-in
retains the loaded loop and vice versa.
To switch from the Audio plug-in to the Sampler plug-in or vice versa:

WORKING WITH LOOPS AND ONE-SHOT SAMPLES 140

1. Select the first Plug-in slot in the Plug-in chain.
2. Open the KOMPLETE KONTROL menu in the header and select Instruments > Internal >
Sampler, or Instruments > Internal > Audio.

→ The Audio plug-in has switched to Sampler plug-in. The loop retains loaded.

14.5. Playback Behavior of Audio Plug-In in Host Software
When you start playback in your host software, the loop will be triggered and play continuously.
However, the loop will only be audible in locations where you placed notes in the host sequencer.
Furthermore, when you use the playback engine mode Stretch, the pitch of the loop will be
transposed based on the pitch of the note used. For example, note C3 will play the sample at its
original pitch, while C4 will play the sample at one octave higher.
You can also play loops with the keyboard in your host software:

•

When the transport is not running, you can trigger the loop by pressing a key.

•

When the transport is running and you press a key, a gate will open at the positions where
notes are placed in the host sequencer.

For more information on playback engine mode, refer to Audio Plug-In.
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15. Managing the Library
With the Browser you can also organize your own Preset files. In this section you will learn how
you save and manage your own Preset files in the User Library and how to import
KOMPLETE KONTROL-compatible user files.
The workflows for organizing Instrument, Loops, and One-shots Preset files are identical to the
workflows for organizing Effect Preset files. The Product Type cannot be selected in the Browser
directly as this is determined by the Plug-in chain. For more information on Product Types and
switching between Product Types, refer to Product Types: Instruments, Loops, One-shots and
Effects.
For detailed overview of the Browser elements, refer to Browser.

15.1. Saving Preset Files to the User Library
KOMPLETE KONTROL allows you to conveniently save any sound you created with your
Instruments and Effects in a new user Preset file. Your saved Preset files are automatically added
to the user content section of the Library pane and can be filtered and searched like any other
Preset file in the KOMPLETE KONTROL Library. On your hard drive, the user Preset files are saved
in the following folder (sorted by Instrument, in corresponding subfolders):

•

Windows: C:\Users\<your
Content\

•

macOS:
Macintosh
HD/Users/<your
Instruments/User Content/

user

name>\Documents\Native
user

Instruments\User

name>/Documents/Native

The Preset files saved for KOMPLETE Instruments with KOMPLETE KONTROL are compatible with
the stand-alone and plug-in versions. This way you can, for example, open a KONTAKT file you
saved with KOMPLETE KONTROL in the KONTAKT stand-alone application or the plug-in by
opening the file from the user content folder described above.
The Preset files you save in KOMPLETE KONTROL are compatible with MASCHINE.
To add them to the user content section of MASCHINE’s Library pane, click on
Rescan in the User pane of the Library page in the MASCHINE Preferences.

Saving a Preset File
Follow the instructions to save a sound in a new Preset file:
1. Select the Instrument or Effect Plug-in slot for which you wish to save a Preset file.
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2. In the File submenu of the KOMPLETE KONTROL menu, click on Save.

Or, if you want to save a Preset file you are working on with a new name, click on Save As… in
the File submenu of the KOMPLETE KONTROL menu.
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3. Enter a name for your new Preset file and click Save in the Save Preset dialog to save the
Preset file.

→ Your new Preset file immediately appears in the user content section of the Library pane.

15.2. Deleting User Preset Files from the User Library
You can delete user Preset files directly from the Results list:
1. Right-click the desired Preset file and select Delete from the context menu. If you want to
delete several user Preset files at once, first select them as described above, and right-click
any of them.
→ A warning dialog opens to inform you that the Preset file will be not only removed from the
KOMPLETE KONTROL Library but also deleted from your hard disk.
2. Click OK to confirm the deletion (or Cancel to keep the file).
→ The Preset file is deleted from the KOMPLETE KONTROL Library and from your hard disk.

When browsing factory content, the Delete entry is not available in the context menu.
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15.3. Editing the Tags and Properties of User Preset Files
When you save user Preset files in KOMPLETE KONTROL, they are automatically assigned to
Instruments and Banks depending on the Instrument you are using. To further define the
attributes of your user Preset files, you can edit the Types and Characters tags as well as the
general properties of the file. This allows you to organize your user content in a meaningful way
and search for your files using the Types and Characters tags in the Library pane.
The Types and Characters tags are also recognized by the MASCHINE Browser. This
way, you can easily find the user Preset files you saved with KOMPLETE KONTROL in
the User content section of MASCHINE’s Library pane.

The CHARACTERS menu is not available when browsing Effects.
To assign tags to your Preset file and change its properties:
1. Select the Preset file in the Results list and click EDIT in the Control bar to open the Attribute
Editor.

2. Click on TYPES to edit the Types tags for your Preset file.
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3. Click and drag the upper edge of the Attribute Editor upwards to increase its size. This makes
it easier to navigate in the list of available tags.

4. Assign the appropriate tags to your Preset file by clicking the checkboxes next to the
corresponding name.
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5. Click on CHARACTERS to edit the Characters tags for your Preset file. You can assign them in
the same way you assigned the Type tags, by clicking on the appropriate checkboxes.

6. Click on PROPERTIES to edit additional information included in your Preset file. You can enter
your name in the Author field, or, in case you intend to share the Preset file, leave a note in the
Comment field for other users to read.

7. To apply any changes made in the Attribute Editor, click APPLY.

→ Your Preset file is now tagged according to your selection of Types and Characters and the
properties are saved. Close the Attribute Editor by clicking on EDIT.

15.4. Syncing Multiple Instances
When running multiple instances of KOMPLETE KONTROL, either as Standalone and/or as a plugin, updates to the Library will be synced across all instances. If you delete a sample from your User
Library in one instance, the sample will no longer be present in the other instances. Similarly, if you
save a Preset in one instance, that Preset will also be available in the other instances.
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15.5. Working with the Files Pane
This section details the actions you can perform that help you to browse for files on your hard
disks using the Files pane. The Results list of the Files pane shows the files and folders found in
the path selected in the Location bar above.

Only KOMPLETE KONTROL-compatible files are shown in the Results list.

The Results list of the Files pane.

15.5.1. Additional Results List Features List in the Files Pane
In the Files pane the Results list offers a context menu with additional commands. You can open
it with a right-click on the selected entry or entries.

The context menu in the result list of the Files pane.

Following commands are available:
Command

Description

Add to Favorites (folders only)

Adds the selected folder to your Favorites.

Import to Library (folders only)

Imports the selected folder(s) into the Library.

Refresh

Refreshes the display of the list, in case items have been modified
in that folder.

Find in Explorer / Find in Finder

Opens an Explorer/Finder window pointing to the selected folder.

Sort by Name

Sorts the Result list according to the item names.

Sort by Date

Sorts the Result list according to the item dates.
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15.5.2. Navigating to File Locations with the Location Bar
The Location bar shows and lets you modify the selected path. At any time the Results list will
display the content of the path shown here.

The Location bar

The Location bar provides following tools:

•

Up arrow: Use the Up arrow on the left to go one level up in your file system.

•

Selected path: Within the path displayed, you can:

•

Click any folder name to jump to that folder.

•

Click any right-pointing arrow after a folder name to open a list of its subfolders, and select
any entry in the list to jump to that folder.

•

If all the levels cannot be displayed in the path, click the double left-pointing arrow left of
the path to display the remaining upper levels (up to the Workspace, representing the
highest level in your file system), and select any entry in the list to jump to that location.

15.5.3. Navigating to Recent File Locations
The Recent Locations button shows a clock icon at the right of the Location bar:

The Recent Location button.

The last 10 locations you have visited are stored by KOMPLETE KONTROL and available here:
▶ Click the Recent Location button and select any recently visited location from the list.
→ This location is loaded in the Location bar and its content displayed in the result list.

15.5.4. Working with File Location Favorites
Located at the top of the Files pane, the favorite bar displays all your favorite folders. Favorite
folders are shortcuts to specific locations in your file system.
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The Favorite bar, at the top of the Files pane.

Favorite folders can be useful if you often return to the same location while browsing your file
system in the Files pane. The default favorite folders are the roots of each of your hard disks, your
desktop folder, and your user folder.

Jumping to Favorite Folders
▶ Click any favorite folder in the Favorite bar to jump to that location.
→ The selected location is loaded in the Location bar and its content appears in the Results list.

Adding and Removing Favorite Folders
You can add your own favorite folders to the Favorites bar. This is done in the Results list:
1. Navigate to the parent folder containing the folder you want to use as a favorite so that this
folder appears in the Results list.
2. In the Results list, right-click the desired folder and select Add to Favorites from the context
menu.

You can also remove any Favorite from the Favorite bar:
▶ To remove a favorite folder, right-click it in the Favorite bar and select Remove from Favorites.

15.6. Loading VST Plug-ins
KOMPLETE Instruments and VST plug-ins supporting the Native Kontrol Standard (NKS) are
automatically loaded when you call up a Preset file from the KOMPLETE KONTROL Library.
However, you can also load plug-ins directly, allowing you to integrate any VST plug-in in
KOMPLETE KONTROL. This way you can play your VST plug-ins using the Smart Play features,
map their parameters to the controls on the keyboard, and save Preset files for them in your
KOMPLETE KONTROL User Library.
To load a VST plug-in in KOMPLETE KONTROL:
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▶ Select the plug-in you want to load in the Plug-ins submenu of the KOMPLETE KONTROL
menu.

If your VST plug-ins do not show up in the Plug-ins submenu, check if the VST plug-in
folders on your hard drive are correctly added to the Locations pane on the
Preferences’ Plug-ins page.

15.7. Installing NKS Instruments
Native Kontrol Standard (NKS) is a software instrument format that allows third-party developers
to integrate with KOMPLETE KONTROL and MASCHINE hardware and software at the same deep
level as KOMPLETE Instruments and Effects.
The Native Kontrol Standard includes:

•

Seamless integration into the KOMPLETE KONTROL Browser for a unified browsing
experience.

•

Full parameter mapping for instant hands-on control.

•

Support of KOMPLETE KONTROL features such as the Light Guide.

NKS Instruments can be found in the KOMPLETE KONTROL Browser next to your
KOMPLETE Instruments. All of their Preset files are fully tagged, so filtering in the Browser gives
you matching results from both KOMPLETE Instruments and NKS Instruments. And when you
load a Preset file from an NKS Instrument, its parameters are automatically mapped to the
controls on the keyboard.

Installing VST Plug-ins with NKS Support
VST plug-ins with NKS support are automatically added to your Library when you start
KOMPLETE KONTROL for the first time after completing their installation. The folders containing
the Preset files for NKS support can be managed in the Factory pane on the Library page of the
Preferences. For more information, refer to Preferences – Library Page.

Installing KONTAKT and REAKTOR Instruments with NKS Support
Third-party developers of KONTAKT and REAKTOR Instruments provide you with a folder that
contains all Instrument files, including Preset files and samples. Instead of running an installer, this
folder needs to be stored on the hard drive. The Instrument can then be activated with Native
Access, which also adds it to the KOMPLETE KONTROL Library. If you are using KONTAKT or
REAKTOR, the Instrument is automatically added to their respective Browser.
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To activate your KONTAKT Instrument with NKS support and add it to the KOMPLETE KONTROL
Library, follow the steps below:
1. Start the stand-alone version of the KOMPLETE KONTROL software.
2. Open the File sub-menu in the KOMPLETE KONTROL menu and click on Manage Products…

→ Native Access opens, showing all installed products.
3. Click on Add a serial in the top-left corner of Native Access.

4. Enter the serial number of the Instrument and click ADD SERIAL.

→ Native Access asks you to browse to the folder containing the Instrument files. Before you do
this, ensure that you have copied the folder to its final location on your computer.
5. Click BROWSE and open the folder containing the Instrument files in the file dialog.
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6. Click on INSTALL to add the Instrument to your KOMPLETE KONTROL Library.

→ The Instrument is installed. KOMPLETE KONTROL automatically scans for the new content
and adds it to the KOMPLETE KONTROL Browser.

The KOMPLETE KONTROL Library and the KONTAKT Browser reference the
Instrument files contained in the folder. It is recommended to not delete or move the
folder afterwards, otherwise KOMPLETE KONTROL and KONTAKT will not be able to
find the Instrument files. If an Instrument cannot be found, use the Rescan function
on the Preferences’ Library page to update the Library with the correct folder location.

15.8. Importing KOMPLETE KONTROL-Compatible User
Files
Apart from the huge KOMPLETE factory library, you might want to use, e.g., your own REAKTOR
ensembles or KONTAKT Instrument files you received from other users.
You can load them directly from the Files pane, but you won’t be able to find and load them from
the keyboard’s on-screen Browser nor from the Library pane.
For this you will have to import the files into the Library first. Importing files does not mean they
will be moved from the directory they currently reside in, they will only be referenced by the
Browser. That’s why whenever you move files, make sure to update the paths to their respective
directories in the Library page of the Preferences panel.
The Files pane allows you to import whole folders. All KOMPLETE KONTROL-compatible files
found in the selected folder(s) will be imported.

Procedure
To import a folder, do the following:
1. In the Files pane, navigate to the folder containing the files you want to import.
2. Select the desired folder.

MANAGING THE LIBRARY 153

3. Click the IMPORT button at the bottom right of the Browser.
→ You will be presented with the Attribute Editor.
4. In the Attribute Editor, tag the files you are about to import to the Library.
5. Click OK at the bottom right of the Browser to import the files to the Library.
→ All KOMPLETE KONTROL-compatible files found in the selected folder(s) are imported to your
Library. They are added as user content. Furthermore, the paths of the imported folders are
added to the list of user libraries in the User pane of the Library page in the Preferences panel.
You can also apply/remove tags at any time after they are imported. However, it may
be best to tag files upon import, since it will make it easier to find them later.
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16. Controlling Instrument, Loop, Oneshot and Effect Parameters
This section introduces you to controlling Instrument, Loop, One-shot and Effect parameters using
the KOMPLETE KONTROL keyboard and explains how to customize parameter mappings.

16.1. About Pre-Mapped Instruments, Loops, One-shots
and Effects
All KOMPLETE and NKS Instruments are pre-mapped, which means that the keyboard’s knobs are
automatically assigned to key parameters as soon as you load an Instrument in
KOMPLETE KONTROL. You do not have to manually configure a mapping or assign knobs via MIDI
learn.
You can customize the parameter mapping for each Preset file in the Plug-in Panel of
the KOMPLETE KONTROL software. For more information, refer to Customizing
Parameter Mappings using the Plug-in Panel.

16.2. Adjusting Parameters
Once you have loaded an Instrument or Effect, the eight knobs on the keyboard are automatically
assigned to eight Instrument parameters. Whenever you turn a knob on the KOMPLETE KONTROL
keyboard, the mapped parameter visually reflects the movement in the KOMPLETE KONTROL
software.
▶ To adjust an Instrument parameter, turn the corresponding knob on the keyboard. The
mapping of each knob is indicated by the displays.

16.3. Switching Parameter Pages
Many Instruments and Effects are equipped with much more than eight parameters. To provide
quick access to additional parameters, the Page buttons (left and right arrows) to the left of the
Control section let you skip through parameter pages. This remaps the knobs to a different set of
Instrument parameters.
▶ To skip to another parameter page and remap the eight knobs to a new set of controls, press
the Page buttons left or right.
→ The number at the bottom right of the right display indicates the current parameter page and
the total number of available pages for the loaded Instrument.

16.4. Customizing Parameter Mappings using the Plug-in
Panel
You can customize the parameter mapping for an Instrument’s Preset file by enabling Edit mode in
the Plug-in panel.
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▶ To enable or disable the Plug-in panel’s Edit mode, click on the Edit mode button in the upper
right corner.

The Edit mode allows you to:

•
•
•
•
•

Add, delete, and replace parameters in the mapping.
Learn parameters to controls.
Rename controls.
Add pages to the Control section, or delete existing pages.
Add and rename sections on the pages to group controls.
To make your changes permanent, save the Preset file to the KOMPLETE KONTROL
User Library. For more information, refer to Saving Preset Files to the User Library.

Plug-in Panel Edit Mode

The Edit mode of the Plug-in panel.

Each page (1) of the Control section on the KOMPLETE KONTROL keyboard shows up as a label at
the top of the Plug-in panel.
1. Click on a label to view and edit the controls on this page. The current page is highlighted.
2. To delete a page, click on the cross icon next to its label.
The Add Page button (2) allows you to add more pages to the Control section for the current
Preset file, while the Learn button (3) enables Learn mode for the Plug-in panel.
▶ In Learn mode, select a control in the Plug-in panel and move any parameter on the
Instrument’s panel to learn this parameter to the selected control (highlighted in blue).
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Controls can be grouped to sections (4) to show related parameters in a coherent manner.
1. Double-click on the empty space above a parameter, enter a name, and then press [enter] or
click elsewhere to create a new section starting with the chosen parameter.
2. To rename an existing section, double-click on it and enter a new name. Press [enter] or click
elsewhere to confirm the changes.
The name of each control is shown below the corresponding knob in the Plug-in panel (5).
▶ To change the name of a control, double-click on it and enter a new name. Press [enter] or click
elsewhere to confirm the changes.
If you place the mouse over a control (6) in Edit mode, additional options allow for changing the
parameter mapping of this control.
1. Click on the arrow icon at the left of the control’s knob and select a parameter from the dropdown menu to map it to this control.
2. Click on the cross icon at the right of the control’s knob to delete this control from the current
page.
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17. Smart Play – Playing and Editing
Scales and Chords
KOMPLETE KONTROL’s Scale engine comes equipped with a vast amount of scales that you can
select and use to play your Instruments. This opens up possibilities to play an Instrument such as
a piano according to, e.g., the minor pentatonic scale without hitting a “false” note. In Chord mode
you can use the provided scales to combine individual note harmonies into chords. Combined with
the Arpeggiator, you can even play scales automatically simply by pressing down a key on the
KOMPLETE KONTROL keyboard or receiving an incoming MIDI note.
When you select a scale in the Perform panel and switch the Scale engine on, the scale gets
mapped onto the keyboard and is reflected by the Light Guide. This means that regardless of what
keys you actually press down on the keyboard—or what MIDI notes you send from the host—the
notes that are being played back are always mapped onto the closest notes contained in the scale
that you selected.

17.1. A Note about Music Theory
KOMPLETE KONTROL has built-in scales and harmonies that you can use to play your
Instruments, Loops and One-shots with chords and arpeggiator sequences.

Scales
Traditionally music is built by combining elements of rhythm and harmony. There are many
exceptions to this, but to understand the concepts of scales, chords and arpeggiator sequences
let’s start from there.
All notes and keys correspond to a pitch—or tone frequency. On a keyboard, each key typically
represents a semitone, meaning that it is a “half step” higher or lower in pitch than the next key
(though other tunings exist as well). To play melodies or chords that sound good together, notes
are usually grouped together in scales. In the Western music tradition, a scale typically covers
seven white keys and five black keys on a keyboard or piano: an octave. It is called so because the
eighth key that follows the seventh contiguous white key plays the same note as the first of the
seven. That key is called the root note. A scale then, is a certain combination of white and black
keys (each representing a semitone) within an octave. By playing only the keys belonging to some
scale, you are certain to stay “in key” within that scale. Important to note though, is that scales are
not made up by absolute note values, but rather consist of relative changes in pitch—or steps
along the scale. For example, the major scale consists of “whole step–whole step–half step–
whole step–whole step–whole step–half step,” which means that you can transpose the scale up
and down a keyboard; choose any root note you want and play the scale from there.
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Chords
Polyphonic Instruments let you play multiple notes simultaneously—in other words chords. As an
example, let’s see how to build up a chord by selecting individual notes from a scale and playing
them simultaneously. In this case, we’ll use the C major scale. As we saw above, the major scale
starts with two whole steps, followed by a half step, and then three more whole steps until it ends
with another half step. We can use this knowledge to play a C major chord by pressing the root
note C, then pressing another key two whole steps above C (the E note) and then yet another key a
half step and a whole step further up the keyboard (the G note) all simultaneously. This C major
chord corresponds to a root note (C), a third (E) and a fifth (G), which is the note interval of a major
triad. By playing a triad chord you have just learned the concept of musical harmony, where notes
are stacked together into chords and played simultaneously.

Arpeggiator Sequences
In above section you read about the combination of notes and playing them together as chords.
You can also play them like diachronic note sequences, quite like playing the harp—or
arpeggiator sequence. If chords have to do with adding harmony to a note, then arpeggiator
sequences add time and rhythm. Instead of playing a chord consisting of three notes
simultaneously, you can play the same three notes as a sequence in a given order (e.g., top-down)
and at a certain rate (e.g., 1/16 notes). This is also a way for monophonic Instruments to play
“chords.”

17.2. Activating the Scale Engine
In order to activate the Scale engine:
1. Click the Perform panel button in the Header to show the Perform panel.

→ The Perform panel appears.

2. To switch on the Scale engine, click the check box next to SCALE in the Perform section so it is
filled blue.
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Activating the Scale Engine on the Keyboard
▶ To switch on the Scale engine, press SCALE (Edit) in the Perform and Edit section on the
keyboard.

17.3. Selecting and Playing a Scale
To select and play a scale on the KOMPLETE KONTROL keyboard, follow these instructions:
1. Press SHIFT + SCALE (Edit) to map the displays and knobs of the Control section to the Scale
engine parameters.
2. To select a scale, turn Knob 2 (BANK, by default set to MAIN) and Knob 3 (TYPE, by default set
to MAJOR) until you find a scale you like.
3. To play the scale you selected, ensure that the SCALE (Edit) button lights up.
→ The keys on the keyboard are now mapped to the notes in the selected scale. The mapping is
reflected visually by the Light Guide. Pressing any unlit key automatically activates the nearest
lit key so that only notes belonging to the selected scales are being played back.
4. To map the knobs and displays to Instrument parameters again, press PLUG-IN. The Scale
engine remains switched on.
If you selected Scale Type CHROM, all keys are mapped.

17.4. Playing Chords
You can play chords in the usual way by pressing any number of keys simultaneously (or send
multiple MIDI notes simultaneously from the host), but KOMPLETE KONTROL also lets you create
and play chords by using Smart Play.
To play multiple notes in a chord simultaneously, the loaded Instrument must be able
to handle polyphony.
To play a chord by only pressing a single key on the keyboard, follow these instructions:
1. Press SHIFT + SCALE (Edit) to map the displays and knobs of the Control section to the Scale
engine parameters.
2. To activate Chord mode, set MODE to HARM by turning Knob 5 (by default set to OFF).
3. Define the intervals of your chord with the TYPE parameter by turning Knob 6 (by default set to
1-3-5).
4. To enable playing full chords, ensure that the SCALE (Edit) button is lit.
→ Chord mode is activated and set to Harmonizer. Pressing any key automatically activates and
plays back the nearest lit key according to the mapping by selected scale. It also plays back the
third and the fifth note above the pressed key in the selected scale, in accordance with the
interval value set by Knob 6 (1-3-5, meaning the first, third, and fifth note of a chord). All played
back notes are indicated by the Light Guide.
5. To map the knobs and displays to Instrument parameters again, press PLUG-IN. The Scale
engine remains switched on.
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17.5. Editing Scales and Chords
You have the possibility to tailor the scales and chords to your needs using the Scale engine
parameters.
▶ To edit the Scale engine parameters in the KOMPLETE KONTROL software, click on SCALE in
the Perform panel so it is highlighted.

▶ To enable Scale Edit mode and map the Scale engine parameters to the keyboard’s Control
section, press SHIFT + SCALE (Edit).
→ You can now edit the Scale engine parameters on the keyboard’s Control section.

Available SCALE Parameters

•

To select the scale to be mapped to the keys of the keyboard and set its root note, use the
SCALE parameters Root Note, Bank, and Type.

•

To define how the selected scale is mapped to the keys of the keyboard, use the KEY MODE
parameter.

•

To automatically generate custom chords while playing on the keyboard, use the CHORD
parameters Mode, Type, and Position.

17.6. Setting the SCALE Parameters
The SCALE parameters Root Note, Bank, and Type allow you to select the scale to be mapped to
the keys of the keyboard and set its root note.

The SCALE parameters Root Note, Bank, and Type.

17.6.1. SCALE Root Note
The first SCALE parameter is Root Note. On the keyboard, it is mapped to Knob 1 of the Control
section in Scale Edit mode. Setting the root note of a scale means deciding what key the scale will
begin with. The following notes of the scale depend on which scale pattern you select with the
SCALEType parameter (see below). You can transpose any scale pattern up or down by selecting
a different Root Note.
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The Light Guide indicates the selected Root Note via fully lit LEDs, while other active
keys are half-lit.
The Root Note setting includes the following values:

•

C , C#, D, D#, E, F, F#, G, G#, A, A#, B

17.6.2. SCALE Bank and Type
The second and third SCALE parameters from the left are Bank and Type. On the keyboard, they
are mapped to Knob 2 and Knob 3 of the Control section in Scale Edit mode. Use them to decide
the scale pattern according to which the notes will be mapped onto the keys of the
KOMPLETE KONTROL keyboard. Each Bank consists of 15 thematically related scales, which can
be selected by using the Type control.
For example, using the default Root Note value C combined with the default TypeMajor from the
default BankMain, you get the scale C major, which spans over one octave and contains the notes
C, D, E, F, G, A, and B (followed by C again). If instead you select G as your Root Note, the G major
scale contains the notes G, A, B, C, D, E, and F# (followed by G again). You will notice that the
distance between each note follows the same pattern of “whole step–whole step–half step–
whole step–whole step–whole step–half step,” which is the pattern of the Major scale.
If you are triggering an Instrument via an incoming MIDI pattern from the host, the notes of the
MIDI pattern will be mapped onto the closest keys belonging to the selected Type. This means
that, for example (with Root Note set to C) a MIDI pattern consisting of the notes C-D-D# will be
played back as such if Type is set to Chromatic (named CHROM on the keyboard) from BankMain,
but instead as C-D-E if Type is set to Major.

The Light Guide indicates the active keys in the selected Type via lit LEDs, while
inactive keys are unlit.
The following scales are available:

Main Scales
Scale

Bank

Type

Degree Formula

Chromatic

Main

Chrom

1 ♭2 2 ♭3 3 4 ♭5 5 ♭6 6 ♭7 7

Major

Main

Major

1234567

Minor

Main

Minor

1 2 ♭3 4 5 ♭6 ♭7

Harm Min

Main

Harm Min

1 2 ♭3 4 5 ♭6 7

Maj Pent

Main

Maj Pent

12356

Min Pent

Main

Min Pent

1 ♭3 4 5 ♭7

Blues

Main

Blues

1 ♭3 4 ♯4 5 ♭7

Japanese

Main

Japanese

1 2 ♭3 5 ♭6

Freygish

Main

Freygish

1 ♭2 3 4 5 ♭6 ♭7

Gypsy

Main

Gypsy

1 2 ♭3 ♯4 5 ♭6 7

Arabic

Main

Arabic

1 ♭2 3 4 5 ♭6 7
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Scale

Bank

Type

Degree Formula

Altered

Main

Altered

1 ♭2 ♯2 3 ♯4 ♭6 ♭7

Whole Tone

Main

WH Tone

1 2 3 ♯4 ♯5 ♭7

H-W Dim

Main

H-W Dim

1 ♭2 ♯2 3 ♯4 5 6 ♭7

W-H Dim

Main

W-H Dim

1 2 ♭3 4 ♯4 ♯5 6 7

Modes Scales:
Scale

Bank

Type

Degree Formula

Ionian

Modes

Ionian

1234567

Dorian

Modes

Dorian

1 2 ♭3 4 5 6 ♭7

Phrygian

Modes

Phrygian

1 ♭2 ♭3 4 5 ♭6 ♭7

Lydian

Modes

Lydian

1 2 3 ♯4 5 6 7

Mixolydian

Modes

Mixolyd

1 2 3 4 5 6 ♭7

Aeolian

Modes

Aeolian

1 2 ♭3 4 5 ♭6 ♭7

Locrian

Modes

Locrian

1 ♭2 ♭3 4 ♭5 ♭6 ♭7

Ionian b2

Modes

Ion b2

1 ♭2 3 4 5 6 7

Dorian b5

Modes

Dor b5

1 2 ♭3 4 ♭5 6 ♭7

Harm Phryg

Modes

Har Phry

1 ♭2 ♭3 4 5 ♭6 7

Phryg Major

Modes

Phry Maj

1 ♭2 ♭3 4 5 6 7

Lydian b3

Modes

Lyd b3

1 2 ♭3 ♯4 5 6 7

Major Locrian

Modes

Maj Loc

1 2 3 4 ♭5 ♭6 ♭7

Minor Locrian

Modes

Min Loc

1 2 ♭3 4 ♭5 ♭6 ♭7

Super Locrian

Modes

Sup Loc

1 ♭2 ♭3 ♭4 ♭5 ♭6 ♭7

Jazz Scales
Scale

Bank

Type

Degree Formula

Lydian ♭7

Jazz

Lyd ♭7

1 2 3 ♯4 5 6 ♭7

Altered

Jazz

Altered

1 ♭2 ♯2 3 ♯4 ♭6 ♭7

Diminished

Jazz

Diminshd

1 ♭2 ♯2 3 ♯4 5 6 ♭7

Mixo b13

Jazz

Mix b13

1 2 3 4 5 ♭6 ♭7

Mixo b9 b13

Jazz

Mixb9b13

1 ♭2 3 4 5 ♭6 ♭7

Lydian ♭7 b2

Jazz

Lyd ♭7b2

1 ♭2 3 ♯4 5 6 ♭7

Bebop

Jazz

Bebop

1 2 3 4 5 6 ♭7 7

Whole Tone

Jazz

Whole Tn

1 2 3 ♯4 ♯5 ♭7

Blues Maj

Jazz

Blues Ma

1 2 ♭3 3 5 6

Blues Min

Jazz

Blues Mi

1 ♭3 4 ♯4 5 ♭7

Blues Combined

Jazz

BluesCmb

1 2 ♭3 3 4 ♯4 5 6 ♭7

Lydian #5

Jazz

Lyd #5

1 2 3 ♯4 ♯5 6 7

Jazz Minor

Jazz

Jazz Mi

1 2 ♭3 4 5 6 7

Half Dim

Jazz

Half Dim

1 2 ♭3 4 ♭5 ♭6 ♭7

Augmented

Jazz

Augmentd

1 ♭3 3 5 ♯5 7
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World Scales
Scale

Bank

Type

Degree Formula

Hungarian Min

World

Hung Min

1 2 ♭3 ♯4 5 ♭6 7

Hungarian Maj

World

Hung Maj

1 ♯2 3 ♯4 5 6 ♭7

Neapolitan

World

Neapoltn

1 ♭2 ♭3 4 5 ♭6 7

Spanish

World

Spanish

1 ♭2 ♭3 3 4 5 ♭6 ♭7

Greek

World

Greek

1 2 ♭3 ♭4 5 ♭6 ♭7

Jewish 1

World

Jewish 1

1 ♭2 3 4 5 ♭6 ♭7

Jewish 2

World

Jewish 2

1 2 ♭3 ♯4 5 6 ♭7

Indian 1

World

Indian 1

1 ♭2 ♭3 ♯4 5 ♭6 7

Indian 2

World

Indian 2

1 2 ♭3 ♯4 5 6 7

Indian 3

World

Indian 3

1 ♭2 2 4 5 ♭6 6

Indian 4

World

Indian 4

1 ♯2 3 4 5 ♯6 7

Mid East 1

World

M East 1

1 ♭2 3 4 5 ♭6 7

Mid East 2

World

M East 2

1 ♭2 3 4 ♭5 ♭6 7

Mid East 3

World

M East 3

1 ♭2 ♭3 4 ♭5 6 ♭7

Mid East 4

World

M East 4

1 ♭2 3 4 ♭5 6 ♭7

Bank

Type

5-Tone Scales
Scale

Degree Formula

Penta I

5-Tone

Pent I

12356

Penta II

5-Tone

Pent II

1 2 4 5 ♭7

Penta III

5-Tone

Pent III

1 ♭3 4 ♭6 ♭7

Penta IV

5-Tone

Pent IV

12456

Penta V

5-Tone

Pent V

1 ♭3 4 5 ♭7

Hirajoshi

5-Tone

Hira

1 2 ♭3 5 ♭6

Insen

5-Tone

Insen

1 ♭2 4 5 ♭7

Kokin Joshi

5-Tone

Kokin

1 2 4 5 ♭6

Akebono

5-Tone

Akebono

1 2 ♭3 5 6

Ryukuan

5-Tone

Ryukuan

13457

Abhogi

5-Tone

Abhogi

1 2 ♭3 4 6

Bhupkali

5-Tone

Bhupkali

1 2 3 5 ♭6

Hindolam

5-Tone

Hindolam

1 ♭3 4 ♭6 ♭7

Bhupalam

5-Tone

Bhupalam

1 ♭2 ♭3 5 ♭6

Amritavarshini

5-Tone

Amrita

1 3 ♯4 5 7

Modern Scales
Scale

Bank

Type

Degree Formula

Octatonic

Modern

Octatonc

1 2 ♭3 4 ♯4 ♯5 6 7

Acoustic

Modern

Acoustic

1 2 3 ♯4 5 6 ♭7

Augmented

Modern

Augmentd

1 ♭3 3 5 ♯5 7
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Scale

Bank

Type

Degree Formula

Tritone

Modern

Tritone

1 ♭2 3 ♭5 5 ♭7

Leading Wh Tone

Modern

Lead Wh

1 2 3 ♯4 ♯5 ♯6 7

Enigmatic

Modern

Enigmatc

1 ♭2 3 ♯4 ♯5 ♯6 7

Scriabin

Modern

Scriabin

1 2 3 ♯4 6 ♭7

Tcherepnin

Modern

Tcherepn

1 ♯1 ♯2 3 4 5 ♯5 6 7

Messiaen I

Modern

Mes I

1 2 3 ♯4 ♯5 #6

Messiaen II

Modern

Mes II

1 ♭2 ♯2 3 ♯4 5 6 ♭7

Messiaen III

Modern

Mes III

1 2 ♭3 3 ♯4 5 ♭6 ♭7 7

Messiaen IV

Modern

Mes IV

1 ♭2 2 4 ♯4 5 ♭6 7

Messiaen V

Modern

Mes V

1 ♭2 4 ♯4 5 7

Messiaen VI

Modern

Mes VI

1 2 3 4 ♯4 ♯5 ♯6 7

Messiaen VII

Modern

Mes VII

1 ♭2 2 ♭3 4 ♯4 5 ♭6 6 7

Major Scales
Scale

Bank

Type

Degree Formula

Natural

Major

Natural

1234567

Lydian

Major

Lydian

1 2 3 ♯4 5 6 7

Mixolydian

Major

Mixolyd

1 2 3 4 5 6 ♭7

Major Minor

Major

Maj Min

1 2 3 4 5 ♭6 ♭7

Harmonic Major

Major

Har Maj

1 2 3 4 5 ♭6 7

Dbl Har Major

Major

Dbl Maj

1 ♭2 3 4 5 ♭6 7

Neapolitan Maj

Major

Nea Maj

1 ♭2 3 4 5 6 7

Major Locrian

Major

Maj Loc

1 2 3 4 ♭5 ♭6 ♭7

Blues Major

Major

Blues Ma

1 2 ♭3 3 5 6

Bebop Major

Major

Bebop Ma

1 2 3 4 5 ♯5 6 7

Hexa 1

Major

Hexa 1

123567

Hexa 2

Major

Hexa 2

123456

Penta 1

Major

Penta 1

12356

Penta 2

Major

Penta 2

13457

Penta 3

Major

Penta 3

13567

Bank

Type

Natural

Minor

Natural

1 2 ♭3 4 5 ♭6 ♭7

Dorian

Minor

Dorian

1 2 ♭3 4 5 6 ♭7

Phrygian

Minor

Phrygian

1 ♭2 ♭3 4 5 ♭6 ♭7

Minor Major

Minor

Min Maj

1 2 ♭3 4 5 6 7

Harmonic Minor

Minor

Har Min

1 2 ♭3 4 5 ♭6 7

Dbl Har Minor

Minor

Dbl Min

1 2 ♭3 ♯4 5 ♭6 7

Neapolitan Min

Minor

Nea Min

1 ♭2 ♭3 4 5 ♭6 7

Minor Scales
Scale

Degree Formula
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Scale

Bank

Type

Degree Formula

Minor Locrian

Minor

Min Loc

1 2 ♭3 4 ♭5 ♭6 ♭7

Blues Min

Minor

Blues Mi

1 ♭3 4 ♯4 5 ♭7

Bebop Minor

Minor

Bebop Mi

1 2 ♭3 4 5 ♭6 ♭7 7

Hexa 1

Minor

Hexa 1

1 2 ♭3 5 ♭6 ♭7

Hexa 2

Minor

Hexa 2

1 2 ♭3 4 5 ♭6

Penta 1

Minor

Penta 1

1 2 ♭3 5 ♭6

Penta 2

Minor

Penta 2

1 ♭3 4 5 ♭7

Penta 3

Minor

Penta 3

1 ♭3 5 ♭6 ♭7

17.7. Setting the KEY MODE Parameter
The only KEY MODE parameter is Mode. On the keyboard, it is mapped to Knob 3 of the Control
section in Scale Edit mode. It defines how the selected is mapped to the keys of the keyboard. This
is also reflected by the Light Guide.

The KEY MODE parameter Mode.

The KEY MODE menu consists of the following three modes, which are described in detail below:

•

Guide

•

Mapped (default value)

•

Easy

Mapped Mode (Default)
In Mapped mode, the notes are mapped to the keyboard according to the selected scale. Notes
outside of the selected scale are not active. Pressing the corresponding keys will trigger the next
available note in the selected scale. The Light Guide highlights the active keys via lit LEDs. The
Root Note is indicated by a brighter lit LED.

Both sections Root Note and Scale Type describe the use of Scale on the assumption
that the KEY MODE is set to its default value Mapped.

Guide Mode
In Guide mode, the notes are mapped to the keyboard in the same way as in Mapped mode,
however notes outside of the selected scale remain active. The mapping only affects the
representation of the scale by means of the Light Guide.
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Easy Mode
In Easy mode, the notes of the selected scale are mapped to the keyboard so that any scale can
be played using the white keys of the keyboard only. The black keys are inactive and pressing them
will not trigger any other notes.
Selecting the 12-step Chromatic scale in KEY MODE Easy maps the keys in the same
way as in the Mapped mode.
The Root Note is always mapped to the middle C key (commonly called C3). If the selected scale
consists of seven notes, it matches the seven white keys of a single octave on the keyboard. In
this case, the Root Note coincides with the key C across all octaves of the keyboard. If instead the
selected scale consists of more or less than seven notes, it does not match the seven white keys
of a single octave on the keyboard and the Root Note is shifted throughout adjacent octaves
accordingly.
The Light Guide highlights all white keys of the keyboard. The Root Note is indicated by a brighter
lit LED.
For two examples of the Easy mode mappings in Major and Minor, refer to below.
Scale Type

Mapping in Key
Mode: Easy
C3

D3

E3

F3

G3

A3

B3

Corresponding Mapping

R

2

3

4

5

6

7

Example with Root Note: C

C

D

E

F

G

A

B

Corresponding Mapping

R

2

♭3

4

5

♭6

♭7

Example with Root Note: C

C

D

E♭

F

G

A♭

B♭

White Keys
Major

Minor

17.8. Setting the CHORD Parameters
17.8.1. CHORD Mode
The first CHORD parameter is Mode. On the keyboard, it is mapped to Knob 5 of the Control
section in Scale Edit mode. Use it to generate chords from single notes, either from the
KOMPLETE KONTROL keyboard or from incoming MIDI notes from the host.

The CHORD parameter Mode.
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The Light Guide indicates the keys being played back in a chord via fully lit LEDs, while
active keys are half-lit and inactive keys are unlit.
CHORD Mode has one inactive (Off) and two active states, which are described in detail below:

•

Off

•

Harm

•

Chd Set

Harm
If CHORD Mode is set to Harm, the CHORD Type menu allows you to specify the interval of notes
in the selected SCALE Type that will constitute the chord: E.g., a triad in the form of the root note,
the third note, and the fifth note (CHORD Type value 1-3-5).

The CHORD parameter Mode, set value Harm.

Chd Set
If CHORD Mode is set to Chd Set, the CHORD Type menu allows you to choose from a selection of
major and minor chords depending on the current Root Note.

The CHORD parameter Mode, set value Chd Set.

The SCALE Type and KEY MODE parameters are not available when CHORD Mode is
set to Chd Set.

17.8.2. CHORD Type
The second CHORD parameter is Type. On the keyboard, it is mapped to Knob 6 of the Control
section in Scale Edit mode. Use it to define a chord that will be generated from a single note used
as input.
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The CHORD parameter Type.

The Light Guide indicates the keys being played back in a chord via fully lit LEDs, while
active keys are half-lit and inactive keys are unlit.
The available CHORD Type values depend on whether CHORD Mode is set to Harm or Chd Set, as
described in detail below.

CHORD Type, CHORD Mode Set to Harmonizer

The CHORD parameter Type, set value 1-3-5 (Mode set to Harm).

If CHORDMode is set to Harm, then CHORDType will offer you a selection of individual notes
present in the selected SCALEType. This means that for all scales except the 12-tone Chrom scale
(refer to further below), you can select the interval of notes that will make up your chord.
The note interval is added onto the key of an incoming MIDI note, either from the
KOMPLETE KONTROL keyboard or from the host. For example, you can select to play a C minor
triad by setting Root Note to C, SCALEType to Minor, CHORDMode to Harm, and CHORDType to
1-3-5. If all of this seems complex, try setting a random value and use the keyboard’s Light Guide
to see what keys are active, inactive, and played back.
When CHORDMode is set to Harm, the CHORDType setting includes the following values:
Chord Type

Interval Added to Played Note

Octave

Octave

1-3

3rd

1-5

5th

1-3-5

3rd and 5th

1-4-5

4th and 5th

1-3-5-7

3rd, 5th and 7th

1-4-7

4th and 7th
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CHORD Type, CHORD Mode Set to Chd Set

The CHORD parameter Type, set value Maj 1 (Mode set to Chd Set).

If CHORDMode is set to Chd Set and, for example, the Root Note is set to C, then the CHORDType
menu presents you with a list of selectable chords. Values are, e.g., Maj 4 and Min 7, which would
generate a major and minor chord, respectively—both using C as the chord’s root note.
When CHORDMode is set to Chd Set, the CHORDType setting includes the following values:

•

Maj 1, Maj 2, Maj 3, Maj 4, Maj 5, Maj 6, Maj 7, Maj 8, Min 1, Min 2, Min 3, Min 4, Min 5, Min 6,
Min 7, Min 8

CHORD Type and the Chromatic Scale
The Chrom scale consists of every semitone in an octave. This means that when you play every
white key and every black key of an octave up or down, you are playing the 12-step Chrom scale.
Since all semitones of an octave are present in the Scale, you can use all keys to form chords. In
turn, selecting Chrom as SCALEType means that you can select virtually any CHORDType. The
following chords are available and can be generated:
Chord Type

Semitones Added above Played Note

Octave

12

Perf 4 (Perfect 4)

5

Perf 5 (Perfect 5)

7

Major

4 and 7

Minor

3 and 7

Sus 4 (Suspended 4)

5 and 7

Maj 7 (Major 7)

4, 7 and 11

Min 7 (Minor 7)

3, 7 and 10

Dom 7 (Dominant 7)

4, 7 and 10

Dom 79(Dominant 9)

4, 7, 10 and 14

Min 7 b5 (Minor 7 b5)

3, 6 and 10

Dim 7 (Diminished 7)

3, 6 and 9

Aug (Augumented)

4 and 8

Quartal

5, 10 and 15

Trichord

5 and 11

17.8.3. CHORD Position
The third CHORD parameter is Position. On the keyboard, it is mapped to Knob 7 of the Control
section in Scale Edit mode. Use it to spread the notes of a chord generated from a single note and
to aid a more musical transition between chords.
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The CHORD parameter Position.

The Position parameter is available when CHORDType is set to Harm or Chd Set and includes the
following values:
Position

Description

Root

The root position of the selected chord is always played.

-1 to -8

Decreasing Position with negative values moves the highest note of the current chord
down by an octave, this inverts the chord to a lower position in the selected scale.

+1 to +8

Increasing Position with positive values moves the lowest note of the current chord up
by an octave, this inverts the chord to a higher position in the selected scale.

Auto

This provides a more human feel in the transition from one chord to another. The notes
used to form each chord are automatically selected to provide the best inversion.
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18. Smart Play – Playing and Editing
Arpeggiator Sequences
Smart Play features a flexible and versatile Arpeggiator that lets you play your Instruments, Loops
and One-shots in note sequences according to the keys you press on the keyboard. You can also
use the Arpeggiator in combination with the scales and chords created with the Scale engine. To
play an arpeggiated note sequence you only need to press any key on the KOMPLETE KONTROL
keyboard or receive an incoming MIDI note from the host.

Activating the Arpeggiator in the KOMPLETE KONTROL Software
▶ Click the Perform panel button in the Header to show the Perform panel.

→ The Perform panel appears in KOMPLETE KONTROL.

▶ To switch on the Arpeggiator, click the blue check box next to ARP in the Perform panel so it is
filled.

Activating the Arpeggiator on the Keyboard
▶ To switch on the Arpeggiator, press ARP (Edit) in the Perform and Edit section on the
keyboard.

18.1. Playing Arpeggiator Sequences
KOMPLETE KONTROL lets you create and play complex arpeggiator sequences using Smart Play.

Playing Arpeggiator Sequences
1. Switch on the Arpeggiator by pressing the ARP (Edit) button on the keyboard.

SMART PLAY – PLAYING AND EDITING ARPEGGIATOR SEQUENCES 172

2. Press a number of keys to start the Arpeggiator.
3. The Arpeggiator automatically plays back the notes corresponding to the pressed keys as a
sequence, rather than simultaneously.

Editing Arpeggiator Parameters
You can also edit the Arpeggiator parameters in the Control section for further tweaking of the
sequence:
1. Press SHIFT + ARP (Edit) to map the displays and knobs of the Control section to the
Arpeggiator parameters.
2. To change the direction of the sequence to e.g., UP-DOWN, turn Knob 2 (TYPE, by default set
to UP).
3. To adjust the OCTAVES reach of the Arpeggiator, turn Knob 6 (by default set to 1) to e.g., 4.
→ The notes corresponding to any keys you press are played back as a sequence, up and then
down again over four octaves.
4. To map the knobs and displays to Instrument parameters again, press PLUG-IN. The
Arpeggiator will still be switched on.

18.2. Using a Sustain Pedal to Control the Arpeggiator
You can use a sustain pedal to control the Arpeggiator.

•

Pressing the sustain pedal while keys are held and then releasing those keys continues the
arpeggiator sequence. This way the footswitch behaves as a trigger for the Arpeggiator. When
a new key is pressed, the new note is added to the current sequence.

•

Releasing the sustain pedal with no keys pressed stops the sequence and all playing notes.
Releasing the sustain pedal with keys still pressed removes all notes from the sequence except
those corresponding to the pressed keys. The sequence continues with the pressed keys only.

18.3. Using Arpeggiator Snapshots on the Keyboard
The Arpeggiator snapshots let you quickly recall four sets of Arpeggiator settings. This way you
can compare settings, or quickly switch between them during a performance. On the keyboard, the
snapshots are mapped to Button 5–8 on the Control section in Arp Edit mode. In the displays, they
are labeled with their respective settings for the RATE parameter (e.g., 1/8, 1/16, 1/16 T, etc.).
▶ To select a snapshot, press its corresponding button on the keyboard’s Control section.
→ All settings associated with this snapshot are instantly recalled.
▶ To change the settings associated with a snapshot, select it and adjust the parameters.
→ The new settings are saved automatically, and you can switch forth and back between
snapshots to recall them.
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Arpeggiator snapshots in the Control section.

18.4. Editing the Arpeggiator
The Arpeggiator’s parameters give you many possibilities to shape your own note sequences.
▶ To edit the Arpeggiator parameters in the KOMPLETE KONTROL software, click on ARP in the
Perform panel so it is highlighted.

▶ To enable Arpeggiator Edit mode and map the Arpeggiator parameters to the keyboard’s
Control section, press SHIFT + ARP (Edit).
→ You can now edit the Arpeggiator parameters on the keyboard’s Control section. Note that the
Arpeggiator Edit mode consists of two pages.

Available Arpeggiator Parameters

•

To switch between Arp and Note Repeat mode and change the playback direction of the
arpeggiator sequence, use the MAIN parameters Mode and Type.

•

To create interesting rhythms for the arpeggiator sequence, use the RHYTHM parameters
Rate, Sequence, and Swing.

•

To change the range of available notes for the arpeggiator sequence, as well as their velocity
and length, use the OTHER parameters Octaves, Dynamic, and Gate.

•

To explore alternative versions of the same arpeggiator sequence, use the ADVANCED
parameters Retrigger, Repeat, Offset, and Inversion.

•

To change the range of keys that trigger the arpeggiator sequence, use the RANGE parameters
Min. Key and Max. Key.

•

To latch the playback of the arpeggiator sequence, use the HOLD parameter.

18.5. MAIN Parameters
The MAIN parameters Mode and Type allow you to switch between Arp and Note Repeat mode
and change the playback direction of the arpeggiator sequence.
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The MAIN parameters Mode and Type.

18.5.1. MAIN Mode
The first MAIN parameter is Mode. On the keyboard, it is mapped to Knob 1 of the Control section
in Arp Edit mode. lt lets you select either Arp or Note Repeat. Depending on your selection, a
different set of Arpeggiator parameters will be available for further editing.
The Mode setting consists of the following two modes:

•

Arp mode, which generates arpeggiator sequences based on chords you play on the keyboard,
or the output of the Scale engine. With ARP switched on and Mode set to Arp, any chord you
created using the Scale engine will play as an arpeggiated note sequence. In this case, you only
need to press one key on the keyboard to hear the arpeggiated notes play out according to the
selected scale.

•

Note Repeat mode, which deactivates the Arpeggiator and instead repeats whichever note is
input until KOMPLETE KONTROL receives a MIDI note-off message. Use the parameters Rate,
Swing, and Gate to change the rhythm of the repeats.

18.5.2. MAIN Type
The second MAIN parameter, Type, is only available in Arp mode. On the keyboard, it is mapped to
Knob 2 of the Control section in Arp Edit mode. It sets the sequential order of the arpeggiated
notes. Choose whether your arpeggiated chord should be played from the root note and up, the
other way around, or even simultaneously. Selecting Order Played will play back the notes in the
order you pressed down the corresponding keys on the KOMPLETE KONTROL keyboard.
Automating the Type parameter in the host can create interesting variations and textures.
The Type setting includes the following values:

•

Up, Down, Up & Down (UP-DOWN on the keyboard), Order Played (PLAYED on the keyboard),
Chord

18.6. RHYTHM Parameters
The RHYTHM parameters Rate, Sequence, and Swing allow you to create interesting rhythms for
the arpeggiator sequence.

The RHYTHM parameters Rate, Sequence, and Swing.
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18.6.1. RHYTHM Rate
The first RHYTHM parameter, Rate, is available in both Arp and Note Repeat mode. On the
keyboard, it is mapped to Knob 3 of the Control section in Arp Edit mode. It sets the beat of the
Arpeggiator in relation to global tempo in musical values, ranging from 1/1 to 1/128. All note
values (except 1/1 and 1/128) are available as basic notes, dotted notes, and triplets. Dotted notes
are 1.5 times longer than the corresponding basic notes. Triplets are 2/3 the duration of their
corresponding basic notes, so that e.g., three 1/4 notes are equal in duration to two basic 1/4
notes.
The Rate setting includes the following values:

•

1/1

•

1/2 Dotted (1/2 D)

•

1/1 Triplet (1/1 T)

•

1/2

•

1/4 Dotted (1/4 D)

•

1/2 Triplet (1/2 T)

•

1/4

•

1/8 Dotted (1/8 D)

•

1/4 Triplet (1/4 T)

•

1/8

•

1/16 Dotted (1/16 D)

•

1/8 Triplet (1/8 T)

•

1/16

•

1/32 Dotted (1/32 D)

•

1/16 Triplet (1/16 T)

•

1/32

•

1/64 Dotted (1/64 D)

•

1/32 Triplet (1/32 T)

•

1/64

•

1/128 Dotted (1/128 D)

•

1/64 Triplet (1/64 T)

•

1/128
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18.6.2. RHYTHM Sequence
The second RHYTHM parameter, Sequence, is only available in Arp mode. On the keyboard, it is
mapped to Knob 4 of the Control section in Arp Edit mode. It gives you a way of adding interesting
rhythms to your arpeggiated notes. Select one of eight different sequences and apply it to the
arpeggiator sequence you are playing. Combine Sequence with the Rate parameter to create a
huge variety of rhythms at different tempos. If Rate is set to a basic or dotted value, then
Sequence applies a 16-step sequencer to the notes. If Rate is instead set to a triplet value, then
Sequence applies a 12-step sequencer to the notes.
You can switch sequences in real time during playback. For example, if sequence 1 is running and
you instead select sequence 2 after the fourth MIDI note in a pattern has been played back, then
sequence 2 starts when the fifth MIDI note in the pattern is played back.
The Sequence setting includes the following values:

•

Off, 1, 2, 3, 4, 5, 6, 7, 8
To display the set value of the SEQUENCE parameter, tap Knob 4.

18.6.3. RHYTHM Swing
The third RHYTHM parameter, Swing, is available in both Arp and Note Repeat mode. On the
keyboard, it is mapped to Knob 5 of the Control section in Arp Edit mode. Adding Swing to your
note sequence can make it feel less quantized and sound more natural. Swing works by
introducing a delay to every second note in a sequence. Doing so often adds a certain groove to
the music.
Swing is a drag control that lets you select a value between 0% and 100%:
1. Set a value of 0% to play the note sequence without swing.
2. Increase the Swing value to add swing by delaying every second note. The delay length is a
percentage of the current step size.
To display the set value of the SWING parameter, tap Knob 5.
Using Swing in combination with the Gate parameter adds further variations in note duration. For
example, if Gate is set to 100%, KOMPLETE KONTROL sends a MIDI note-off message before each
note and plays back the sequence legato. If Gate is set to values larger or smaller than 100%, then
notes will be scaled after the value of the Swing parameter has been applied, leaving the groove
intact.

18.7. OTHER Parameters
The OTHER parameters Octaves, Dynamic, and Gate allow you to change the range of available
notes for the arpeggiator sequence, as well as their velocity and length.
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The OTHER parameters Octaves, Dynamic, and Gate.

18.7.1. OTHER Octaves
The first OTHER parameter, Octaves, is only available in Arp mode. On the keyboard, it is mapped
to Knob 6 of the Control section in Arp Edit mode. It lets you decide the range of the arpeggiator
sequence. You can choose to play back your sequence within the octave of only the keys you
pressed on the KOMPLETE KONTROL keyboard, or you can select up to eight octaves and let the
corresponding notes of your chord or scale be played back in as many octaves.
Depending on the settings you have made to the Type parameter, the octaves played back can be
above (e.g., Up), below (e.g., Down) or both above and below (Up & Down) the pressed keys.
The Octaves setting includes the following values:

•

1, 2, 3, 4, 5, 6, 7, 8
To display the set value of the OCTAVES parameter, tap Knob 6.

18.7.2. OTHER Dynamic
The second OTHER parameter, Dynamic, is only available in Arp mode. On the keyboard it is
mapped to Knob 7 of the Control section in Arp Edit mode. It reads the velocity of the input—e.g., a
key you pressed on the KOMPLETE KONTROL keyboard or an incoming MIDI note from the host—
and scales it by the factor you set with the Dynamic parameter. The scaling is applied per note.
The velocity of each played note is taken and multiplied by the value set with the Dynamic
parameter.
Dynamic is a drag control that lets you set a value between 1.0% and 200.0%.
To display the set value of the DYNAMIC parameter, tap Knob 7.

18.7.3. OTHER Gate
The third OTHER Parameter, Gate, is available in both Arp and Note Repeat mode. On the
keyboard, it is mapped to Knob 8 of the Control section in Arp Edit mode. It lets you decide the
length of the notes in your sequence. Setting a value between 1% and 99% makes the duration of
the notes shorter than they otherwise would be. Setting a value between 101% and 200% instead
elongates the duration of the notes by the selected value.
Gate is a drag control that lets you set a value between 1.0% and 200.0%.
The GATE RESET function, mapped to Button 4 of the Control section lets you reset the GATE
parameter to its default value of 100% at any time.
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To display the set value of the GATE parameter, tap Knob 8.

18.8. ADVANCED Parameters
The ADVANCED parameters Retrigger, Repeat, Offset, and Inversion allow you to explore
alternative versions of the same arpeggiator sequence.

The ADVANCED parameters Retrigger, Repeat, Offset, and Inversion.

18.8.1. ADVANCED Retrigger
The first ADVANCED parameter, Retrigger, is only available in Arp mode. On the keyboard, it is
mapped to Knob 1 of the Control section when page 2 is selected in Arp Edit mode. Retrigger sets
a number of steps in the arpeggiator sequence after which the sequence restarts its cycle,
regardless of the number of pitches in the sequence.
For example:

•

If the arpeggiator sequence consists of a 5 note cycle (1 - 2 - 3 - 4 - 5) and Retrigger is set to 3,
the Arpeggiator output is 1 - 2 - 3 - repeat.

•

If the arpeggiator sequence consists of a 5 note cycle (1 - 2 - 3 - 4 - 5) and Retrigger is set to 8,
the Arpeggiator output is 1 - 2 - 3 - 4 - 5 - 1 - 2 - 3 - repeat.

Rests in a Sequence are treated as steps:

•

If the arpeggiator sequence consists of 6 pitches, the Sequence is 1 - 2 - 3 - rest - 4 - 5 - 6 –
rest, and Retrigger is set to 5, the Arpeggiator output is 1 - 2 - 3 - rest - 4 -repeat.

18.8.2. ADVANCED Repeat
The second ADVANCED parameter, Repeat, is only available in Arp mode. On the keyboard, it is
mapped to Knob 2 of the Control section when page 2 is selected in Arp Edit mode. Repeat sets a
number by which each step in the arpeggiator sequence is repeated.
For example:

•

If the arpeggiator sequence consists of a 3 note cycle (1 - 2 - 3) and Repeat is set to 3, the
Arpeggiator output is 1 - 1 - 1 - 2 - 2 - 2 - 3 - 3 - 3 - repeat.

18.8.3. ADVANCED Offset
The third ADVANCED parameter, Offset, is only available in Arp mode. On the keyboard, it is
mapped to Knob 3 of the Control section when page 2 is selected in Arp Edit mode. Offset sets a
number by which the steps in the arpeggiator sequence are shifted in the cycle.
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For example:

•

If the arpeggiator sequence consists of a 5 note cycle (1 - 2 - 3 - 4 - 5) and Offset is set to 0, the
Arpeggiator output is 1 - 2 - 3 - 4 - 5 - repeat.

•

If the arpeggiator sequence consists of a 5 note cycle (1 - 2 - 3 - 4 - 5) and Offset is set to +1,
the Arpeggiator output is 2 - 3 - 4 - 5 - 1 - repeat.

•

If the arpeggiator sequence consists of a 5 note cycle (1 - 2 - 3 - 4 - 5) and Offset is set to -1,
the Arpeggiator output is 5 - 1 - 2 - 3 - 4 - repeat.

18.8.4. ADVANCED Inversion
The fourth ADVANCED parameter, Inversion, is only available in Arp mode. On the keyboard, it is
mapped to Knob 4 of the Control section when page 2 is selected in Arp Edit mode. Inversion adds
inverted alternations of the arpeggiator sequence to the cycle.
For example:

•

If the arpeggiator sequence consists of a 3 note cycle (1 - 2 - 3), Type is set to Up, and
Inversion is set to 0, the Arpeggiator output is 1 - 2 - 3 - repeat.

•

If the arpeggiator sequence consists of a 3 note cycle (1 - 2 - 3), Type is set to Up, and
Inversion is set to 1, the Arpeggiator output is 1 - 2 - 3 - 2 - 3 - repeat.

•

If the arpeggiator sequence consists of a 3 note cycle (1 - 2 - 3), Type is set to Up, and
Inversion is set to 2, the Arpeggiator output is 1 - 2 - 3 – (2 - 3 - 1 octave up) - (3 - 1 - 2 octave
up) - repeat.

18.9. RANGE Parameters
The RANGE parameters Min. Key and Max. Key allow you to change the range of keys that trigger
the arpeggiator sequence.

The RANGE parameters Min. Key and Max. Key.

18.9.1. RANGE Min. Key
The first RANGE parameter, Min. Key, is only available in Arp mode. On the keyboard, it is mapped
to Knob 5 of the Control section when page 2 is selected in Arp Edit mode. Min. Key sets the
lowest key that can be used as an input for the arpeggiator sequence.

The Arpeggiator can still generate pitches below the Min. Key setting.
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18.9.2. RANGE Max. Key
The second RANGE parameter, Max. Key, is only available in Arp mode. On the keyboard, it is
mapped to Knob 6 of the Control section when page 2 is selected in Arp Edit mode. Max. Key sets
the highest key that can be used as an input for the arpeggiator sequence.
The Arpeggiator can still generate pitches above the Max. Key setting.

18.10. HOLD Parameter
The HOLD parameter On/Off is available in both Arp and Note Repeat mode. On the keyboard, it is
mapped to Button 3 of the Control section in Arp Edit mode. The HOLD function allows you to
latch the notes played by the Arpeggiator. When set to On, the Arpeggiator will continuously play a
sequence according to the last pressed keys on the keyboard.

The HOLD parameter On / Off.

HOLDOn/Off is a switch control that lets you select the values On and Off.
1. Pressing any key while HOLD is On will set a new sequence.
2. To stop the Arpeggiator playback, set the HOLD parameter to Off.
Alternatively, you can switch the Arpeggiator completely off to stop playback by
pressing ARP (Edit) in the keyboard’s PERFORM section. When you switch the
Arpeggiator back on, HOLD will still be active and you can continue to play latched
note sequences with the Arpeggiator.

